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1 PREFACE

Mari is a creative texture-painting tool that can handle extremely complex 
or texture heavy projects. It was developed at Weta Digital and has been 
used on films such as The Adventures of Tintin: The Secret of the Unicorn, 
District 9, The Day the Earth Stood Still, The Lovely Bones and Avatar.

The name Mari comes from the Swahili 'Maridadi', meaning 'beautiful' and 
carrying connotations of 'usefulness'.

About this guide This guide provides a complete reference for all the functions and fields 
within Mari. It does not give you any instructions on using Mari. For details 
on installing Mari, read the Getting Started Guide. For full instructions on 
using Mari, read the User Guide.

The first part of this document describes all the functions within Mari, 
broken up by functional area.

Contact 
customer 
support

Should questions arise that this manual fails to address, you can contact 
Customer Support directly via e-mail at support@thefoundry.co.uk or via 
telephone to our London office on +44 (0)20 7968 6828 or to our Los 
Angeles office on (310) 399 4555 during office hours.



2  TYPES OF CONTROLS

Control What it looks like What it does How to use it Notes

Add attribute Lets you add an 
attribute to a prop-
erty.

Click the icon, and fill 
in the Add User 
Attribute dialog box.

For more information, see the 
Extending Mari chapter in the 
Mari User Guide.

Buttons
, 

Lets you select a 
function.

Click it. May show an icon or a word.

Checkbox  unselected,  selected Lets you select an 
option.

Click to select. An “x” displays when selected.

Control 
sphere

Lets you move a light

around the scene.

Click and drag to pull 
the light around.

Curve editor Maps between input 
and output values 
(45° = the same). Bar 
along the bottom 
displays the effect at 
each point.

Drag to move points 
on the graph. Add 
points by clicking on 
the curve or bar. Edit 
a point by right-click-
ing it.

You can also remove a 
point by clicking on it 
while holding Ctrl.

Dropdown 
list

Lets you select from 
a list of valid values.

Click the down arrow 
on the right, then click 
to select an option.

Entry box Lets you type an 
entry.

Click inside the box 
and type a valid entry.

Often combined with a slider and 
reset button.

Horizontal 
slider

Slides along a range 
of valid values.

Click and drag left 
(more) or right (less).

Often combined with an entry box 
(that shows the value) and reset 
button.

Incrementers Lets you increment a 
value up or down.

Click up or down 
arrows to increment 
up or down.
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List Lets you select from 
a list of valid values.

Click to select an 
option.

On/Off Indi-
cator

 on,  off Shows whether an 
option is on or off

Look at it. Often combined with a switch.

Option 
buttons

Lets you select 
mutually exclusive 
options.

Click to select which 
option you want.

Circle is filled when selected. 
Sometimes called “radio buttons”.

Remove 
attribute

Lets you remove an 
attribute from a 
property.

Click the icon, then 
click Remove to con-
firm.

Reset button Reset to the default. Click the icon. Often combined with an entry box 
and slider.

Swatch Displays the 

currently selected 

color, and lets you 

select a different 

color.

Click to select a color 
from the 
Colors Palette.

Switch Turns an option on 
or off.

Click and drag right 
(on) or left (off).

Often combined with an On/Off 
indicator.

Control What it looks like What it does How to use it Notes
Mari 2.0v1The Foundry
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Tabs Displays several 
groups of the same 
kind of information, 
such as different 
categories of brush 
tips in the 
Brush Editor Palette.

Click: 

• a tab to view it

•  to view the 

previous or next tab

•  to add a tab

•  to delete a 

tab

•  to open the 

current tab in a 
separate window

Thumbnail Displays a thumbnail 
preview of a selected 
feature or function.

Look at it.

Control What it looks like What it does How to use it Notes
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3  PROJECT FUNCTIONS

Function How to access it What it does
Opens this dialog 
box Notes

New project • Menubar | File > New

• Keyboard | Ctrl+N 

• Projects tab | New button 

• Projects tab | Right-click > 
New 

• Toolbar | 

Creates a new project. New Project Dialog 
Box

Name the project, select 
options, and add geometry.

Open a project • Projects tab | Right-click > 
Open

• Projects tab | Double-click

Opens the selected project 
(the project you right-
clicked on).

Open recent 
project

• Menubar | File > Open > 
<project name>

Opens a project, from a list 
of the last 10 projects 
opened.

Save project • Menubar | File > Save 

• Keyboard | Ctrl+S

• Toolbar | 

Saves the current project.

Close project • Menubar | File > Close 

• Keyboard | Ctrl+W

• Toolbar | 

Closes the current project. Save Changes 
Before Closing? (if 
unsaved changes)

Delete project • Projects tab | Delete button

• Projects tab | Right-click > 
Delete

Deletes the selected project 
from disk.

Open Archive • Projects tab | Open Archive 
button

• Projects tab | Right-click > 
Open Archive

Opens a project from an 
archive file.

Import Archive

Archive Project • Projects tab | Archive 
button

• Projects tab | Right-click > 
Archive

Saves the selected project to 
disk as a Mari archive (.mra) 
file.

The archive includes all the 
supporting files required for 
the project.

Copy (Duplicate) 
Project

• Projects tab | Copy button 

• Projects tab | Right-click > 
Copy

Creates a copy of the 
selected project. 
The new copy appears in the 
Projects tab.



4  PREFERENCE FUNCTIONS

Function How to access it What it does
Opens this dialog 
box Notes

Set preferences Menubar | Edit > Preferences Lets you set general prefer-
ences for Mari — cache size, 
plug-ins, autosave fre-
quency, and so on.

Mari Preferences 
Dialog Box

Edit toolbars Menubar | Edit > Toolbars Lets you create and edit cus-
tom toolbars.

Manage Toolbar 
Dialog Box

Edit shortcuts Menubar | Edit > Shortcuts Lets you add or edit keyboard 
shortcuts.

Manage Keyboard 
Shortcuts Dialog Box

Configure 
Heads-Up 
Display

Menubar | Edit > HUD Manager Lets you set what information 
Mari shows in the Heads-Up 
Display (HUD) behind the 
model on the canvas.

HUD Manager Dialog 
Box



5  SELECTION FUNCTIONS

Function How to access it What it does
Opens this 
dialog box Notes

Object selection 
mode • Selection toolbar | 

• Menubar | Selection > 
Object Mode

• Right-click | canvas > 
Object Mode

Sets Mari to select whole 
objects.

Patch selection 
mode • Selection toolbar | 

• Menubar | Selection > 
Patch Mode

• Right-click | canvas > 
Patch Mode

Sets Mari to select patches 
on objects.

Faces selection 
mode • Selection toolbar | 

• Menubar | Selection > 
Face Mode

• Right-click | canvas > 
Face Mode

Sets Mari to select areas on 
the objects.

Hide unselected 
areas

• Menubar | Selection > 
Hide Unselected 

• Right-click | canvas > 
Visibility > Hide 
Unselected

• Right-click | Patches Pal-
ette > Hide Unselected 

• Keyboard | Shift+H

• Mouse | 

Hides the unselected areas 
on the canvas.

For the mouse gesture: press and 
hold \, click and drag in the direc-
tion indicated. (A thin red line 
traces gestures onscreen. Mari 
1.2v1
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Hide selected 
areas

• Menubar | Selection > 
Hide Selected 

• Right-click | canvas > 
Visibility > Hide Selected

• Right-click | Patches Pal-
ette > Hide Selected 
Patches

• Keyboard | H 

• Mouse | 

Hides the selected areas on 
the canvas.

For the mouse gesture: press and 
hold \, click and drag in the direc-
tion indicated. (A thin red line 
traces gestures onscreen.

Show selected 
areas

• Menubar | Selection > 
Show Selected 

• Right-click | canvas > 
Visibility > Show 
Selected

• Right-click | Patches Pal-
ette > Show Selected 
Patches

Shows the selected areas on 
the canvas.

Show all areas • Menubar | Selection > 
Show All 

• Right-click | canvas > 
Visibility > Show All

• Right-click | Patches Pal-
ette > Show All Patches

• Keyboard | Ctrl+Shift+H 

• Mouse | 

Displays all areas, selected 
or not, on the canvas.

For the mouse gesture: press and 
hold \, click and drag in the direc-
tion indicated. (A thin red line 
traces gestures onscreen.

Show whole 
object

• Menubar | Selection > 
Show Entire Object

• Right-click | canvas > 
Visibility > Show Entire 
Object

Shows all area, selected or 
not, on only the selected 
object.

Function How to access it What it does
Opens this 
dialog box Notes
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Select all areas • Menubar | Selection > 
Select All

• Right-click | canvas > 
Selection > Select All

• Right-click | Patches Pal-
ette > Select All Patches

• Button | Patches Palette 

> 

• Keyboard | Ctrl+A

Selects all areas in the 
model, depending on your 
current selection mode 
(objects, patches, or faces)

De-select all 
areas

• Menubar | Selection > 
Select None 

• Right-click | canvas > 
Selection > Select None

• Right-click | Patches Pal-
ette > Select None 

• Keyboard | Ctrl+E

De-selects all areas on the 
model.

Invert selection 
of areas

• Menubar | Selection > 
Select Invert 

• Right-click | canvas > 
Selection > Select Invert

• Right-click | Patches Pal-
ette > Select Invert 
Patches

• Keyboard | Ctrl+I

De-selects the current 
selection and selects every-
thing currently unselected.

Depends on your current selection 
mode (either objects, patches, or 
faces) for the scope of inversion. 
For example, in face mode, the 
unselected faces become selected 
and vice versa.

Select visible 
areas

• Menubar | Selection > 
Select Visible 

• Right-click | canvas > 
Selection > Select Visible

• Right-click | Patches Pal-
ette > Select Visible 
Patches

Selects only areas that 
aren't hidden.

Lock unselected 
areas

• Menubar | Selection > 
Lock Unselected

• Right-click | canvas > 
Locking > Lock 
Unselected

• Right-click | Patches Pal-
ette > Lock Unselected 
Patches

Locks unselected patches so 
they cannot be edited.

Function How to access it What it does
Opens this 
dialog box Notes
Mari 2.0v1The Foundry
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Lock selected 
areas

• Menubar | Selection > 
Lock Selected

• Right-click | canvas > 
Locking > Lock Selected

• Right-click | Patches Pal-
ette > Lock Selected 
Patches

• Button | Patches Palette 

> 

Locks selected areas, so 
they cannot be painted.

Unlock selected 
areas

• Menubar | Selection > 
Unlock Selected

• Right-click | canvas > 
Locking > Unlock 
Selected

• Right-click | Patches Pal-
ette > Unlock Selected 
Patches

• Button | Patches Palette 

> 

Unlocks selected locked 
areas, so they are again 
paintable.

Lock all areas • Menubar | Selection > 
Lock All

• Right-click | canvas > 
Locking > Lock All

• Right-click | Patches Pal-
ette > Lock All Patches

Locks all areas, so they can-
not be painted.

Unlock all areas • Menubar | Selection > 
Unlock All

• Right-click | canvas > 
Locking > Unlock All

• Right-click | Patches Pal-
ette > Unlock All Patches

Unlocks all locked areas, so 
they are again paintable.

Unlock everything • Menubar | Selection > 
Unlock Entire Object

• Right-click | canvas > 
Locking > Unlock Entire 
Object

Unlocks everything on the 
current object, regardless of 
whether it’s a face, patch, or 
channel.

Create selection 
group for patches

• Right-click | canvas > 
Create Patch Selection 
Set

Creates a new selection set 
consisting of whichever 
patches you currently have 
selected.

Creates a new selection set in the 
Patches Palette

Function How to access it What it does
Opens this 
dialog box Notes
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Create selection 
group

• Right-click | canvas > 
Create Selection Group 

• Button | Selection Groups 

Palette > 

Creates a new selection 
group to save your selec-
tion modes.

You can create selection groups in 
any selection mode (objects, 
patches, or faces).

Reselect 
selection group

• Right-click | selection 
group in Selection 
Groups Palette > Select 
Selection Group

• Button | Selection Groups 

Palette > 

Reselects the current selec-
tion group.

Lock the selection 
group

• Right-click | selection 
group in Selection 
Groups Palette > Lock 
Selection Group

• Button | Selection Groups 

Palette > 

Locks the selection group.

Unlock the 
selection group

• Right-click | selection 
group in Selection 
Groups Palette > Unlock 
Selection Group 

• Button | Selection Groups 

Palette > 

Unlocks the selection group.

Hide the selection 
group

• Right-click | selection 
group in Selection 
Groups Palette > Hide 
Selection Group 

• Button | Selection Groups 

Palette > 

Hides the contents of the 
selection group.

Function How to access it What it does
Opens this 
dialog box Notes
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Show the 
selection group

• Right-click | selection 
group in Selection 
Groups Palette > Show 
Selection Group

• Button | Selection Groups 

Palette > 

Shows the contents of the 
selection group.

Remove the 
selection group

• Right-click | selection 
group in Selection 
Groups Palette > Remove 
Selection Group

• Button | Selection Groups 

Palette > 

Function How to access it What it does
Opens this 
dialog box Notes
Mari 2.0v1The Foundry
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Function How to access it What it does
Opens this 
dialog box Notes

Add object • Menubar | Objects > Add 
Object 

• Right-click | Objects Palette > 
Add Object 

• Button | Objects Palette > 

Adds a new object to the 
project.

Add Objects

Remove object • Menubar | Objects > Remove 
Object 

• Right-click | Objects Palette > 
Remove Object

• Button | Objects Palette > 

Removes the selected object 
from the project.

Projects must always have at 
least one object.

Add object 
version

• Right-click | Objects Palette > 
Add Object Version

Lets you select a file con-
taining the new object ver-
sion data.

Add Version

Rename object 
version

• Right-click | Objects Palette > 
Rename Object Version

Renames the current object 
version.

Remove object 
version

• Right-click | Objects Palette > 
Remove Object Version

Deletes the current object 
version.

Objects must always have at 
least one version.

Calculate 
ambient occlusion

• Menubar | Objects > Ambient 
Occlusion 

• Right-click | Objects Palette > 
Ambient Occlusion

Calculates the ambient 
occlusion for the object. This 
is required for any opera-
tions that use the ambient 
occlusion data (such as 
using ambient occlusion 
masking).

This can take a long time, 
depending on the complexity 
of the model.

Reset Move 
Object - single 
object

• Mouse | Shift-click on the 
object

Shift-click on the object 
resets that object to its 
original position. 

Reset Move 
Object - all 
objects

• Keyboard | ’ Pressing the apostrophe key 
resets all objects back to 
their original positions.
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Function How to access it What it does
Opens this 
dialog box Notes

Add channel • Menubar | Channels > Add Channel

• Right-click | in Channels Palette > 
Add Channel

• Button | Channels Palette > 

Adds a new channel to the 
current project.

Add Channel 
Dialog Box

Create channel 
presets

• Menubar | Channels > Channel Pre-
sets

• Right-click | in Channels Palette > 
Channel Presets

Allows you to create a new 
channel preset to use as a 
template for new channels.

Channel Pre-
sets Dialog 
Box

Click the checkbox for 
channels you want to 
add, and click OK. You 
can customize avail-
able categories of 
channel presets using 
an XML file in a folder 
specified in your pref-
erences.

Remove channel • Menubar | Channels > Remove 
Channel

• Right-click | in Channels Palette > 
Remove Channel

• Button | Channels Palette > 

Removes the selected channel, 
and any layers associated with 
it, from the channels list.

Convert channel • Menubar | Channels > Convert 
Channel

• Right-click | in Channels Palette > 
Convert Channel

• Button | Channels Palette > 

Changes the color depth of 
the channel to either 8bit 
(Byte), 16bit (Half), or 32bit 
(Float).

Convert Type 
Dialog Box

Determines number of 
pixels per RGB channel.

Flatten channel • Menubar | Channels > Flatten

• Right-click | in Channels Palette > 
Flatten

Cut channel • Menubar | Channels > Cut

• Right-click | in Channels Palette > 
Cut

• Keyboard | Ctrl+X

Cuts the channel and all asso-
ciated layers from the chan-
nels list and places it in the 
clipboard.

Copy channel • Menubar | Channels > Copy

• Right-click | in Channels Palette > 
Copy

• Keyboard | Ctrl+C

Copies the channel, and all 
associated layers from the 
channels list and places it in 
the clipboard.
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Paste channel • Menubar | Channels > Paste

• Right-click | in Channels Palette > 
Paste

• Keyboard | Ctrl+V

Pastes any cut or copied 
channel and associated layers 
from the clipboard to the 
channels list.

Export current 
channel

• Menubar | Channels > Export Cur-
rent Channel

• Right-click | canvas > Export > 
Export Current Channel

• Right-click | in Channels Palette > 
Export Current Channel

Exports the current channel to 
a series of files.

Export Dialog 
Box

Export all chan-
nels

• Menubar | Channels > Export > 
Export All Channels

• Right-click | canvas > Export > 
Export All Channels

• Right-click | in Channels Palette > 
Export > Export All Channels

Exports all the channels in the 
channels palette to a series of 
files.

Export Dialog 
Box

Export everything • Menubar | Channels > Export > 
Export Everything

• Right-click | canvas > Export > 
Export Everything

• Right-click | in Channels Palette > 
Export > Export Everything

Exports the channels for all 
the objects in your project to 
a series of files.

Export Dialog 
Box

Flatten and 
export the cur-
rent channel

• Menubar | Channels > Export Flat-
tened > Export Current Channel 
Flattened

• Right-click | canvas > Export Flat-
tened > Export Current Channel 
Flattened

• Right-click | in Channels Palette > 
Export Flattened > Export Current 
Channel Flattened

Flattens the current channel 
and exports it to a series of 
files.

Export Dialog 
Box

Flatten and 
export all chan-
nels

• Menubar | Channels > Export Flat-
tened > Export All Channels Flat-
tened

• Right-click | canvas > Export Flat-
tened > Export All Channels Flat-
tened

• Right-click | Channels Palette > 
Export Flattened > Export All Chan-
nels Flattened

Flattens all the channels in the 
channels palette and exports 
it to a series of files.

Export Dialog 
Box
Mari 2.0v1The Foundry
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Flatten and 
export everything

• Menubar | Channels > Export Flat-
tened > Export Everything Flat-
tened

• Right-click | canvas > Export Flat-
tened > Export Everything Flat-
tened

• Right-click | Channels Palette > 
Export Flattened > Export Every-
thing Flattened

Flattens the channels for all 
objects in your project and 
exports them to a series of 
files.

Export Dialog 
Box

Import into a 
layer stack

• Menubar | Channels > Import > 
Import into Layer Stack

• Right-click | canvas > Import > 
Import into Layer Stack

• Right-click | in Channels Palette > 
Import > Import into Layer Stack

Imports the file as layers into 
the layer stack of your cur-
rent, selected channel.

Import Dialog 
Box

Import into a new 
channel

• Menubar | Channels > Import > 
Import into New Channel

• Right-click | canvas > Import > 
Import into New Channel

• Right-click | in Channels Palette > 
Import > Import into New Channel

Import the file as a new chan-
nel in the Channels palette.

Import Dialog 
Box

Resize channel • Menubar | Channels > Resize

• Right-click | in Channels Palette > 
Resize

Resize options are:

• 256x256

• 512x512

• 1024x1024

• 2048x2048

• 4096x4096

• 8192x8192

• 16384x16384

• 32768x32768

• Half Size

• Double Size

Lock channel • Menubar | Channels > Lock Channel

• Right-click | channel in Channels 
Palette > Lock Channel

• Button | Channels Palette > 

Lock the selected channel so 
that the channel nor any of 
the layers in the associated 
layer stack can be edited or 
deleted.

Lock icons in the Chan-
nels Palette show the 
current state of the 
channel.
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Unlock channel • Menubar | Channels > Unlock Chan-
nel

• Right-click | channel in Channels 
Palette > Unlock Channel

• Button | Channels Palette > 

Unlocks the selected channel 
so that the channel or the lay-
ers within the layer stack can 
be edited.

Lock icons in the Chan-
nels Palette show the 
current state of the 
channel.

Lock all channels • Menubar | Channels > Lock All 
Channels

• Right-click | Channels Palette > 
Lock All Channels

Locks all the channels in the 
Channels palette, regardless 
of what is selected.

Unlock all chan-
nels

• Menubar | Channels > Unlock All 
Channels

• Right-click | Channels Palette > 
Unlock All Channels

Unlock all the channels in the 
Channels palette, regardless 
of what is selected.

In addition to the 
unlock options listed 
here, you can also 
unlock channels by 
selecting Unlock Entire 
Object.

View the Next 
Channel

• Menubar | Channels > Next Channel

• Right-click | in Channels Palette > 
Next Channel

• Keyboard | Page Down

• Mouse | 

Selects the next channel in the 
list.

View the Previous 
Channel

• Menubar | Channels > Previous 
Channel

• Right-click | in Channels Palette > 
Previous Channel

• Keyboard | Page Up

• Mouse | 

Selects the previous channel 
in the list.

Snapshot all 
channels

• Menubar | Channels > Snapshots > 
Snapshot All Channels

• Right-click | in Channels Palette > 
Snapshots > Snapshot All Channels

Takes snapshots of all the 
channels in the channels pal-
ette.

Snapshot the cur-
rent channel

• Menubar | Channels > Snapshots > 
Snapshot Current Channel

• Right-click | in Channels Palette > 
Snapshots > Snapshot Current 
Channel

Takes snapshots of only the 
current selected channel.
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Manage snap-
shots

• Menubar | Channels > Snapshots > 
Manage Snapshots

• Right-click | in Channels Palette > 
Snapshots > Manage Snapshots

Opens the Snapshots Palette.

Delete all snap-
shots

• Menubar | Channels > Snapshots > 
Delete All Snapshots

• Right-click | in Channels Palette > 
Snapshots > Delete All Snapshots

Deletes all the snapshots 
taken for the current project.
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Function How to access it What it does
Opens this dialog 
box Notes

Add new layer • Menubar | Layers > Add New 
Layer

• Right-click | in Layers Palette > 
Add New Layer

• Button | Layers Palette > 

Adds a new layer to the 
layers list.

Add adjustment layer • Menubar | Layers > Add Adjust-
ment Layer

• Right-click | layer in Layers Pal-
ette > Add Layer Adjustment

• Button | Layers Palette > 

Adds the selected filter as 
an Adjustment layer to 
the layers list.

Following the arrows 
in the Add Adjust-
ment Layer menu 
leads to a choice of 
25 adjustment layers.

Add procedural layer • Menubar | Layers > Add Proce-
dural Layer

• Right-click | in Layers Palette > 
Add Procedural Layer 

• Button | Layers Palette > 

Adds the selected Basic, 
Environment, Geometry, 
or Procedural layer to the 
layers list.

Following the arrows 
in the Add Proce-
dural Layer menu 
leads to a choice of 
27 procedurals.

Cut layer or layer mask • Menubar | Layers > Cut

• Right-click | layer in Layers Pal-
ette > Cut

• Menubar | Layers > Layer Mask 
> Cut

• Right-click | layer mask in Layers 
Palette > Layer Mask > Cut

Cuts the layer from the 
layers list to allow you to 
paste it elsewhere in the 
project or temporarily 
remove it.

Copy layer or layer 
mask

• Menubar | Layers > Copy

• Right-click | layer in Layers Pal-
ette > Copy

• Menubar | Layers > Layer Mask 
> Copy

• Right-click | layer mask in Layers 
Palette > Layer Mask > Copy

Copies the layer from the 
layers list to allow you to 
paste it elsewhere in the 
project.
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Paste layer or layer 
mask

• Menubar | Layers > Paste

• Right-click | layer in Layers Pal-
ette > Paste

• Menubar | Layers > Layer Mask 
> Paste

• Right-click | layer mask in Layers 
Palette > Layer Mask > Paste

Pastes a cut or copied 
layer into the selected 
location in the project’s 
Layers Palette. Layers can 
be paste as a copy in the 
layer list, or as a new 
layer in a mask group or 
adjustment stack.

Duplicate layer
• Button | Layers Palette > 

Creates an exact copy of 
the selected layer.

’Copy’ is added to the 
layer name to denote 
which layer is the 
duplicate.

Remove layers • Right-click | layer in Layers Pal-
ette > Remove Layers

• Button | Layers Palette > 

Removes the selected 
layer from the current 
project.

Merge layers • Right-click | layer in Layers Pal-
ette > Merge Layers

Merges two or more lay-
ers together into a single 
new layer.

Any masks or layer 
groups contained in 
the selection will also 
be merged into the 
layer and are no lon-
ger displayed as 
masks or groups.

Add empty layer group • Right-click | in Layers Palette > 
Add Layer Group

• Button | Layers Palette > 

Adds an empty layer 
group, which allows you 
to add layers, masks, 
adjustments or procedur-
als within a single layer 
group.

These layer groups 
can be flattened to 
create a single layer.

Group layers • Right-click | layer in Layers Pal-
ette > Group Layers

Gathers multiple selected 
layers together under a 
single group.

Selected layers are 
located under a par-
ent layer, which is 
given a ‘group’ name.

Flatten layer group • Right-click | layer in Layers Pal-
ette > Flatten Layer Group

Reduces multiple layers 
into a single layer, where 
all the textures are still 
present.

Function How to access it What it does
Opens this dialog 
box Notes
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Add mask • Menubar | Layers > Layer Mask 
> Add Mask

• Right-click | layer in Layers Pal-
ette > Layer Mask > Add Layer 
Mask

• Button | Layers Palette > 

Adds a layer mask to the 
selected layer. Choose to 
Reveal All, Hide All, or to 
create From Alpha.

Bake mask • Menubar | Layers > Layer Mask 
> Bake Mask

• Right-click | layer in Layers Pal-
ette > Layer Mask > Bake Mask

Bakes the mask into the 
layer, essentially flatten-
ing it.

Remove mask • Menubar | Layers > Layer Mask 
> Remove Mask

• Right-click | layer in Layers Pal-
ette > Layer Mask > Bake Mask

Remove the mask from 
the layer.

Make mask group • Menubar | Layers > Layer Mask 
> Make Mask Group

• Right-click | layer in Layers Pal-
ette > Layer Mask > Make Mask 
Group

Creates a mask layer 
group from a single mask 
on a layer. Requires the 
selected layer to have a 
mask.

Clicking the mask 

group icon  

opens an undocked 
mask group palette.

Flatten mask group • Menubar | Layers > Layer Mask 
> Make Mask Group

• Right-click | layer in Layers Pal-
ette > Flatten Mask Group

Reduces the masks in a 
mask group back into a 
single mask on the layer.

Enable mask • Menubar | Layers > Layer Mask 
> Enable Mask

• Right-click | in Layers Palette > 
Layer Mask > Enable Mask

Enables the mask to be 
viewed on the model.

Disable mask • Menubar | Layers > Layer Mask 
> Disable Mask

• Right-click | in Layers Palette > 
Layers Mask > Disable Mask

Disables the mask from 
being viewed on the 
model. Disabling the mask 
only temporarily removes 
it from view.

To remove the mask 
entirely, simply 
Remove Mask in the 
same menu.

Add secondary adjust-
ment

• Menubar | Layers > Secondary 
Adjustment > Add Secondary 
Adjustment

• Right-click | adjustment layer in 
Layers Palette > Secondary 
Adjustment

Allows you to add another 
type of adjustment to the 
selected adjustment layer.

This only applies to 
adjustment layers. 
The option appears 
grayed out if the 
selected layer isn’t an 
adjustment.

Function How to access it What it does
Opens this dialog 
box Notes
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Remove secondary 
adjustment

• menubar | Layers > Secondary 
Adjustment > Remove Second-
ary Adjustment

• Right-click | adjustment layer in 
Layers Palette > Remove Sec-
ondary Adjustment

Removes any secondary 
adjustment that has been 
applied to the selected 
adjustment layer

This only applies to 
adjustment layers. 
The option appears 
grayed out if the 
selected layer isn’t an 
adjustment. 

Add adjustment stack • Menubar | Layers > Adjustment 
Stack > Add Adjustment Stack

• Right-click | layer in Layers Pal-
ette > Adjustment Stack > Add 
Adjustment Stack

Adds an adjustment stack 
to the selected layer. Add 
adjustment layer from the 
menu of 21 Filter adjust-
ment layers.

This only applies to 
layers other than 
adjustment layers.

Bake adjustment stack • Menubar | Layers > Adjustment 
Stack > Bake Adjustment Stack

• Right-click | layer in Layers Pal-
ette > Adjustment Stack > Bake 
Adjustment Stack

Bakes an adjustment 
stack down, essentially 
flattening the stack into a 
single adjustment layer.

Remove adjustment 
stack

• Menubar | Layers > Adjustment 
Stack > Remove Adjustment 
Stack

• Right-click | layer in Layers Pal-
ette > Adjustment Stack > 
Remove Adjustment Stack

Removes any adjustment 
stack that has been 
applied to the selected 
layer.

This only applies to 
layers other than 
adjustment layers.

Enable adjustment 
stack

• Menubar | Layers > Adjustment 
Stack > Enable Adjustment 
Stack

• Right-click | layer in Layers Pal-
ette > Adjustment Stack > 
Enable Adjustment Stack

If an adjustment stack 
has been disabled, this 
option re-enables the 
adjustment stack.

This only applies to 
adjustment stacks 
that have been dis-
abled. If a layer does 
not have an adjust-
ment stack, or if the 
stack is already 
enabled, the option 
appears grayed out.

Disable adjustment 
stack

• Menubar | Layers > Adjustment 
Stack > Disable Adjustment 
Stack

• Right-click | layer in Layers Pal-
ette > Adjustment Stack > Dis-
able Adjustment Stack

Disables an adjustment 
stack to show the paint 
layer result as it is with-
out the stack. Useful for 
comparing the model with 
and without the adjust-
ment stack.

This only applies to 
adjustment stacks 
that have been added 
to a layer. If a layer 
does not have an 
adjustment stack, the 
option appears 
grayed out.

Convert to paintable • Menubar | Layers > Convert to 
Paintable

• Right-click | layer in Layers Pal-
ette > Convert to Paintable

Function How to access it What it does
Opens this dialog 
box Notes
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Share As channel • Menubar | Layers > Sharing > 
Share As Channel

• Right-click | layer in Layers Pal-
ette > Sharing > Share As Chan-
nel

Copies the selected layer 
into the Channels Palette 
as a new Channel. Clicking 
on the channel icon opens 
a new palette with the 
shared layer already 
listed.

Unshare layer • Menubar | Layers > Sharing > 
Unshare Layer

• Right-click | layer in Layers Pal-
ette > Sharing > Unshare Layer

If you have shared a layer 
as a channel, you can 
undo the shared state by 
selecting this option. 

Unsharing the layer 
to remove the shared 
state doesn’t remove 
the channel from the 
Channels Palette. This 
need to be done man-
ually.

Make shared channel 
current

• Menubar | Layers > Sharing > 
Make Shared Channel Current

• Right-click | layer in Layers Pal-
ette > Sharing > Make Shared 
Channel Current

Cache layer • Menubar | Layers > Cache Layer

• Right-click | layer in Layers Pal-
ette > Cache Layer

Bakes the layer to speed 
up layer performance. 
Caching a layer caches it 
to the hard-disk.

Cache up to here • Menubar | Layers > Cache Up To 
Here

• Right-click | layer in Layers Pal-
ette > Cache Up To Here

Caches up to the current 
selected layer in the layer 
stack.

Uncache layer • Menubar | Layers > Uncache 
Layer

• Right-click | layer in Layers Pal-
ette > Uncache Layer

Release the cached files 
and unlocks the layer 
stack, allowing it to be 
edited again.

Uncache layer up to 
here

• Menubar | Layers > Uncache Up 
To Here

• Right-click | layer in Layers Pal-
ette > Uncache Up To Here

Releases the cached files 
and unlocks the layer 
stack up to the selected 
layer, allowing those lay-
ers to be edited again.

Export selected layers • Menubar | Layers > Export > 
Export Selected Layers

• Right-click | layer in Layers Pal-
ette > Export > Export Selected 
Layers

Exports the selected layer 
to an external source.

Export Dialog 
Box

Function How to access it What it does
Opens this dialog 
box Notes
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Export all layers • Menubar | Layers > Export > 
Export All Layers

• Right-click | layer in Layers Pal-
ette > Export > Export All Lay-
ers

Exports all the layers in 
the layer stack to an 
external source.

Export Dialog 
Box

Export selected layers 
flattened 

• Menubar | Layers > Export Flat-
tened > Export Selected layers 
Flattened

• Right-click | layer in Layers Pal-
ette > Export > Export Selected 
Layers Flattened

Exports the selected layer 
or layers flattened into a 
single file to an external 
source.

Export Dialog 
Box

Export all layers flat-
tened

• Menubar | Layers > Export Flat-
tened > Export All Layers Flat-
tened

• Right-click | layer in Layers Pal-
ette > Export > Export All Lay-
ers Flattened

Exports all the layers in 
the layer stack flattened 
into a single file to an 
external source.

Export Dialog 
Box

Import into layer • Menubar | Layers > Import > 
Import into Layer

• Right-click | layer in Layers Pal-
ette > Import > Import into 
Layer

Selects a file with paint or 
mask data to be imported 
into the selected layer.

Import Dialog 
Box

Import into layer stack • Menubar | Layers > Import into 
Layer Stack

• Right-click | layer in Layers Pal-
ette > Import > Import into 
Layer Stack

Selects a file with paint or 
mask data to be imported 
into the current layer 
stack.

Import Dialog 
Box

Inspect layer properties • Right-click | layer in Layers Pal-
ette > Layer Properties

Opens a separate win-
dow to display the prop-
erties of the selected 
layer.

Refresh layer view • Right-click | in Layers Palette > 
Refresh Layer View

Refreshes the entire layer 
stack.

Function How to access it What it does
Opens this dialog 
box Notes
Mari 2.0v1The Foundry



9  PTEX FUNCTIONS

Function How to access it What it does Notes

Double face resolu-
tion

• Menubar | Ptex > Double Face Resolution

• Button | Ptex Toolbar > 

Double the selected face resolu-
tion.

Halve face resolution • Menubar | Ptex > Halve Face Resolution

• Button | Ptex Toolbar > 

Halve the selected face resolu-
tion.

Set the world space 
face resolution for 
the selected face

• Menubar | Ptex > World Space Face Reso-
lution

• Button | Ptex Toolbar > 

Set the world space face resolu-
tion for the selected face.

Set the face resolu-
tion for the selected 
face

• Menubar | Ptex > Set Face Resolution

• Button | Ptex Toolbar > 

Set the face resolution for the 
selected face.

Fill selected faces 
with foreground 
color

• Menubar | Ptex > Fill Faces Foreground

• Button | Ptex Toolbar > 

Fill the selected faces with the 
foreground color.

Fill selected faces 
with background 
color

• Menubar | Ptex > Fill Faces Background

• Button | Ptex Toolbar > 

Fill the selected faces with the 
background color.
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Function How to access it What it does
Opens this 
dialog box Notes

Extract patch • Menubar | Patches > Extract 
Selected

• Right-click | canvas > Patches > 
Extract Selected 

Extracts the selected 
patches as images, and dis-
plays them in the Image 
Manager Palette.

You can only extract 
images up to 8K in res-
olution.

Select patches by 
number

• Menubar | Patches > Select Range

• Right-click | canvas > Patches > 
Select Range

Lets you enter a series of 
patch numbers in order to 
select those patches.

Select Patches

Copy selected 
patches to sys-
tem clipboard

• Menubar | Patches > Copy Indexes 
to Clipboard

• Right-click | canvas > Patches > 
Copy Indexes to Clipboard

• Right-click | Patches Palette > 
Copy Indexes to Clipboard

Copies selected patch IDs to 
the system clipboard.

Copies the UDIM of the 
selected patch(es) to 
the system clipboard, 
for use in other applica-
tions.

Paste selected 
patch

• Menubar | Patches > Quick Paste

• Right-click | canvas > Patches > 
Quick Paste

• Keyboard | Ctrl+V

Pastes a copied patch (from 
the clipboard).

Copy selected 
patch

• Menubar | Patches > Quick Copy

• Right-click | canvas > Patches > 
Quick Copy

• Keyboard | Ctrl+C

Copies the selected patch. Only copies the paint 
baked onto the patch 
(does not copy unbaked 
paint).

Copy textures • Menubar | Patches > Copy Textures

• Right-click | canvas > Patches > 
Copy Textures

Copies multiple textures 
from selected patches.

Copy Multiple 
Textures Dia-
log Box

Fill patches with 
black

• Menubar | Patches > Fill > Black

• Right-click | canvas > Patches > Fill 
> Black

Fills the patch with black 
paint.

Fill patches with 
gray

• Menubar | Patches > Fill > Gray

• Right-click | canvas > Patches > Fill 
> Gray

Fills the patch with gray 
paint.

Fill patches with 
white

• Menubar | Patches > Fill > White

• Right-click | canvas > Patches > Fill 
> White

Fills the patch with white 
paint.
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Fill patches with 
foreground color

• Menubar | Patches > Fill > Fore-
ground

• Right-click | canvas > Patches > Fill 
> Foreground

Paints the selected patch(es) 
with the current foreground 
color.

Fill patches with 
background color

• Menubar | Patches > Fill > Back-
ground

• Right-click | canvas > Patches > Fill 
> Background

Paints the selected patch(es) 
with the current background 
color.

Fill with patches 
with transparency

• Menubar | Patches > Fill > Trans-
parent

• Right-click | canvas > Patches > Fill 
> Transparent

Makes the selected patch(es) 
transparent.

Copy the patch 
mask

• Menubar | Patches > UV Mask to 
Image Manager

• Right-click | canvas > Patches > UV 
Mask to Image Manager

• Right-click | patch in Patches Pal-
ette > UV Mask to Image Manager

Copies the outline (mask) of 
the UVs on the patch to the 
Image Manager.

Copy the patches 
wireframe

• Menubar | Patches > UV Wireframe 
to Image Manager

• Right-click | canvas > Patches > UV 
Wireframe to Image Manager

Copies the wireframe of the 
UVs on the patch to the 
Image Manager.

Extend the patch 
bleed area

• Menubar | Patches > Bleed Patch 
Edges

• Right-click | canvas > Patches > 
Bleed Patch Edges

• Right-click | in Patches Palette > 
Bleed Patch Edges

Extends the bleed area at 
the edges of the UV patches 
out to the edge of the entire 
patch.

Flip patch verti-
cally

• Menubar | Patches > Transform > 
Flip Vertical

• Right-click | canvas > Patches > 
Transform > Flip Vertical

Flips the paint on the 
selected patch(es) vertically. 

Flip patch hori-
zontally

• Menubar | Patches > Transform > 
Flip Horizontal

• Right-click | canvas > Patches > 
Transform > Flip Horizontal

Flips the paint on the 
selected patch(es) horizon-
tally.

Rotate patch 90 
degrees counter-
clockwise

• Menubar | Patches > Transform > 
Rotate 90 CCW

• Right-click | canvas > Patches > 
Transform > Rotate 90 CCW

Rotates the paint on the 
selected patch(es) 90 
degrees counterclockwise.

Function How to access it What it does
Opens this 
dialog box Notes
Mari 2.0v1The Foundry
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Rotate patch 90 
degrees clockwise

• Menubar | Patches > Transform > 
Rotate 90 CW

• Right-click | canvas > Patches > 
Transform > Rotate 90 CW

Rotates the paint on the 
selected patch(es) 90 
degrees clockwise.

Rotate patch 180 
degrees

• Menubar | Patches > Transform > 
Rotate 180

• Right-click | canvas > Patches > 
Transform > Rotate 180

Rotates the paint on the 
selected patch(es) 180 
degrees.

Mirror patch from 
left to right

• Menubar | Patches > Mirror > Mir-
ror Left to Right

• Right-click | canvas > Patches > 
Mirror > Mirror Left to Right

Mirrors the paint on the 
selected patch(es) from left 
to right.

Mirror patch from 
right to left

• Menubar | Patches > Mirror > Mir-
ror Right to Left

• Right-click | canvas > Patches > 
Mirror > Mirror Right to Left

Mirrors the paint on the 
selected patch(es) from right 
to left.

Mirror patch from 
top to bottom

• Menubar | Patches > Mirror > Mir-
ror Top to Bottom

• Right-click | canvas > Patches > 
Mirror > Mirror Top to Bottom

Mirrors the paint on the 
selected patch(es) from top 
to bottom.

Mirror patch from 
bottom to top

• Menubar | Patches > Mirror > Mir-
ror Bottom to Top

• Right-click | canvas > Patches > 
Mirror > Mirror Bottom to Top

Mirrors the paint on the 
selected patch(es) from bot-
tom to top.

Link selected 
patches

• Menubar | Patches > Link > Link 
Selected Patch Images

• Right-click | canvas > Link > Link 
Selected Patch Images

• Right-click | Patches Palette > Link 
Selected Patch Images

Links patches that have been 
selected in the Patches pal-
ette. This allows you to 
quickly replicate changes 
from one patch across multi-
ple patches.

A colored box highlights 
linked patches in the UV 
view.

Unlink selected 
patches

• Menubar | Patches > Link > Unlink 
Selected Patch Images

• Right-click | canvas > Link > Unlink 
Selected Patch Images

• Right-click | Patches Palette > 
Unlink Selected Patch Images

Unlinks any linked patches 
that have been selected in 
the Patches palette.

Removes the colored 
box from the unlinked 
patches in the UV view.

Function How to access it What it does
Opens this 
dialog box Notes
Mari 2.0v1The Foundry
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Selects all 
patches linked to 
a specific patch

• Menubar | Patches > Link > Select 
Linked Patch Images

• Right-click | canvas > Link > Select 
Linked Patch Images

• Right-click | Patches Palette > 
Select Linked Patch Images

Selects all of the patches 
that have been linked to the 
specified patch selection, 
and highlights them in the 
Patches palette.

Unlinks all linked 
patches

• Menubar | Patches > Link > Unlink 
All Linked Patch Images

• Right-click | canvas > Link > Unlink 
All Linked Patch Images

• Right-click | Patches Palette > 
Unlink All Linked Patch Images

Unlinks all linked patches for 
the entire project.

Resize patches • Menubar | Patches > Resize 
Selected > Size

• Right-click | canvas > Resize 
Selected > Size

• Right-click | Patches Palette > 
Resize Selected > Size

Resizes the selected patches 
to the chosen size, including 
options to double or halve 
the size.

Function How to access it What it does
Opens this 
dialog box Notes
Mari 2.0v1The Foundry



11  SHADING FUNCTIONS

Function How to access it What it does
Opens this dialog 
box Notes

Add new shader • Menubar | Shading > 
Add New Shader 

• Right-click | in Shaders Palette > 
Add New Shader 

• Button | Shaders Palette > 

Adds a new shader from 
the choices:

• Phong

• Cook Torrance

• Beckman

• Blinn

• Flat

• Standard Lighting, and

• Choose Diffuse and 
Specular.

Create Shader 
Dialog Box when 
selecting Choose 
Diffuse and 
Specular.

The Choose Diffuse and 
Specular option allows 
you to create a custom 
shader. Refer to the 
Create Shader Dialog 
Box for more informa-
tion.

Duplicate shader • Menubar | Shading > Duplicate 
Shader 

• Right-click | in Shaders Palette > 
Duplicate Shader 

• Button | Shaders Palette > 

Makes a copy of the 
selected shader.

Delete shader • Menubar | Shading > Remove 
Shader

• Right-click | in Shaders Palette> 
Remove Shader 

• Button | Shaders Palette > 

Deletes the selected 
shader from the project.

Cut shader • Right-click | on shader in Shaders 
Palette > Cut

• Ctrl+X

Cuts the shader from the 
Shaders palette list and 
places it in the clipboard.

Default shaders cannot 
be cut or pasted.

Copy shader • Right-click | on shader in Shaders 
Palette > Copy

• Ctrl+C

Copies the shader from 
the Shaders palette list 
and places it in the clip-
board.

Default shaders cannot 
be copied or pasted.

Paste shader • Right-click | on shader in Shaders 
Palette > Paste

• Ctrl+V

Pastes the cut or copied 
shader from the clipboard 
into the Shaders palette 
list.

Set lighting on 
main mesh to flat

• Menubar | Shading > Flat 

• Toolbar | 

Shades all pixels with the 
same value.
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Set lighting on 
main mesh to 
basic

• Menubar | Shading > Basic 

• Toolbar | 

Applies a basic lighting 
model.

Set lighting on 
main mesh to full

• Menubar | Shading > Full 

• Toolbar | 

Applies a full, configu-
rable lighting model.

From within the Lighting 
palette, you can also 
adjust the four basic 
lights. 

Mari saves these light-
ing values with the proj-
ect.

Toggle shadows 
in the display

• Menubar | Shading > Shadows

• Toolbar | 

Toggles whether to show 
the shadows in the dis-
play.

This does not enable or 
disable shadow pro-
cessing. To enable 
shadow processing, 
enable Depth Projec-
tions in the Preferences. 
By default this prefer-
ence is disabled.

Toggle wireframe 
view

• Menubar | Shading > Toggle 
Wireframe

• Keyboard | Shift+W

• Toolbar | 

Toggles whether to show 
the wireframes on the 
model.

Toggle UV image 
rendering

• Menubar | Shading > Toggle 
UvImage

• Toolbar | 

Shows the patches in the 
UV view as they appear 
after export, including 
the overspill areas.

Toggle whole 
patch project

• Menubar | Shading > Toggle Whole 
Patch Project

• Toolbar | 

Enables painting outside 
geometry shell boundar-
ies in UV patches.

This is only available in 
UV views.

Function How to access it What it does
Opens this dialog 
box Notes
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Function How to access it What it does
Opens this 
dialog box Notes

Undo all unbaked 
painting

• Menubar | Painting > Clear 
Painting 

• Toolbar | 

• Mouse | 

Undo all painting not yet 
baked into the model (still in 
the paint buffer).

For the mouse gesture: press and 
hold \, click and drag in the direc-
tion indicated. (A thin red line 
traces gestures onscreen.)

Undo • Menubar | Edit > Undo 

• Keyboard | Ctrl+Z 

• Toolbar | 

• Mouse | 

Undo the last action. For the mouse gesture: press and 
hold \, click and drag in the direc-
tion indicated. (A thin red line 
traces gestures onscreen.) 

See also the History View Palette.

Redo • Menubar | Edit > Redo 

• Keyboard | Ctrl+Y 

• Toolbar | 

• Mouse | 

Redo the last (undone) 
action.

For the mouse gesture: press and 
hold \, click and drag in the direc-
tion indicated. (A thin red line 
traces gestures onscreen.) 

See also the History View Palette.

Bake painting into 
the model

• Keyboard | B 

• Menubar | Painting > Bake 

• Mouse | 

• Statusbar | 

Saves the painting as part of 
the project.

For the mouse gesture: press and 
hold \, click and drag in the direc-
tion indicated. (A thin red line 
traces gestures onscreen.)

Show or hide 
painting

•  Keyboard | . Shows or hides the contents 
of the paint buffer (that is, 
the unbaked paint).

Show or hide 
paintable areas 
(not currently 
masked out)

• Menubar | Painting > 
Toggle Mask Preview 

• Keyboard | , 

• Projection Palette | Mask 
Preview | MaskPreview 
Enabled

Shows or hides the current 
masking (including all mask-
ing currently turned on – the 
edge mask, channel mask, 
ambient occlusion mask, 
depth mask, and backface 
mask). When this is on, this 
shows paintable areas nor-
mally, and unpaintable areas 
are colored.
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Save current 
painting as a file

• Menubar | Painting > Save 
Painting

Saves the current unbaked 
paint (the contents of the 
paint buffer) as an .exr file.

Save Window 
Painting

Saves the paint buffer as an .exr 
file, and puts it in the Image Man-
ager Palette.

Load previously 
saved painting 
files

• Menubar | Painting > Load 
Painting

Loads an .exr file and proj-
ects it onto the model as the 
current painting.

Load Window 
Painting

Draw straight line 
between two 
points

• Mouse | Click, then Shift-
click

Draws a line with the current 
brush between the two 
selected points.

Draw straight line 
horizontally or 
vertically

• Mouse | Shift-click and 
drag

Constrains painting to 
straight horizontal or verti-
cal lines.

Toggle Last Brush 
Tip • Mouse | 

• Keyboard | N

Switches to the last brush 
tip used.

Function How to access it What it does
Opens this 
dialog box Notes
Mari 2.0v1The Foundry
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Function How to access it What it does
Opens this 
dialog box Notes

Apply Invert filter • Menubar | Filters > 
Invert

Inverts the colors in the 
selection’s alpha channel. 
Replaces colors with their 
“opposite” in the color chart. 
For example, replaces a 
color with a float value of 
0.3 with a color with float 
value 0.7.

Apply Invert

Apply Luminosity 
filter

• Menubar | Filters > 
Luminosity

Outputs just the luminosity 
value of each pixel in the 
selection. That is, it outputs 
a grayscale image based on 
the brightness of every pixel 
in the original image.

Apply 
Luminosity

Apply In Blur 
filter

• Menubar | Filters > 
Blur > Blur

Applies a standard blur to 
the selection.

Apply Blur You can select the blur radius — the 
number of pixels Mari uses when cal-
culating the blur value for each pixel. 
The higher the radius, the more 
blurred the results. If you use a larger 
blur radius, you may get slight lines 
on the boundaries between patches. 
This is an artifact of the way that 
Mari handles patch edges.

This filter is not supported with Ptex 
channels.

Apply Soften Blur 
filter

• Menubar | Filters > 
Blur > Soften

Applies a subtle softening 
blur. This is a quick, pre-
defined blur filter. If you 
need more control over the 
degree or type of blurring, 
use either the standard Blur 
or Gaussian Blur filters.

Apply Soften This filter is not supported with Ptex 
channels.

Apply Gaussian 
Blur filter

• Menubar | Filters > 
Blur > Gaussian

Applies a Gaussian blur. 
Compared to the standard 
Blur filter, this gives you 
much finer control over the 
degree of blurring, and the 
option of using much higher 
blur values.

Apply 
Gaussian

You can select the blur radius. The 
higher the radius, the more blurred 
the results. If you use a higher blur 
radius, you may see artifacts along 
the boundaries of geometry shells and 
UV patches.

This filter is not supported with Ptex 
channels.
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Apply Gamma 
filter

• Menubar | Filters > 
Gamma

Changes the gamma levels in 
the selection.

Apply Gamma Do Inverse reverses the gamma con-
version. That is, a higher setting for 
Gamma results in a more washed-out 
looking image.

Apply sRGB To 
Linear Filter

• Menubar | Filters > 
sRGB To Linear

Applies an sRGB to linear 
colorspace conversion.

Apply sRGB To 
Linear

Checking Invert applies a linear to 
sRGB colorspace conversion.

Apply Hue filter • Menubar | Filters > 
Hue

Changes the hue, saturation, 
and value of the colors on 
the model.

Apply Hue To change the hue of the colors, set 
the value for Hue. This moves the col-
ors around the color wheel. The rota-
tion value is the degree around the 
color wheel that each color shifts, 
between 0 and 360 (which both cor-
respond to the original colors). The 
options to change the Saturation are: 

• Saturation — how much saturation 
is applied. Select a multiplier from 0 
to 2, where 1.00 is the original sat-
uration value.

• Offset — an offset value to add to 
the initial saturation value, before 
applying the scale.

You can also edit the Saturation 
curve. This controls how the filter 
translates current saturation values 
to new values. For each input value 
along the bottom of the graph, the 
output value is set from the position 
of the line above that point. Edit the 
curve by: 

• pulling the anchor points 

• clicking between anchor points to 
add a new point 

• right-clicking to select from a set of 
preset values. 

You can edit the Scale, Offset and 
Value curve for the value of the colors 
in the same way.

Apply Brightness 
filter

• Menubar | Filters > 
Brightness

Changes the brightness of 
the paint, either overall or 
for specific color channels. 
You can also change the 
contrast.

Apply Bright-
ness

You can either change the brightness 
of all color channels at once, or one- 
by-one. Changing the main Brightness 
control changes (overwrites) any 
changes you make to brightness val-
ues for individual color channels.

Function How to access it What it does
Opens this 
dialog box Notes
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Apply Contrast 
filter

• Menubar | Filters > 
Contrast

Changes the contrast of the 
paint.

Apply Contrast You can select the amount of contrast 
using the slider.

Apply Clamp filter • Menubar | Filters > 
Clamp

Clamps color values to lie 
within the specified upper 
and lower values.

Apply Clamp Set the Upper Value and Lower Value 
by adjusting the sliders or entering 
values in the entry boxes.

Select the individual Color Component 
to clamp in the dropdown menu.

Apply Levels filter • Menubar | Filters > 
Levels

Changes the color levels in 
the paint, by setting the 
white point, midtone, and 
black point.

Apply Levels You can change the levels of all color 
components or each color component 
separately. You can set the:

• Color Component - whether this 
affects all color components, or a 
specific one (Red, Green, or Blue).

• White Point - the upper limit of dis-
played color intensity. Areas with a 
value higher than this are mapped 
to 1 (white).

• Midtone - the middle point between 
white and black. Mari remaps the 
values so that this is the middle of 
the range between the white point 
and black point. Moving this pushes 
the values towards that end of the 
spectrum.

• Black Point - the lower limit of dis-
played color intensity. Areas with a 
value lower than this are mapped to 
0 (black).

• White Output Level - how strongly 
to output the white in the filtered 
image. Higher values show the 
entire white output, lower values 
show decreasing amounts. 

• Black Output Level - how strongly 
to output the black in the filtered 
image. Higher values show the 
entire black output, lower values 
show decreasing amounts. 

Function How to access it What it does
Opens this 
dialog box Notes
Mari 2.0v1The Foundry



FILTER FUNCTIONS 43
 

Apply Color 
Curves filter

• Menubar | Filters > 
Color Curves

Changes the color curve for 
each color component (RGB) 
in the painting.

Apply Color 
Curves

You can also edit each color curve, 
controlling how each color component 
appears on-screen. This controls how 
the filter translates current color val-
ues to new values. For each input 
value along the bottom of the graph, 
the output value is set from the posi-
tion of the line above that point. Edit 
the curve by:

• pulling the anchor points 

• clicking between anchor points to 
add a new anchor point 

• right-clicking to select from a set of 
preset values.

Apply Color 
Switches filter

• Menubar | Filters > 
Color Switches

Turns individual color com-
ponents on or off.

Apply Color 
Switches

Use the checkboxes to select which 
color components are displayed. 
When Mari applies the filter, it 
removes any unchecked color compo-
nents from the painting.

Apply Tone 
Mapping filter

• Menubar | Filters > 
Tone Mapping

Varies the “exposure” of the 
painting.

Apply Tone 
Mapping

You can set the:

• White Point — the upper limit of 
color intensity displayed; any colors 
of greater intensity map to white.

• Exposure — lower exposures give 
darker images; higher exposures 
give lighter ones.

Apply Copy 
Channel filter

• Menubar | Filters > 
Copy Channel

Copies the value from one 
RGB color component to the 
other two. The result is a 
grayscale image with the 
intensity values from the 
selected component.

Apply Copy 
Channel

Select the source component from the 
list. When you apply the filter, Mari 
copies the selected component over 
the other two components.

Function How to access it What it does
Opens this 
dialog box Notes
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Apply Premultiply 
Alpha filter

• Menubar | Filters > 
Premultiply Alpha

Either pre- or post- multi-
plies the alpha in the 
selected image. If you are 
painting using an image 
without pre-multiplied alpha 
onto one with it, use this fil-
ter to perform the pre- mul-
tiplication, so the images 
match and you avoid lines 
around the outside of the 
patch. Post-multiply works 
the same, but in reverse 
[removes pre- multiplication 
to match images that do not 
have pre-multiplied alpha].

Apply Premul-
tiply Alpha

If the Postmultiply box is checked, the 
pre-multiplied alpha is removed.

Apply Edge 
Detect filter

• Menubar | Filters > 
Edge Detect

Finds “edges” (transitions 
between colors) in the image 
and heightens them.

Apply Edge 
Detect

This filter is not supported with Ptex 
channels.

Apply Emboss 
filter

• Menubar | Filters > 
Emboss

Applies an “emboss” effect, 
so that textures look 
“raised” on the surface.

Apply Emboss This filter is not supported with Ptex 
channels.

Apply Sharpen 
filter

• Menubar | Filters > 
Sharpen

Removes 'fuzziness' and 
clarifies detail in the image.

Apply Sharpen You can set the amount of sharpen-
ing. Higher values mean more sharp-
ening, while a value of 0.00 is the 
picture without the filter applied.

This filter is not supported with Ptex 
channels.

Apply High Pass 
Filter

• Menubar | Filters > 
High Pass

Removes low frequency 
information from the image 
while maintaining higher fre-
quency detail.

This can be useful for 
quickly creating specular 
maps where only the higher 
frequency image highlights 
are maintained.

Apply High 
Pass

You can set the kernel size (the 
amount of filtering) by adjusting the 
Radius.

If you use a large radius, you may get 
slight lines on the boundaries 
between patches. This is an artifact of 
the way that Mari handles patch 
edges.

This filter is not supported with Ptex 
channels.

Function How to access it What it does
Opens this 
dialog box Notes
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Apply Color Cor-
rection filter

• Menubar | Filters > 
Color Correction

Applies a colorspace correc-
tion to the current channel 
or painting.

Apply Color 
Correction

You have the option to use Mari’s 
default Configuration File or a custom 
one.

Set the colorspace of the current 
channel or painting in the Input Color-
Space dropdown.

Set the colorspace correction to apply 
to the current channel or painting in 
the Output ColorSpace dropdown.

Apply Add Noise 
filter

• Menubar | Filters > 
Add Noise

Applies noise to the current 
channel or painting.

Apply Add 
Noise

Use the Amount slider to adjust how 
much noise is applied and select the 
component you want to affect from 
the Color Component dropdown.

For additive grayscale noise that 
modifies the intensity while retaining 
the original color, check the Grayscale 
checkbox.

You can regenerate the noise using 
different random samples by dragging 
on the Seed slider.

Adjust the size of the noise applied by 
dragging on the Size slider.

Function How to access it What it does
Opens this 
dialog box Notes
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Function How to access it What it does
Opens this 
dialog box Notes

View all selected 
areas

• Menubar | Camera > View All 

• Keyboard | A 

• Mouse | 

Fills the canvas with all 
selected areas (or all objects 
in the project if nothing is 
selected).

For the mouse gesture: 
press and hold \, click and 
drag in the direction indi-
cated. (A thin red line traces 
gestures onscreen.)

Load FBX Camera • Menubar | Camera > Load 
Camera

Loads a 3rd party .fbx cam-
era view point of the current 
model.

(The view point may seem 
arbitrary, depending on the 
model)

Load Camera File format is .fbx

Project onto the 
front patches from 
the current view

• Menubar | Camera > Quick 
Project Front

Loads the data from the file 
set in the Quick Projection 
dialog. The result is pro-
jected onto the patches of 
the model visible from the 
current view, and baked on.

Quick Projection 
(if details have 
not already been 
set)

Project onto all 
images from the 
current view

• Menubar | Camera > Quick 
Project Through

Loads the data from the file 
set in the Quick Projection 
dialog. The result is pro-
jected onto all patches of 
the model (whether visible in 
the current view or not) and 
baked on.

Quick Projection 
(if details have 
not already been 
set)

Unproject from the 
current view

• Menubar | Camera > Quick 
Unproject

Saves the current baked 
painting, as visible in the 
current view, to an image 
file (as set in the Quick 
Projection properties dialog 
box).

Quick Projection 
(if details have 
not already been 
set)

Set up quick 
projection

• Menubar | Camera > Quick 
Projection Settings

Lets you set the image Res-
olution, Path and Lighting 
setup for the projected file.

Quick Projection

View left side of 
model

• Menubar | Camera > Camera 
Left

• Keyboard | 1

Changes the view to show 
the “left” side of the model.

Model's “left” (may seem 
arbitrary, depending on the 
model).

View right side of 
model

• Menubar | Camera > Camera 
Right 

• Keyboard | 2

Changes the view to show 
the “right” side of the model.

Model's “right” (may seem 
arbitrary, depending on the 
model).
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View top of model • Menubar | Camera > Camera 
Top 

• Keyboard | 3

Changes the view to show 
the “top” of the model.

Model's “top” (may seem 
arbitrary, depending on the 
model).

View bottom of 
model

• Menubar | Camera > Camera 
Bottom 

• Keyboard | 4

Changes the view to show 
the “bottom” of the model.

Model's “bottom” (may seem 
arbitrary, depending on the 
model).

View front of 
model

• Menubar | Camera > Camera 
Front 

• Keyboard | 5

Changes the view to show 
the “front” the model.

Model's “front” (may seem 
arbitrary, depending on the 
model).

View back of 
model

• Menubar | Camera > Camera 
Rear 

• Keyboard | 6

Changes the view to show 
the “rear” the model.

Model's “back” (may seem 
arbitrary, depending on the 
model).

Create a projector • Right-click | in 
Projectors Palette > Create 
Projector

• Button | Projectors Palette 
> 

Sets the current camera and 
paintable region, to frame a 
particular view on the model.

Use the view saved 
in a particular 
projector

• Right-click | Projector in 
Projectors Palette > Make 
Projector Current

Changes the current view to 
the view set in the selected 
projector.

Save the current 
camera view

• Right-click | Projector in 
Projectors Palette > Save 
Projector 

• Button | Projectors Palette 
> 

Saves the current projector 
(including all details of the 
view) to disk.

Save

Save all projectors 
defined in the 
project

• Right-click | in 
Projectors Palette > Save All 
Projectors

Saves all the projectors cur-
rently defined in the project. 
Mari saves all the projectors 
as a single file.

File format is .mpc (Mari 
Projector Collection).

Load projectors 
from disk

• Right-click | in Projectors 
Palette > Load Projector 

• Button | Projectors Palette 
> 

Loads one or more projec-
tors from a file, and changes 
the current view to the first 
projector in the file.

Load

Save a snapshot 
from a projector to 
a file

• Right-click | Projector in 
Projectors Palette > 
Unproject

Saves the current baked 
painting from the selected 
projector to an image file.

Save Unpro-
jected Image (if 
Output Path has 
not been set yet)

Function How to access it What it does
Opens this 
dialog box Notes
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Load image data 
from the current 
projector

• Right-click | Projector in 
Projectors Palette > Project

Loads the data from the file 
specified for that projector, 
projects it onto the model, 
and bakes it on.

Pick Path (if 
Input Path has 
not been set yet)

Load image data 
into the paint buf-
fer from the cur-
rent projector

• Right-click | Projector in 
Projectors Palette > Import 
Image

Loads the data from the file 
specified for that projector, 
and puts it into the paint 
buffer.

Pick Path (if 
Input Path has 
not been set yet)

Load a projector • Right-click | Projector in 
Projectors Palette > Make 
Projector Current

Displays the current project 
with that projector (camera 
and paintable region).

Remove a projec-
tor

• Right-click | Projector in 
Projectors Palette > Remove 
Projector 

• Button | Projectors Palette 

> 

Deletes that projector.

Generate a render 
turntable from a 
projector

• Right-click | Projector in 
Projectors Palette > Render 
Turntable

Takes the scene as viewed 
through the selected projec-
tor, and creates a series of 
images showing the scene 
rotating through an axis. 
You can include custom text 
or thumbnails of reference 
images in the turntable.

Render Turnta-
ble Dialog Box

Generate a diag-
nostic turntable 
from a projector

• Right-click | Projector in 
Projectors Palette > Diag-
nostic Turntable

Takes the scene as viewed 
through the selected projec-
tor, and creates a turntable 
for a set of channels. The 
turntable has flat lighting 
and uses the default shader.

Diagnostics 
Turntable Dialog 
Box

Rotate • Mouse | Alt and drag Drag to rotate the model in 
different directions.

Keys plus mouse movement; 
uses last mouse click as 
pivot point.

Zoom • Mouse | Alt+Ctrl and drag 
left or right

Drag left to zoom out, right 
to zoom in.

Keys plus mouse movement.

Pan • Mouse | Alt+Shift and drag Drag the model to a differ-
ent place on the canvas.

Keys plus mouse movement

Spin • Mouse | Ctrl+R and drag Drag up to spin the model 
clockwise, left to spin coun-
terclockwise

Keys plus mouse movement.

Function How to access it What it does
Opens this 
dialog box Notes
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Focus • Keyboard | F Re-centers view on selected 
patch(es).

If no patches are selected, 
focuses on the center of the 
model.

Switch to Ortho 
Camera

• Keyboard | F10 Switches the canvas view to 
Orthographic mode.

Switch to 
Perspective 
Camera

• Keyboard | F11 Switches the canvas view to 
Perspective mode.

Enables the Near, Far, and 
FoV fields. See Projectors 
palette fields for more 
information.

Switch to UV 
Camera

• Keyboard | F12 Switches the canvas view to 
UV mode.

Reset the model 
position

• Keyboard | 1 In the UV view, resets the 
model to its default position.

Rotate the model 
90 degrees coun-
ter-clockwise

• Keyboard | 2 In the UV view, rotates the 
model 90 degrees counter-
clockwise from the default 
position.

Rotate the model 
180 degrees coun-
ter-clockwise

• Keyboard | 3 In the UV view, rotates the 
model 180 degrees counter-
clockwise.

Rotate the model 
270 degrees coun-
ter-clockwise

• Keyboard | 4 In the UV view, rotates the 
model 270 degrees counter-
clockwise.

Function How to access it What it does
Opens this 
dialog box Notes
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Function How to access it What it does
Opens this dialog 
box Notes

Set the dis-
play properties

• Right-click | main canvas 
> Display Properties 

• Menubar | View > Display 
Properties

Opens a dialog box allowing 
you to control how the main 
canvas displays.

Display Properties 
Dialog Box

Save the cur-
rent layout

• Menubar | View > Save 
Layout

Saves the current layout of 
your Mari workspace as a 
*.mws file.

Save Window 
Layout

Saves the position of palettes 
and other elements of the GUI.

Open a saved 
layout

• Menubar | View > Load 
Layout

Opens a saved layout (*.mws 
file).

Load Window 
Layout

By default, Mari starts with the 
last-used layout.

Revert to the 
default layout

• Menubar | View > Default 
Layout

Resets the layout back to 
the Mari default.

Save image of 
current canvas

• Menubar | View > Take 
Screenshot

Saves the current view of 
the canvas as an image file.

Various image formats available.

Adjust the 
screenshot 
settings

• Menubar | View > Screen-
shot Settings

Opens a dialog box that 
allows you to set how 
screenshots are saved.

Screenshot Set-
tings

Hide docked 
palettes

• Menubar | View > Hide 
Palettes 

• Keyboard | Home

Hides all docked palettes, so 
the canvas takes up the 
entire workspace.

The Home key cycles between 
showing all palettes, hiding 
undocked palettes, and hiding all 
palettes.

Hide GUI 
components on 
canvas

• Keyboard | / Hides displayed information 
(such as the histogram, 
heads-up display, etc) from 
the canvas.

View a 
particular 
palette

• Menubar | View > Palettes 
><palette name> 

• Right-click | Menubar or 
Toolbar > 
<palette name>

Displays the selected pal-
ette.

The palette re- displays in its last 
position.

Enter full 
screen mode

• Menubar | View > Full 
Screen

Enters full screen mode Click View > Full Screen to exit 
full screen mode.
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Function How to access it What it does
Opens this 
dialog box Notes

View installed 
plug-ins

• Menubar | Tools > Plug-
ins

Displays a list of installed 
plug-ins.

Plug-ins Drag the edge of the dialog box, and 
column headings within, to display 
full content.

Imports Custom 
Brushes

• Menubar | Tools > Import 
Brushes

Allows you to select the cus-
tom Photoshop brush file 
that you want to import into 
Mari

Import 
Brushes

Photoshop custom brush files must 
be in the .abr file format.

Set the Mari 
cache location

• Menubar | Tools > Cache 
Location Setup

Lets you set the area to hold 
the Mari cache.

Cache 
Location

You can only add or remove addi-
tional cache locations when there 
are no projects. Once projects have 
been created for a given set of 
cache locations, that set must not 
be changed or project corruption 
will occur.

Make changes to 
your license

• Menubar | Tools > License Lets you:

• purchase, activate, and 
install licenses, 

• tell Mari where to find a 
license server, 

• obtain 15-day trial 
licenses,

• see how many days remain 
before your license 
expires (if you are using a 
temporary license),

• see your System ID (if you 
are using a node locked 
license), and

• see your server name (if 
you are using a floating 
license).

Mari Licens-
ing

You can only obtain a trial license 
for a major Mari release once on 
each machine. For example, if you 
had a trial license for Mari 1.1v1, 
you can’t get another one for Mari 
1.1v2 on the same machine.
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Function How to access it What it does Notes

Execute example scripts • Menubar | Python > Examples Executes example scripts and displays 
results in the output pane of the Python 
Console.

View Python API docu-
mentation

• Menubar | Python > Documenta-
tion

Displays the Python API documentation in 
a web browser.

View Software API Over-
view documentation

• Menubar | Python > Readme Displays the Software API Overview doc-
umentation.

An introduction to 
Python in Mari and 
GLSL shaders

Display Python Console • Menubar | Python > Show Console Displays the Python Console
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Function How to access it What it does Notes

View information about 
Mari

• Menubar | Help > About Displays the Mari info screen. About this release, 
credits, and so on.

View the Mari Getting 
Started Guide

• Menubar | Help > Getting Started Displays the basic guide to working with 
Mari.

View the Mari User Guide • Menubar | Help > User Guide Displays the comprehensive, step-by-
step guide to all Mari's functions.

View the Mari Reference 
Guide

• Menubar | Help > Reference Guide Displays the overall Mari reference guide.

View the Mari Release 
Notes

• Menubar | Help > Release Notes Displays a web page that links to the 
release notes

View the Mari Training 
Resources web page.

• Menubar | Help > Training and 
Tutorials

Displays a web page with links to user 
guide assets and video tutorials.

View Software API Over-
view documentation

• Menubar | Help > SDK > API 
Overview

Displays the Software API Overview doc-
umentation.

An introduction to 
Python in Mari and 
GLSL shaders.

View the Python API doc-
umentation and examples.

• Menubar | Help > SDK > Python Displays the Python API documentation 
and a list of examples.

View the C API documen-
tation and examples.

• Menubar | Help > SDK > C API Displays the C API documentation and a 
list of examples.
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Project Toolbar

Project Toolbar 
Controls

What it looks like What it does

Lets you perform common project functions, such as creating, closing and saving proj-
ects.

Control Type What it does
Opens this 
dialog box Notes

button Create a new project. New Project 
Dialog Box

Name the project, 
select options, and 
add geometry.

button Close the current project. Save Changes 
Before Clos-
ing? (if 
unsaved 
changes)

button Save the current project.

button Undo the last action. See also History View 
Palette.

button Redo the last action. See also History View 
Palette.
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Lighting Toolbar 
Lighting Toolbar

Lighting Toolbar 
Controls

Painting Toolbar

What it looks like What it does

Lets you change the lighting on the object. You can choose from three lighting presets: flat, basic, or 
full, and toggle the use of shadows in the display.

By default, lighting is relative to the scene, not the view. You can set individual lights to move with 
the view.

Mari saves custom lighting with the project. If you need the same lights in another project, you need 
to set them up separately.

Control Type What it does Notes

button Set the lighting on the object to "flat". In this mode, the position of the lights has no 
effect. 

button Set the lighting on the object to "basic". In this mode, you can move lights around on the 
canvas or make fine adjustments to lighting using 
the Lights Palette.

button Set the lighting on the object to "full". In this mode, you can move lights around on the 
canvas or make fine adjustments to lighting using 
the Lights Palette.

button Toggles shadows on or off. This does not enable or disable shadow processing. 
It simply controls whether the shadows are dis-
played or not. To enable shadow processing, 
enable Depth Projections in the Preferences. By 
default, this preference is disabled.

What it looks like What it does

Clears all painting not yet baked into the model (still in the paint buffer).
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Tools Toolbar 
Tools Toolbar

Tools Toolbar 
Controls

What it looks like What it does

Lets you select a tool for 
painting.

Control Type What it does
Opens this 
dialog box Notes

button Activate the Select tool. This tool lets you select 
areas on the model(s) in your project.

You can select whole objects, 
patches, or areas on the surface of 
the objects. Once you have made a 
selection, you can choose to show or 
hide the selected areas, or to lock 
them for editing.

button Activate the Marquee Select tool. This tool lets you 
select areas on the screen, to control where you 
can apply paint.

When you've made a selection, paint 
only bakes down within the selected 
areas.

button Activate the Transform Paint Buffer tool. This tool 
lets you resize, rotate, and move the paint buffer 
(and any unbaked paint in the buffer). It works on 
the entire paint buffer at once.

You can also make these transfor-
mations by manually editing the val-
ues under Transform in the Paint 
Buffer section of the Painting Pal-
ette.

button Activate the Zoom Paint Buffer tool. This tool lets 
you zoom in and out of the scene with the paint 
buffer locked to the object and without baking the 
paint.

You can also enable this tool by 
pressing Z. Zooming is reset when 
paint is baked.

button Activate the Pan Object tool. This tool lets you 
move objects and lights around on the canvas.

button Activate the Vector Inspector tool. This tool lets 
you control the appearance of the directional 
markers for painted vectors.

You can opt to enable or disable the 
visibility of the directional markers 
in the Vector Inspector toolbar. If 
the markers don’t appear when you 
select the tool, ensure that this 
option is set to enabled.
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Tools Toolbar 
button Activate the Blur tool. This tool lets you blur paint 
already baked on a model.

If you want to blur large areas of the 
surface, you may want to use the 
blur Filter Functions instead. These 
apply a controlled blur to entire 
patches or objects. Mari includes 
several blur filters, including a con-
trollable Gaussian blur.

button Activate the Warp tool. This tool lets you warp a 
selected area within your paint buffer. You create a 
warp box — a rectangle with between 4 and 64 
control points.

button Activate the Slerp tool. This tool works like the 
Liquify tool in Adobe® Photoshop®. It lets you 
“pull” the contents of the paint buffer around.

As well as pulling, Slerp lets you 
grow, shrink, and rotate the paint. 
You can also use it to selectively 
erase distortions you've already 
applied.

button Activate the Pinup tool. This tool lets you works 
like the Warp tool, but lets you set your own con-
trol points (pins) wherever you want.

Shift-click to create a pin. 

button Activate the Paint tool. This tool lets you draw 
paint strokes in the paint buffer.

button Activate the Vector Paint tool. This tool lets you 
draw vector paint strokes in the paint buffer.

button Activate the Eraser tool. This tool lets you erase 
paint from the paint buffer. It does not affect any 
underlying paint baked onto the model.

To clear the entire paint buffer, click 

the  button in the Painting 

Toolbar.

button Activate the Paint Through tool. This tool lets you 
position an image over an object, and then as you 
paint, paints the image "through" onto your model. 

button Activate the Paint Gradient tool. This lets you cre-
ate a color gradient floating over your model, 
which you can paint through to stamp onto your 
model (like the Paint Through tool). 

button Activate the Clone Stamp tool. This tool lets you 
clone from an existing image, shown in a separate 
window. You set a source point on the image. As 
you paint, Mari copies the texture around that 
source point onto your model. 

You can also clone stamp from 
painting already on an object, in the 
paint buffer, or in another channel.

Control Type What it does
Opens this 
dialog box Notes
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Selection Toolbar 
Selection 
Toolbar

button Activate the Towbrush tool. This tool lets you lets 
you select areas of paint and drag them around the 
surface of your model. As you tow the paint 
around, it blends the edges of your selection with 
the surrounding paint. It works like the Clone 
Stamp tool, but blends in the edges of the cloned 
selection.

button Activate the Color Picker / Pixel Analyzer tool. This 
tool lets you pick a color from the paint on the 
model.

Color 
swatch

button Select a foreground color. Select Color

button Swap the foreground and background colors.

Color 
swatch

button Select a background color. Select Color

button Set the foreground color to white and the back-
ground color to black.

Control Type What it does
Opens this 
dialog box Notes

What it looks like What it does

Lets you switch between three selection modes (objects, patches, and faces) when using the Select tool.
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Selection Toolbar 
Selection Toolbar 
Controls

Control Type What it does Notes

button Set Mari to select whole objects.

button Set Mari to select patches on objects. You can hold down Shift to add to the 
selection, Ctrl to remove from the selection, 
and Meta (Windows) to intersect the selec-
tion.

button Set Mari to select areas on objects. You can hold down Shift to add to the 
selection, Ctrl to remove from the selection, 
and Meta (Windows) to intersect the selec-
tion.
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Canvas Toolbar 
Canvas Toolbar

Canvas Toolbar 
Controls

What it looks like What it does

Lets you set the view options for the UV and 
3D views.

Control Type What it does Notes

button Toggle whether to show the wireframes on the model. You can also press Shift+W to do this.

button Toggle between showing the patches in the UV view:

• as they appear as part of the model, and

• as they appear when exported (that is, as square images, with 
overpaint areas around the corners of the patches).

button Toggle whether paint can be projected onto UV patches located 
outside the shells of the original geometry.

This control is only available in UV view.

button Switch to the orthographic camera view.

button Switch to the perspective camera view. In this view, you can set the near and far 
clipping planes and the field of view.

button Switch to the UV camera view (the UV tab). This gives you a 
“flat” view of the patches in the model.

Near entry box Set the value for the near clipping plane. Mari doesn’t display 
parts of the scene that are closer than the Near plane.

This control is only available in the per-
spective camera view.

Far entry box Set the value for the far clipping plane. Mari doesn’t display 
parts of the scene that are further than the Far plane.

This control is only available in the per-
spective camera view.

FoV entry 
box, 
slider

Set the value for the field of vision. This controls how much Mari 
distorts the view when applying perspective. At 0, the perspec-
tive camera gives exactly the same view as the ortho camera. As 
the value increases, the distortion increases.

This control is only available in the per-
spective camera view.
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Tool Properties Toolbar 
Tool Properties 
Toolbar

Tool Properties 
Toolbar Controls

What it looks like What it does

Displays information about the selected 
tool.

Tool Control Type What it does
Opens this 
dialog box Notes

Facing dropdown Set whether the selection only applies to the 
Front of the model as you can see it, or if the 
selection goes Through the model and includes 
the other side.

button Activate Rectangle Selection mode. This lets you 
draw a rectangular selection.

This control only 
works in Face selec-
tion mode. 

button Activate Lasso Selection mode. This lets you 
draw the outline of your selected area. You can 
draw any shape you want.

This control only 
works in Face selec-
tion mode.

button Activate Smart Selection mode. This lets you cre-
ate selections based on the surface of the model. 

Smart selection only 
works in Face selec-
tion mode.

Smart SelType dropdown Choose whether to base your smart selection on:

• Connectedness — selects the areas on the 
model connected to the selected face. When 
you look at the area in the UV view, this 
selects the whole connected area within the 
current UV patch. If the UV patch holds several 
different areas, only those areas you click on 
are selected.

• Edge Angle — selects based on the degree of 
change between neighboring faces. The selec-
tion goes until it hits an angle higher than the 
Smart Sel Angle.

• Orientation — selects the area that faces in 
the same direction as your initial selection.

This control only 
works in Smart Selec-
tion mode.
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Tool Properties Toolbar 
Smart Sel Angle entry box, 
slider

Set the maximum angle for the smart selection.

• For Edge Angles, this sets the maximum angle 
between areas on the model surface. For exam-
ple, if the angle is set to 30, this selects areas up 
to a 30 degree change of facing.

• For Orientation, this sets how far from the fac-
ing of your original selection the selection goes 
to. For example, if the angle is set to 30, this 
selects areas up to 30 degrees away from the 
facing of your original selection.

This control only 
works in Smart Selec-
tion mode.

All button Select all items.

None button Unselect all items.

Invert button Invert the current selection. Unselected areas 
become selected, and vice versa.

Grow button Grow the current selection. This control only 
works in Face selec-
tion mode.

Shrink button Shrink the current selection. This control only 
works in Face selec-
tion mode.

Grow/Shrink by dropdown Choose whether to grow or shrink the current 
selection by Vertex or Edge.

This control only 
works in Face selec-
tion mode.

button Activate Rectangle Selection mode. This lets you 
draw a rectangular selection.

button Activate Lasso Selection mode. This lets you 
draw the outline of your selected area. You can 
draw any shape you want.

button Activate Ellipse Selection mode. This lets you 
draw an elliptical selection.

button Activate MagicWand Selection mode. This lets 
you select by color. When you click, Mari creates 
a selection around the point you clicked. The 
selection is based on color – areas with a similar 
color to the original point are selected. You can 
change the color threshold for the selection.

Tool Control Type What it does
Opens this 
dialog box Notes
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Tool Properties Toolbar 
Mode button How drawing a new selection affects the current 
marquee selection:

• Replace — the new selection replaces the 
existing selection.

• Transform — this lets you move your selection 
area around (move, rotate, or scale the selec-
tion).

In Replace mode (the 
default), you can:

• hold down Shift, 
click and drag to 
add to the current 
selection, or

• hold down Ctrl, click 
and drag to remove 
from the current 
selection.

In Transform mode, 
you can:

• hold down Shift, 
click and drag to 
move the current 
selection,

• hold down Ctrl, click 
and drag to rotate 
the current selec-
tion, or

• hold down 
Shift+Ctrl, click and 
drag to scale the 
current selection.

Invert button Invert the current selection. Unselected areas 
become selected, and vice versa.

Clear button Clear the current selection.

Feathering entry box Soften the edges of the selection. Higher values 
give the selection a softer, fuzzier edge. At 0, the 
selection has a hard edge.

Reset Buffer button Reset any transformations (moves, rotations, 
scales) applied to the paint buffer (and any 
unbaked paint in the buffer).

Reset button Reset the zoom level of the paint buffer.

Zoom In button Zoom in on the paint buffer.

Zoom Out button Zoom out of the paint buffer.

No properties.

Tool Control Type What it does
Opens this 
dialog box Notes
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Tool Properties Toolbar 
Reset button Reset the settings of the vector inspector. Can also be done by 
using the ’ (apostro-
phe) shortcut when 
the vector inspector 
is active.

Enabled checkbox Enable (or disable) the visible directional markers 
for the vector paint tool.

Can also be done by 
using the Shift+I 
shortcut.

Line spacing entry box, 
slider

Adjust the spacing between the directional mark-
ers.

Can also be done by 
Shift+dragging the 
mouse when the vec-
tor inspector is 
active.

Line length entry box, 
slider

Adjust the length of the directional markers.

Line width entry box, 
slider

Adjust the width (thickness) of the directional 
markers.

Start Color button Change the color at the base of the directional 
markers.

End Color button Change the color at the tip of the directional 
markers.

Vector Space dropdown Set whether the vector inspector operates in 
ScreenSpace, TangentSpace, or WorldSpace.

Same as Paint, 
plus the following:

Blur entry box, 
slider

Set the blur strength. The higher the value, the 
more blur is produced.

Clear button Remove the current warp.

+ button Increase the number of control points (up to 64) 
in the warp grid.

- button Decrease the number of control points in the 
warp grid.

Toggle Grid button Toggle between hiding and displaying the grid 
lines connecting the control points.

Tool Control Type What it does
Opens this 
dialog box Notes
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Tool Properties Toolbar 
Mode dropdown Select how to use the Slerp tool:

• Pull — pulls paint around.

• Grow — makes the paint in a specific area 
larger.

• Shrink — makes the paint in a specific area 
smaller.

• Rotate — rotates paint around.

• Erase — lets you undo the distortion in a spe-
cific area of the painting.

You can also:

• press ’ (apostrophe) 
to undo all the dis-
tortions you've 
applied, or

• press ; (semicolon) 
to apply your 
changes to the 
paint buffer (that 
is, make them so 
you can't erase the 
distortions).

Radius entry box, 
slider

Set the slerp radius (that is, how big the brush 
tip is).

Opacity entry box, 
slider

Set the strength of the Slerp effect.

Reset Pins button Undo all the distortions you've applied, moving 
the pins back to their original positions.

You can also press ’ 
(apostrophe) to do 
this.

Clear Pins button Remove all the current pins. You can also press 
Ctrl+’ (apostrophe) to 
do this.

+ button Increase the strength of the currently selected 
pin. Stronger pins pull more of the surrounding 
texture towards them.

You can also press 
the Up arrow key to 
do this.

- button Decrease the strength of the currently selected 
pin.

You can also press 
the Down arrow key 
to do this.

Apply button Apply your changes to the paint buffer and 
remove all current pins.

You can also press ; 
(semicolon) to do this.

Tool Control Type What it does
Opens this 
dialog box Notes
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Tool Properties Toolbar 
Painting Mode dropdown The blending mode used when the paint bakes 
down onto the channel surface. The default is 
Normal (paint in the buffer overwrites the sur-
face), but Mari supports a number of other 
blending modes.

Colors checkbox Whether more pressure causes the color to vary 
(from slightly darker to the target color).

Alpha checkbox Whether more pressure increases the opacity.

Radius checkbox Whether more pressure increases the radius.

Flow checkbox Whether more pressure increases the flow.

Radius entry box Set how big the brush tip is (in pixels). You can also adjust 
the opacity by press-
ing R and clicking and 
dragging.

Opacity entry box How opaque the paint is. This is a multiplier on 
the paint buffer contents. At 1.0, the paint bakes 
down to the surface with the same opacity as it 
is in the buffer. At 0.5, the paint applied to the 
surface is half as transparent as when it's in the 
buffer.

You can also adjust 
the opacity by press-
ing O and clicking and 
dragging.

Flow entry box Mimics how quickly paint is applied, by setting 
the maximum opacity in a splat.

Same as Paint

Same as Paint.

Tool Control Type What it does
Opens this 
dialog box Notes
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Tool Properties Toolbar 
Same as Paint, 
plus the following:

Mode dropdown Select from two modes:

• Paint through — you hover the image preview 
over the model and stamp it down onto the 
surface.

• Image clone — you hover the image next to the 
model, set a source point, and clone from that 
point.

The Image clone mode 
is like the normal 
Clone Stamp tool, but 
you have more control 
over the source image 
(you can resize, 
stretch, and rotate it).

Stamp button Stamp the image straight onto the model. You can also press ’ 
(apostrophe) to do 
this.

Toggle Repeat button Toggle source image tiling on and off. If this is 
on, when you paint off the edge of the image, 
Mari repeats the image (so you always have 
source data).

You can also press ; 
(semicolon) to toggle 
this.

Tool Control Type What it does
Opens this 
dialog box Notes
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Tool Properties Toolbar 
Tint button Tint combines the foreground color with the 
paint through texture.

Stencil dropdown Stencil uses the Paint Through texture’s alpha 
channel as a mask and paints the foreground 
color. There are three options available:

• No Stencil - if this is selected, Mari ignores the 
stencil color and follows the alpha value.

• Stencil - if this is selected, paint is applied to 
the foreground color.

• Inverted Stencil - if this is selected, paint is 
applied in everything that is transparent.

By default the option 
is set to No Stencil.

Luminance dropdown Luminance uses the Paint Through texture’s lumi-
nance instead of the alpha, but works similarly to 
Stencil. The following options exist within the 
same dropdown menu as the Stencil options:

• Luminance - Works well for dirt, noise, and 
other similar images by using the luminance 
value of an image instead of the alpha.

• Inverted Luminance - Similar to the luminance 
option, but the calculated luminance value is 
inverted before use.

By default, the option 
in the dropdown menu 
is set to No Stencil.

Reset Image button Reset any transformations (such as moving, 
resizing, or rotating) you have made to the 
source image that you're cloning.

Pan Lock checkbox Lock the image position relative to the model. If 
you pan the model, the image that you're painting 
through pans too.

Scale Lock checkbox Lock the image size relative to the model. If you 
zoom the model in or out, the image that you're 
painting through zooms in or out too.

Tool Control Type What it does
Opens this 
dialog box Notes
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Tool Properties Toolbar 
Same as Paint, 
plus the following:

Color swatch Select the start color for the gradient. Select Color

Color swatch Select the end color for the gradient. Select Color

In Point entry box How far through the gradient the start color 
lasts (before it starts graduating into the end 
color).

Out Point entry box How far through the gradient the end color 
reaches.

Type dropdown Select between Linear or Radial gradient. A linear 
gradient has a color at one end grading into the 
other color. A radial gradient has a color in the 
middle, radiating out in a circle to the other color 
on the outside.

Same as Paint, 
plus the following:

Source dropdown Clone from:

• Current Paint Target - the model's surface 
(baked paint) in the active channel.

• Painting - the current (unbaked) paint in the 
paint buffer.

• Image - an external image (selected from the 
Image Manager, optionally zoomed in or out).

• Any of the other channels in the project.

button Clone from the selected region to another part of 
the surface.

button Overwrite the selected region with another part 
of the surface.

button Swap the contents of the selected region with 
another area on the surface.

Sample Size entry box, 
slider

Radius in pixels that the eyedropper uses when 
sampling colors off the surface. The eyedropper 
takes the average value of all the pixels in this 
area, and sets this as the foreground color.

Tool Control Type What it does
Opens this 
dialog box Notes
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Ptex Toolbar 
Ptex Toolbar

Ptex Toolbar 
Controls

What it looks like What it does

Displays a number of options for manag-
ing Ptex faces within your project.

This toolbar is only available for Ptex 
channels.

Control Type What it does Notes

button Double the selected face resolution.

button Halve the selected face resolution.

button, 
entry box

Set the world space face resolution for the selected face. Enter the Texel Density and then click 

.

button, 
dropdown

Set the face resolution for the selected face.
Select the Size and then click .

dropdown Fill the selected faces with the foreground color.

button Fill the selected faces with the background color.
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ColorSpace Toolbar 
ColorSpace 
Toolbar

ColorSpace Controls

What it looks like What it does

Displays a number of options for 
managing colorspaces in Mari.

Control Type What it does Notes

button Enable color management. Click to toggle.

button Select a custom colorspace configuration file.

button Select a custom LUT to apply to the scene.

button Clear the current LUT applied to the scene.

Extrapolate checkbox Sets whether the GPU extrapolates the grid values or 
clamps to the maximum value of the LUT.

InputColor 
Space

dropdown Set the colorspace of the scene.

Display 
Device

dropdown Set the colorspace of the display device used to view the 
scene.

View Trans-
form

dropdown Select a colorspace transform to apply to the scene.

Component dropdown View the individual color channels for the scene.

Gain incre-
menter, 
entry box, 
slider

Set the amount of exposure adjustment applied before the 
display transform.

You can boost or reduce Gain by entering 
a multiplier (exposure value), dragging on 
the slider, or adjusting the F-Stop value.

Gamma entry box, 
slider

Set the amount of gamma correction applied after the dis-
play transform.

You can boost or reduce Gamma by 
entering a gamma level or dragging on 
the slider.
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Navigation Toolbar 
Navigation 
Toolbar

Navigation Toolbar 
Controls

What it looks like What it does

Displays a number of options for managing navigation in Mari.

Control Type What it does Notes

button Resets all the options in the Navigation toolbar to the 
default settings.

button, 
dropdown

Provides the following options for panning:

• Pan All - allows panning in any direction.

• Pan X - allows panning on the x axis only.

• Pan Y - allows panning on the y axis only.

• Pan Disabled - disables all panning.

The button changes to reflect the 
selected option.

button, 
dropdown

Provides the options to either enable or disable zooming. The button changes to reflect the 
selected option.

button, 
dropdown

Provides the options to either enable or disable rolling. The button changes to reflect the 
selected option.
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Paint Buffer Symmetry Toolbar 
Paint Buffer 
Symmetry 
Toolbar

button, 
dropdown

Provides the following options for orbiting:

• Orbit All - allows orbiting around the model in any direc-
tion.

• Orbit X - allows orbiting around the model on the x axis 
only.

• Orbit Y - allows orbiting around the model on the y axis 
only.

• Orbit Disabled - disables all orbiting.

The button changes to reflect the 
selected option.

button, 
dropdown

Provides the following options:

• Snap 45 degrees - when rotating the model it snaps at 
45 degree angles.

• Snap 90 degrees - when rotating the model it snaps at 
90 degree angles.

• Snap angle disabled - when rotating the model it does 
not snap to any angle.

The button changes to reflect the 
selected option.

Control Type What it does Notes

What it looks like What it does

Displays the four options for the Paint Buffer Symmetry functionality.
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Paint Buffer Symmetry Toolbar 
Paint Buffer 
Symmetry Toolbar 
Controls

Control Type What it does Notes

button This is the default setting. When mirroring is disabled, the 
paint buffer acts as normal and the paint strokes are not 
mirrored.

button Mirroring left and right splits the paint buffer down the 
center vertically. Any paint strokes made on either the left 
or right side of the divider are mirrored on the opposite 
side.

This applies to paint strokes only.

button Mirroring top and bottom splits the paint buffer down the 
center horizontally. Any paint strokes made on either the 
top or bottom of the divider are mirrored on the opposite 
side.

This applies to paint strokes only.

button Mirroring four ways splits the paint buffer into quarters 
around the center of the canvas. Any paint strokes made in 
one of the quadrants are mirrored in the other three.

This applies to paint strokes only.
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Vector Painting Toolbar 
Vector Painting 
Toolbar

Vector Painting 
Toolbar Controls

Default Shaders 
Toolbar

What it looks like What it does

Displays the option to toggle the vector inspector on or off and to 
create default vector shaders. When the tool is active, the vector 
inspector markers are shown, regardless of whether you toggle the 
option on or off.

Control Type What it does Notes

button Quickly enables the vector inspector so that the directional 
markers are visible. To quickly turn off the directional mark-
ers, click the button again.

Can also be done by using the Shift+I 
shortcut.

button Sets up two default vector shaders with default channels and 
layers for painting flow or normal maps. Also changes the 
tool to Vector Paint and switches the Painting Mode to Paint 
Flow Vectors.

Can also be done by navigating to 
Python | Examples > Setup Vector 
Brush

What it looks like What it does

Displays one of the four default shader in the Shaders palette: Current 
Channel, Current Layer and Below, Current Layer, and Current Paint 
Target. Selecting a custom created shader in the Shaders palette won’t 
highlight any of the shaders in the toolbar, but selecting a default 
shader from either the palette or the toolbar activates the shader and 
highlights the icon in the toolbar.
Mari 2.0v1The Foundry



TOOLBARS 76
Default Shaders Toolbar 
Default Shaders 
Toolbar Controls

Control Type What it does Notes

button Selects the default Current Channel shader from the Shaders 
palette and displays only the paint in the current channel.

button Selects the default Current Layer and Below shader from the 
Shaders palette and displays only the paint in the current 
layer stack.

button Selects the default Current Layer shader from the Shaders 
palette and displays only the paint in the current layer.

button Selects the default Current Paint Target shader from the 
Shaders palette and displays only the paint of the currently 
selected target.
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Status Bar Icons

What it looks like What it does

Displays status icons that indicate which features are active, whether an error has 
been encountered, and information about the current project. This includes progress 
bars on running processes.

Icon What it does Notes

Displays the UDIM number of the patch you have selected. If nothing is 
selected, then there is nothing listed after Udim.

Notifies you that there is paint to bake. Click on the icon to bake.

Notifies you that background jobs are currently running. Clicking on this icon displays a dialog 
for the progress bar.

Notifies you that the project has changed and allows you to save. Click on the icon to save changes.

Notifies you that your painting is hidden.

Notifies you that color management is active.

Notifies you that you are currently projecting on the front of objects. Clicking on this icon toggles between 
projecting through objects and project-

ing on the front of objects. The  icon 
takes the default icon’s place when 
switching to project through.

Notifies you that you currently have edge masking enabled. Clicking on this icon disables edge 
masking.

Notifies you that you currently have channel masking enabled. Clicking on this icon disables channel 
masking.

Notifies you that you currently have ambient occlusion masking enabled. Clicking on this icon disables ambient 
occlusion masking.

Notifies you that you currently have depth masking enabled. Clicking on this icon disables depth 
masking.
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Notifies you that you currently have backface masking enabled. Clicking on this icon disables backface 
masking.

Notifies you that you currently have fractal noise masking enabled. Clicking on this icon disables fractal 
noise masking.

Notifies you that you currently have the global mask preview enabled. Clicking on this icon disables the global 
mask preview.

Warns you that a low memory status has been detected. Low memory 
affects Mari’s performance and may make it unstable.

Try freeing memory or closing and 
restarting Mari to clear this issue.

Notifies you that there are warning messages present. Clicking on this icon displays these 
warnings.

Warns you that the cache disk is critically full. If you don’t free disk space, data loss 
may occur. A simple way to free disk 
space is to close the project and re-
open it. Mari saves your session history, 
but closing your project clears this used 
disk space up for use.

Warns you that there is no disk space left for the operation you are try-
ing to run.

Warns you that channels are a higher bit-depth than what the virtual 
texture is configured for.

Notifies you that Mari is currently loading data from the disk.

Notifies you that Mari is currently loading data from the RAM to GPU 
memory.

Notifies you that Mari is listening for commands on [COMPUTER NAME] 
port [PORT NUMBER].

Hovering over this icon displays the 
computer name and port number on 
which Mari is listening for commands.

Notifies you that there was an error while Mari was listening for com-
mands.

Notifies you that Nuke is connected to send commands to Mari on [COM-
PUTER NAME] port [PORT NUMBER].

Hovering over this icon displays the 
computer name and port number from 
which Nuke is connected.

Icon What it does Notes
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What It Does

The Channels palette displays:

• a list of channels in the project,

• buttons to add, duplicate, convert, or remove channels,

• options for creating quick channels, and

• channel attribute information.

Channels provide a foundation that layers are built on. These channels can be diffuse, bump, or spec 
channels, to name only a few. Channels are assigned to lighting shaders, and sliders in that palette give 
you fine control over aspects of each channel. 

Below are the controls you can expect to find on the Channels palette.

Channels Palette 
Fields

Control Type What it does Dialog Notes

button Adds a new channel to the channels list. Add Channel 
Dialog Box

button Duplicate the selected channel.

button Converts the channel into either 8bit (Byte), 16bit 
(Half), 32bit (Float). 

Convert Type 
Dialog Box

button Removes the channel.

Quick Channel | swatch Creates a channel filled in black. The created channel is 
named Quick Channel. If 
there are multiple Quick 
Channels, then the name is 
followed with a number.
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Channels Palette Fields 
Quick Channel | swatch Creates a channel filled in white. The created channel is 
named Quick Channel. If 
there are multiple Quick 
Channels, then the name is 
followed with a number.

Quick Channel | swatch Creates a channel filled in mid-grey. The created channel is 
named Quick Channel. If 
there are multiple Quick 
Channels, then the name is 
followed with a number.

Quick Channel | swatch Creates a channel filled in transparent. The created channel is 
named Quick Channel. If 
there are multiple Quick 
Channels, then the name is 
followed with a number.

Quick Channel | dropdown Sets the channel size used when creating a Quick 
Channel, from the options:

• 256x256

• 512x512

• 1024x1024

• 2048x2048

• 4096x4096

• 8192x8192

• 16384x16384

• 32768x32768

Ensure this is set to the 
size you want before cre-
ating Quick Channels.

Quick Channel | dropdown Sets the channel depth used when creating a Quick 
Channel, from the options:

• 8bit (Byte)

• 32bit (Float)

• 16bit (Half)

Ensure this is set to the 
depth you want before 
creating Quick Channels.

button Opens an individual palette that displays the layers 
of that channel only.

button Indicates an unlocked state. Clicking the icon 
changes the channel state to locked.

‘

button Indicates a locked state. Clicking the icon changes 
the channel state to unlocked.

button Adds user attributes for the channel.

<channel name> > 
General | File Space

information Sets whether the channel is Normal, Vector, Vector 
(flipped Y)
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Channels Palette Fields 
<channel name> > 
General | Color 
Space

information Sets whether the channel is Color or Scalar.

<channel name> > 
General | Size

information Lists the size of the patches in the channel.

<channel name> > 
General | Depth

information Lists the color depth of the channel.
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What It Does The Layers palette lets you view, create and alter layers. You can also add 
the following to individual layers, or layer groups:

• masks

• adjustments

• procedurals

Layers Palette 
Fields

Control Type What it does Notes

dropdown, 
switch

Filter bar function that gives the choices: Name, 
Type, Attribute, and Color Tag. Depending on 
which filter option you choose, the filter bar shows 
one of the following:

•  - filter for the type of layers by 

clicking on the associated icons.

•  - filter for the 
attributes of layers by clicking on the associated 
icons.

•  - filter for the color 
tags of the selected color icon.

Both Type and Attribute provide 
icons that allow you to set the 
parameters for your filter.

Quickly clear the entry box by press-

ing the  icon.

dropdown Click to select from the blend mode options avail-
able for individual layers. To adjust the blend 
amount, enter the value into the entry box, or 
adjust the slider located to the right of the blend 
mode menu.

•  - adjusts 

the blend mode amount.

This list does not include the 
advanced blend mode options.

button Opens the Advanced Blending menu, which gives 
options for blend modes and components, blend 
amount, and whether the blend applies to only the 
selected layer.

 

icon Click to toggle the selected layers’ visibility on the 
canvas.
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Layers Palette Fields 
 

icon Denotes whether the layer is a paint layer and, 
when lit, whether it is selected as the current paint 
target.

icon Denotes whether the layer is a mask layer and, 
when lit, whether the mask is selected as the cur-
rent paint target.

You can Shift+click on the mask to 
disable it, or right-click on the layer 
and select Layer Mask > Disable 

Mask. The disabled mask icon  

indicates the disabled state.

To enable it, either Shift+click on the 
mask again or select Layer Mask > 
Enable Mask from the right-click 
menu.

icon Denotes whether the layer has a mask group and, 
when lit, whether the mask group is selected as 
the current layer.

Clicking on the icon brings up the 
mask group palette.

icon Denotes whether the layer is an adjustment layer, 
or has an adjustment as part of the layer and, 
when lit, whether the adjustment is selected as the 
current layer.

To distinguish whether the layer is an 
adjustment layer or simply has an 
adjustment on it, look for the posi-
tion of the icon. If the icon is in the 

left-most column, where the  

icon is normally located on paint lay-
ers, then the layer is an adjustment 
layer.

icon Denotes whether the layer is a procedural layer 
and, when lit, whether the procedural is selected 
as the current layer.

icon Denotes whether the layer is the parent layer of a 
group.

 

icon Locks or unlocks the selected layer. If the layer is 
the parent of a group of layers, all the layers in the 
group are also locked or unlocked. Clicking the 
padlock icon when a layer is cached also unlocks it.

button Adds a new paint layer to the layer stack.

button Adds a mask to the selected layer or, if none is 
selected, the top layer in the layer stack.

If a mask has already been added to 
a layer, you cannot add a second 
mask using this method. You must 
create a mask group using the right-
click menu.

button Adds an adjustment layer to the layer stack. Choose adjustments from the drop-
down menu when you click the icon.

Control Type What it does Notes
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Layers Palette Fields 
button Adds a procedural layer to the layer stack. Choose procedurals from the drop-
down menu when you click the icon.

button Adds a parent layer for a group to the layer stack. 
Additional layers can be added after the parent 
layer is created.

button Duplicates the selected layer in the layer stack. The duplicate has "copy" included in 
the name so that it can be differenti-
ated from the original.

button Removes the selected layer from the layer stack.

button Assigns a color to the selected layers. To clear an 
already assigned color, click the icon and select 
the gray color in the center of the palette. This 
effectively removes the color and returns it to the 
default color state.

Adjustment/Brightness

Brightness entry box, 
slider

Controls the brightness of the paint on the model.

Adjustment/Brightness Lookup

Map curve editor Adjusts the brightness to a specific lookup value 
using a curve map.

Adjustment/Clamp

Min entry box, 
slider

Clamps the minimum RGB value for the selected 
checkboxes below.

Max entry box, 
slider

Clamps the maximum RGB value for the selected 
checkboxes below.

Components | R checkbox If enabled, specifies that the red channel should be 
affected by the Min and Max sliders.

Components | G checkbox If enabled, specifies that the green channel should 
be affected by the Min and Max sliders.

Components | B checkbox If enabled, specifies that the blue channel should 
be affected by the Min and Max sliders.

Components | A checkbox If enabled, specifies that the alpha channel should 
be affected by the Min and Max sliders.

Adjustment/Color Balance

Preserve Luminosity checkbox Ensures that the luminosity value is maintained 
when other values are adjusted.

Control Type What it does Notes
Mari 2.0v1The Foundry



LAYERS PALETTE 85
Layers Palette Fields 
Highlights | Cyan/Red entry box, 
slider

Adjusts the scale of the Red color component. 
Dragging the slider to the left pulls the scale 
towards cyan, whereas dragging the slider to the 
right pulls it towards red. The modification applies 
to the texture’s highlights.

Highlights | Magenta/
Green

entry box, 
slider

Adjusts the Green color component. Dragging the 
slider to the left pulls the scale towards magenta, 
whereas dragging the slider to the right pulls it 
towards green. The modification applies to the 
texture’s highlights.

Highlights | Yellow/Blue entry box, 
slider

Adjusts the Blue color component. Dragging the 
slider to the left pulls the scale towards yellow, 
whereas dragging the slider to the right pulls it 
towards blue. The modification applies to the tex-
ture’s highlights.

Shadows | Cyan/Red entry box, 
slider

Adjusts the scale of the Red color component. 
Dragging the slider to the left pulls the scale 
towards cyan, whereas dragging the slider to the 
right pulls it towards red. The modification applies 
to the texture’s shadows.

Shadows | Magenta/
Green

entry box, 
slider

Adjusts the Green color component. Dragging the 
slider to the left pulls the scale towards magenta, 
whereas dragging the slider to the right pulls it 
towards green. The modification applies to the 
texture’s shadows.

Shadows | Yellow/Blue entry box, 
slider

Adjusts the Blue color component. Dragging the 
slider to the left pulls the scale towards yellow, 
whereas dragging the slider to the right pulls it 
towards blue. The modification applies to the tex-
ture’s shadows.

Midtones | Cyan/Red entry box, 
slider

Adjusts the scale of the Red color component. 
Dragging the slider to the left pulls the scale 
towards cyan, whereas dragging the slider to the 
right pulls it towards red. The modification applies 
to the texture’s midtones

Midtones | Magenta/
Green

entry box, 
slider

Adjusts the Green color component. Dragging the 
slider to the left pulls the scale towards magenta, 
whereas dragging the slider to the right pulls it 
towards green. The modification applies to the 
texture’s midtones

Midtones | Yellow/Blue entry box, 
slider

Adjusts the Blue color component. Dragging the 
slider to the left pulls the scale towards yellow, 
whereas dragging the slider to the right pulls it 
towards blue. The modification applies to the tex-
ture’s midtones.

Control Type What it does Notes
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Layers Palette Fields 
Adjustment/Color Lookup

Red curve editor Adjusts the value of the red channel for the overall 
layer stack, using the curve editor.

Green curve editor Adjusts the value of the green channel for the 
overall layer stack, using the curve editor.

Blue curve editor Adjusts the value of the blue channel for the over-
all layer stack, using the curve editor.

Adjustment/Color Switch

Red checkbox Turns the red channel on or off. Disabling the red 
channel removes it from the painting.

Green checkbox Turns the green channel on or off. Disabling the 
green channel removes it from the painting.

Blue checkbox Turns the blue channel on or off. Disabling the blue 
channel removes it from the painting.

Alpha checkbox Turns the alpha channel on or off. Disabling the 
alpha channel removes it from the painting.

Adjustment/Contrast

Contrast entry box, 
slider

Adjusts the contrast for the layer stack.

Contrast Pivot entry box, 
slider

Sets the point around which Contrast is adjusted.

Adjustment/Copy Channel

Channel dropdown Copies the value from one RGB color channel to 
the other two. The result is a grayscale image with 
the intensity values from the selected channel.

Adjustment/Gamma

Gamma entry box, 
slider

Adjusts the gamma levels in the layer stack.

Invert entry box, 
slider

Reverses the gamma conversion. That is, a higher 
setting for Gamma results in a more washed-out 
looking image.

Adjustment/Grade

Blackpoint entry box, 
slider

Sets the blackpoint of the RGB values. Blackpoint is the color value at which 
the input is considered to be 100% 
black.

Whitepoint entry box, 
slider

Sets the whitepoint of the RGB values. Whitepoint is the color value at 
which the input is considered to be 
100% white.
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Lift entry box, 
slider

Lifts the blackpoint, while keeping the whitepoint 
the same.

Gain entry box, 
slider

Adjusts the whitepoint, while keeping the black-
point the same

Multiply entry box, 
slider

Multiplies the value to lighten the texture while 
preserving the blackpoint.

Offset entry box, 
slider

Specifies a fixed value to add in order to lighten 
the texture.

Adding negative values essentially 
darkens the texture.

Gamma entry box, 
slider

Adjusts the midtones, while keeping the whitepoint 
and blackpoint the same.

Adjustment/HSL

Hue Shift entry box, 
slider

Adjusts the hue, as tied to the HSL, for the layer 
stack.

Saturation Scale entry box, 
slider

Adjusts the saturation level, as tied to the HSL, for 
the layer stack.

Lightness Scale entry box, 
slider

Adjusts the lightness level, as tied to the HSL, for 
the layer stack.

Adjustment/HSV

Hue Shift entry box, 
slider

Adjusts the hue level, as tied to the HSV, for the 
layer stack.

Saturation Scale entry box, 
slider

Adjusts the saturation level, as tied to the HSV, for 
the layer stack.

Value Scale entry box, 
slider

Adjusts the value level, as tied to the HSV, for the 
layer stack.

Adjustment/Height As Normal

Bump Weight entry box, 
slider

Adjusts the sensitivity of the bump weight when 
calculating height as a normal value.

Adjustment/Hue Shift 

Hue entry box, 
slider

Changes the RGB hue value of the paint in the 
layer stack.

Adjustment/Invert

Red checkbox Inverts the contents of the red color component 
when checked. Uncheck the parameter to leave the 
component unchanged. If there is a significant 
amount of red paint in your layer stack the inverse 
is a significant absence of red.

It is uncommon that only one compo-
nent would be selected, however if 
the need arises, you can choose to 
invert only one, or a subset, of the 
four components.
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Green checkbox Inverts the contents of the green color component 
when checked. Uncheck the parameter to leave the 
component unchanged. If there is a significant 
amount of green paint in your layer stack the 
inverse is a significant absence of green.

It is uncommon that only one compo-
nent would be selected, however if 
the need arises, you can choose to 
invert only one, or a subset, of the 
four components.

Blue checkbox Inverts the contents of the blue color component 
when checked. Uncheck the parameter to leave the 
component unchanged. If there is a significant 
amount of blue paint in your layer stack the 
inverse is a significant absence of blue.

It is uncommon that only one compo-
nent would be selected, however if 
the need arises, you can choose to 
invert only one, or a subset, of the 
four components.

Alpha checkbox Inverts the contents of the alpha color component 
when checked. Uncheck the parameter to leave the 
component unchanged.

It is uncommon that only one compo-
nent would be selected, however if 
the need arises, you can choose to 
invert only one, or a subset, of the 
four components.

Adjustment/Levels

Red checkbox Determines whether to apply the adjustment to the 
red component.

Green checkbox Determines whether to apply the adjustment to the 
green component.

Blue checkbox Determines whether to apply the adjustment to the 
blue component.

Output Level | WhiteOut entry box, 
slider

Adjusts the white level of the output in the paint 
for the selected color components.

Output Level | BlackOut entry box, 
slider

Adjusts the black level of the output in the paint 
for the selected color component.

Input Level | White entry box, 
slider

Adjusts the white level of the input for the 
selected color component.

Input Level | Mid entry box, 
slider

Adjusts the midtone level of the input for the 
selected color components.

Input Level | Black entry box, 
slider

Adjusts the black level of the input for the selected 
color component.

Adjustment/Luminosity

Control Type What it does Notes
Mari 2.0v1The Foundry



LAYERS PALETTE 89
Layers Palette Fields 
Adjustment/Premultiply Alpha

Unpremultiply checkbox Either pre- or post-multiplies the alpha in the 
selected image. If you are painting using an image 
without pre-multiplied alpha onto one with it, use 
this filter to perform the pre-multiplication, so the 
images match and you avoid lines around the out-
side of the patch. Post-multiply works the same, 
but in reverse: it removes pre-multiplication to 
match images that do not have pre-multiplied 
alpha.

Adjustment/Saturation

Saturation entry box, 
slider

Adjusts the color saturation of the paint in the 
layer stack.

Adjustment/Scale

R entry box, 
slider

Adjusts the scale of the Red color component. 
Dragging the slider to the left pulls the scale 
towards cyan, whereas dragging the slider to the 
right pulls it towards red.

G entry box, 
slider

Adjusts the Green color component. Dragging the 
slider to the left pulls the scale towards magenta, 
whereas dragging the slider to the right pulls it 
towards green.

B entry box, 
slider

Adjusts the Blue color component. Dragging the 
slider to the left pulls the scale towards yellow, 
whereas dragging the slider to the right pulls it 
towards blue.

A entry box, 
slider

Adjusts the Alpha component.

Adjustment/Set Value

Channel dropdown The options available in the dropdown menu are 
Red, Green, Blue, Alpha.

Value entry box, 
slider

Adjusting the slider modifies the value of the com-
ponent chosen in the dropdown menu above.

Adjustment/Shuffle

R dropdown Select a color component from the options r, g, b, 
and a in the dropdown menu to replace the Red 
component with another color. Setting r in the 
dropdown menu keeps the red color in the Red 
component.
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G dropdown Select a color component from the options r, g, b, 
and a in the dropdown menu to replace the Green 
component with another color. Setting g in the 
dropdown menu keeps the green color in the Green 
component.

B dropdown Select a color component from the options r, g, b, 
and a in the dropdown menu to replace the Blue 
component with another color. Setting b in the 
dropdown menu keeps the blue color in the Blue 
component.

A dropdown Select a color component from the options r, g, b, 
and a in the dropdown menu to replace the Alpha 
component with another color. Setting a in the 
dropdown menu keeps the alpha color in the Alpha 
component.

Adjustment/Tangent To Screen

Suppress Blue checkbox Suppresses the blue value from the color-encoded 
vectors in screen space.

Adjustment/Tangent To World

Suppress Blue checkbox Suppresses the blue value from the color-encoded 
vectors in world space.

Adjustment/sRGB2Linear

Invert checkbox Applies an sRGB to linear colorspace conversion. 
Checking Invert applies a linear to sRGB colorspace 
conversion.

Procedural/Basic/Color

Color swatch Applies the specified color from the color swatch 
to the entire model.

Procedural/Basic/Constant

Constant entry box, 
slider

Generates a constant level of grayscale color to be 
applied to the model.

Procedural/Basic/Vector

X entry box, 
slider

Adjusts the values of the X axis, which correspond 
to the Red color component, to modify the color-
encoded vectors.

Y entry box, 
slider

Adjusts the values of the Y axis, which correspond 
to the Green color component, to modify the color-
encoded vectors.

Z entry box, 
slider

Adjusts the values of the Z axis, which correspond 
to the Blue color component, to modify the color-
encoded vectors.
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W entry box, 
slider

Adjusts the values of the W axis, which correspond 
to the Alpha component, to modify the color-
encoded vectors.

Procedural/ Environment/Cubemap

Cubic Image entry box, 
file browser

The environment image you want to be reflected. This procedural cannot be cached or 
baked and is for display purposes 
only.

Falloff Start entry box, 
slider

Specifies where the cubic image starts.

Falloff End entry box, 
slider

Specifies where the cubic image ends.

Procedural/ Environment/Cubemap Projector

Cubic Image entry box, 
file browser

Select or input the filepath to the .dds cubic image 
to project as a texture.

This procedural cannot be cached or 
baked and is for display purposes 
only.

Cull Backfaces checkbox When the checkbox is ticked, this setting ensures 
that projection does not affect areas facing away 
from the camera when factoring edge falloff.

Offset | X entry box, 
slider

The offset of the projected image along the X axis. 
This affects the position of where the camera sits 
in the scene.

Offset | Y entry box, 
slider

The offset of the projected image along the Y axis. 
This affects the position of where the camera sits 
in the scene.

Offset | Z entry box, 
slider

The offset of the projected image along the Z axis. 
This affects the position of where the camera sits 
in the scene.

Rotation | X entry box, 
slider

The rotation of the projected image along the X 
axis.

This rotates the camera for the 
entire scene, not just one part.

Rotation | Y entry box, 
slider

The rotation of the projected image along the Y 
axis.

This rotates the camera for the 
entire scene, not just one part.

Rotation | Z entry box, 
slider

The rotation of the projected image along the Z 
axis.

This rotates the camera for the 
entire scene, not just one part.

Edge Falloff | Start entry box, 
slider

Modifies how far away the projection falloff starts 
on the model.

Edge Falloff | End entry box, 
slider

Modifies how far away the projection falloff ends 
on the model.

Edge Falloff | Curve curve editor Modifies the otherwise linear shape of the edge 
falloff to your desired shape.
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Distance Falloff | Start entry box Modifies the falloff start distance. From 0-100; 
100 represents straight-on projection.

Distance Falloff | End entry box Modifies the falloff end distance. From 0-100; 
100 represents straight-on projection.

Distance Falloff | Curve entry box, 
slider

Modifies the otherwise linear shape of the dis-
tance falloff to your desired shape.

Procedural/Environment/Sphere Map

SphereMap file browser The environment image you want to be reflected. This procedural cannot be cached or 
baked and is for display purposes 
only.

FalloffStart entry box, 
slider

Specifies where the spherical image starts.

FalloffEnd entry box, 
file browser

Specifies where the spherical image ends.

Procedural/Environment/Sphere Map Projector

Spherical Image filebrowser Uses a spherical image of any file type as a texture 
to project onto the model. Select the filepath to 
the spherical image to project as a texture.

This procedural cannot be cached or 
baked and is for display purposes 
only.

Cull Backfaces checkbox When the checkbox is ticked, this setting ensures 
that projection does not affect areas facing away 
from the camera when factoring edge falloff.

Offset | X entry box The offset of the projected image along the X axis. 
This affects the position of where the camera sits 
in the scene.

Offset | Y entry box The offset of the projected image along the Y axis. 
This affects the position of where the camera sits 
in the scene.

Offset | Z entry box The offset of the projected image along the Z axis. 
This affects the position of where the camera sits 
in the scene.

Rotation | X entry box, 
slider

The rotation of the projected image along the X 
axis.

This rotates the camera for the 
entire scene, not just one part.

Rotation | Y entry box, 
slider

The rotation of the projected image along the Y 
axis.

This rotates the camera for the 
entire scene, not just one part.

Rotation | Z entry box, 
slider

The rotation of the projected image along the Z 
axis.

This rotates the camera for the 
entire scene, not just one part.

Edge Falloff | Start entry box, 
slider

Modifies how far away the projection falloff starts 
on the model.

Edge Falloff | End entry box, 
slider

Modifies how far away the projection falloff ends 
on the model.
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Edge Falloff | Curve curve editor Modifies the otherwise linear shape of the edge 
falloff to your desired shape.

Distance Falloff | Start entry box Modifies the falloff start distance. From 0-100; 
100 represents straight-on projection.

Distance Falloff | End entry box Modifies the falloff end distance. From 0-100; 
100 represents straight-on projection.

Distance Falloff | Curve curve editor Modifies the otherwise linear shape of the dis-
tance falloff to your desired shape.

Procedural/Environment/Triplanar Projection

World Scale entry box Gives overall scale control for the image projec-
tion.

Top | Top Image file browser Specifies the location of the image you want to 
project onto the top of your model.

Top | Top Repeat entry box, 
slider

Specifies the frequency at which the image is 
repeated across the top of your model.

Top | Top Angle entry box, 
slider

Specifies the rotation angle of the image on the 
top of your model.

Top | Top U Offset entry box, 
slider

Specifies how much the image on the top of your 
model is offset by on the U axis.

Top | Top V Offset entry box, 
slider

Specifies how much the image on the top of your 
model is offset by on the V axis.

Top | Top U Scale entry box, 
slider

Specifies how much the image on the top of your 
model is stretched or contracted on the U axis.

Top | Top V Scale entry box, 
slider

Specifies how much the image on the top of your 
model is stretched or contracted on the V axis.

Top | Top Falloff Start entry box, 
slider

Controls where the image projection starts on the 
top of the model.

Top | Top Falloff End entry box, 
slider

Controls where the image projection ends on the 
top of the model.

Top | Top Falloff curve editor Controls the falloff of the image projection 
between the start and end values on the top of the 
model.

Front | Front Image file browser Specifies the location of the image you want to 
project onto the front of your model.

Front | Front Repeat entry box, 
slider

Specifies the frequency at which the image is 
repeated across the front of your model.

Front | Front Angle entry box, 
slider

Specifies the rotation angle of the image on the 
front of your model.
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Front | Front U Offset entry box, 
slider

Specifies how much the image on the front of your 
model is offset by on the U axis.

Front | Front V Offset entry box, 
slider

Specifies how much the image on the front of your 
model is offset by on the V axis.

Front | Front U Scale entry box, 
slider

Specifies how much the image on the front of your 
model is stretched or contracted on the U axis.

Front | Front V Scale entry box, 
slider

Specifies how much the image on the front of your 
model is stretched or contracted on the V axis.

Front | Front Falloff 
Start

entry box, 
slider

Controls where the image projection starts on the 
front of the model.

Front | Front FalloffEnd entry box, 
slider

Controls where the image projection ends on the 
front of the model.

Front | Front Falloff curve editor Controls the falloff of the image projection 
between the start and end values on the front of 
the model.

Right | Right Image file browser Specifies the location of the image you want to 
project onto the side of your model.

Right | Right Repeat entry box, 
slider

Specifies the frequency at which the image is 
repeated across the side of your model.

Right | Right Angle entry box, 
slider

Specifies the rotation angle of the image on the 
side of your model.

Right | Right U Offset entry box, 
slider

Specifies how much the image on the side of your 
model is offset by on the U axis.

Right | Right V Offset entry box, 
slider

Specifies how much the image on the side of your 
model is offset by on the V axis.

Right | Right U Scale entry box, 
slider

Specifies how much the image on the side of your 
model is stretched or contracted on the U axis.

Right | Right V Scale entry box, 
slider

Specifies how much the image on the side of your 
model is stretched or contracted on the V axis.

Right | Right Falloff 
Start

entry box, 
slider

Controls where the image projection starts on the 
side of the model.

Right | Right Falloff End entry box, 
slider

Controls where the image projection ends on the 
side of the model.

Right | Right Falloff curve editor Controls the falloff of the image projection 
between the start and end values on the side of 
the model.

Procedural/Geometry/Ambient Occlusion

Procedural/Geometry/Position

Procedural/Geometry/Surface Normal
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Procedural/Geometry/UDIM Mask

UDIM entry box Enter the UDIM number of the UDIM you want to 
unmask.

Procedural/Geometry/UV

Procedural/Procedural/Fractal/ Cloud

Size entry box, 
slider

Adjusts the size of the cloud pattern.

Roughness entry box, 
slider

Adjusts the roughness of the cloud pattern. Drag-
ging the slider to lower values smooths out the 
transition from color A to color B.

Offsets | X Offset entry box, 
slider

Moves the pattern across the model on the x axis.

Offsets | Y Offset entry box, 
slider

Moves the pattern across the model on the y axis.

Offsets | Z Offset entry box, 
slider

Moves the pattern across the model on the z axis.

Color | Color A swatch Sets the color to be used for the pattern’s A input.

Color | Color B swatch Sets the color to be used for the pattern’s B input.

Procedural/Procedural/Fractal/Turbulence

Size entry box, 
slider

Adjusts the size of the turbulence pattern.

Roughness entry box, 
slider

Adjusts the roughness of the turbulence pattern. 
Dragging the slider to lower values smooths out 
the transition from color A to color B.

Color | Color A swatch Sets the color to be used for the pattern’s A input.

Color | Color B swatch Sets the color to be used for the pattern’s B input.

Procedural/Procedural/Misc/Flow

Animation | Animated checkbox Enables or disables the animation.

Animation | Time Offset entry box, 
slider

Adjusts the flow over time to view the effect of 
vector paint.

Animation | Speed entry box, 
slider

Adjusts the sensitivity of Time Offset to affect the 
speed of flow.

Image | Tile Image file browser Selects the image to use on the model for flow.

Image | Repeat entry box, 
slider

Sets the repetition value of the tiled image.
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Procedural/Procedural/Misc/Oil

Size entry box, 
slider

Adjusts the size of the oil pattern.

Organicness entry box, 
slider

Sets the overall organic quality of the oil pattern.

Roughness entry box, 
slider

Adjusts the roughness of the oil pattern. Dragging 
the slider to lower values smooths out the transi-
tion from color A to color B.

Color | Color A swatch Sets the color to be used for the pattern’s A input.

Color | Color B swatch Sets the color to be used for the pattern’s B input.

Procedural/Procedural/Noise/Cellular

Size entry box, 
slider

Adjusts the size of the cellular pattern.

Type dropdown Sets how color A and color B are used in the pat-
tern.

Distance Method dropdown Changes the shape of the cells to affect the dis-
tance the cells are from each other.

Color | Color A swatch Sets the color to be used to the pattern’s color A 
input.

Color | Color B swatch Sets the color to be used for the pattern’s color B 
input.

Procedural/Procedural/Noise/Perlin

Size entry box, 
slider

Adjusts the size of the noise pattern.

Color | Color A swatch Sets the color to be used for the pattern’s color A 
input.

Color | Color B swatch Sets the color to be used for the pattern’s color B 
input.

Procedural/Procedural/Noise/Squiggle

Size entry box, 
slider

Adjusts the size of the squiggle pattern.

Color | Color A swatch Sets the color to be used for the pattern’s color A 
input.

Color | Color B swatch Sets the color to be used for the pattern’s color B 
input.

Procedural/Procedural/ Pattern/Cube

Repeat entry box, 
slider

Specifies the repetition frequency of the cube pat-
tern.
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Gap entry box, 
slider

Sets the spacing between the cubes in the pattern.

Fall Off entry box, 
slider

Adjusts the falloff amount between the cubes.

Roundness entry box, 
slider

Adjusts how much the cubes are rounded off.

Color | Color A swatch Sets the color to be used for the pattern’s color A 
input.

Color | Color B swatch Sets the color to be used for the pattern’s color B 
input.

Procedural/Procedural/Pattern/Object Space Linear Gradient

Start entry box, 
slider

Sets the start point on the object for Color B of 
the gradient.

End entry box, 
slider

Sets the end point of Color B, where Color A 
begins, on the object of the gradient.

Map curve editor Set the color A and color B transitions for the gra-
dient using points on a curve.

Rotation | X entry box, 
slider

Adjusts how the gradient appears on the model by 
rotating the gradient on the X axis.

Rotation | Y entry box, 
slider

Adjusts how the gradient appears on the model by 
rotating the gradient on the Y axis.

Rotation | Z entry box, 
slider

Adjusts how the gradient appears on the model by 
rotating the gradient on the Z axis.

Color | Color A swatch Sets the color to be used for the gradient’s A 
input.

Color | Color B swatch Sets the color to be used for the gradient’s B 
input.

Procedural/Procedural/Pattern/Sphere

Size entry box, 
slider

Adjusts the size of the spherical pattern.

Falloff curve editor Adjusts the falloff amount between the spheres.

Color | Color A swatch Sets the color to be used for the pattern’s color A 
input.

Color | Color B swatch Sets the color to be used for the pattern’s color B 
input.

Procedural/Procedural/Pattern/Tiled

Tile Image file browser The image you want to have tiled across the model.
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Rotation Angle 
(Degrees)

entry box, 
slider

Changes the angle of rotation for the tiled image.

Offset | U Offset entry box, 
slider

Specifies how much the image is offset by on the U 
axis.

Offset | V Offset entry box, 
slider

Specifies how much the image is offset by on the V 
axis.

Repeat | U Repeat entry box, 
slider

Specifies how much the image is repeated on the U 
axis.

Repeat | V Repeat entry box, 
slider

Specifies how much the image is repeated on the V 
axis.

Mirror | Mirror U entry box, 
slider

Sets whether the tiled image is mirrored on the U 
axis.

Mirror | Mirror V entry box, 
slider

Sets whether the tiled image is mirrored on the V 
axis.

Procedural/Procedural/Pattern/UV Grid

Color swatch Sets the color to be used for the grid lines.

Repeat entry box, 
slider

Specifies the repeat rate for the grid on the 
model’s surface.

Thickness entry box, 
slider

Sets the thickness of the grid lines.

Procedural/Procedural/Pattern/UV Linear Gradient

Start entry box, 
slider

Sets the start point on the UV patches for Color B 
of the gradient.

End entry box, 
slider

Sets the end point of Color B, where Color A 
begins, on the UV patches of the gradient.

Map curve editor Set the color A and color B transitions for the gra-
dient in UV space using points on a curve.

Angle entry box, 
slider

Specifies the angle of the linear gradient on the UV 
patches.

Repeat entry box, 
slider

Sets how much the linear gradient is repeated 
across the UV patches.

Color | Color A swatch Sets the color to be used for the gradient’s A 
input.

Color | Color B swatch Sets the color to be used for the gradient’s B 
input.

Procedural/Procedural/Plant/Wood

Size entry box, 
slider

Adjusts the size of the wood pattern across the 
entire model.
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Bands entry box, 
slider

Adjusts the size of the individual bands in the 
wood pattern.

Noise | Size entry box, 
slider

Adjusts the amount of the noise in the bands of 
the wood pattern.

Noise | Roughness entry box, 
slider

Adjusts the roughness of the wood pattern. Drag-
ging the slider to lower values makes the transi-
tion from color A to color B more distinct.

Stretch | X entry box, 
slider

Stretches the wood pattern across the model on 
the x axis.

Stretch | Y entry box, 
slider

Stretches the wood pattern across the model on 
the y axis.

Stretch | Z entry box, 
slider

Stretches the wood pattern across the model on 
the z axis.

Color | Color A swatch Sets the color to be used for the pattern’s color A 
input.

Color | Color B swatch Sets the color to be used for the pattern’s color B 
input.
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23  PATCHES PALETTE

What It Does

The Patches palette displays a selectable list of patches in the project, with icons and buttons to toggle 
whether they are visible, or whether they are locked. You can group patches into sets.

Patches palette 
fields

Control Type What it does
Opens this 
dialog box Notes

Sorted by dropdown Lets you specify whether to list patches by: 
UDIM, or a custom sort (by dragging patches up 
and down the list).

icon Click to toggle whether a patch is visible or not.

icon Click to toggle whether a patch is locked or not.

button Hide selected patches.

button Show selected patches.

button Select all patches.

button Lock selected patches.

button Unlock selected patches.

button Link selected patches.

This allows you to replicate changes made to one 
patch onto all linked patches quickly and easily.

button Unlink selected patches.



24  OBJECTS PALETTE

What It Does

The Objects palette displays the current objects in the project, and allows you to:

• Show and hide the objects.

• Add and remove objects from the project.

• Lock and unlock the objects.

• Select the object to edit.

• Add versions to existing objects.

Objects palette 
fields

Control Type What it does Notes

Sorted by dropdown Lets you specify whether to list the objects by their 
name or by version numbers.

icon Click to toggle whether an object is visible or not.

icon Click to toggle whether an object is locked or not.

button Add another object to the project.

button Removes the selected object from the project.

<object name> > Geometry | Version dropdown List of versions of the object, listed by the name of 
the source file. When you select a version from this 
list, Mari updates to show that version in the dis-
play.

<object name> > Info | Name text The name of the object file. You can edit this if 
required.

<object name> > State | Hidden checkbox Whether the object is hidden.

<object name> > State | Locked checkbox Whether the object is locked or editable.
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<object name> > User Attributes | Cre-
ated

info The creation date of the model file.

<object name> > User Attributes | Modi-
fied

info The last modification date of the model file.

<object name> > User Attributes | Owner info The user who made the last edit to the model file.

Control Type What it does Notes
Mari 2.0v1The Foundry
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What It Does

The Shaders palette displays the lighting shaders and allows you to toggle between the shader setup for 
the current channel, layer stack, layer, and paint target, as well as custom-made shaders.

Shaders Palette 
Fields

Control Type What it does Dialog Notes

Current Channel shader Default shader that displays only the paint 
in the selected channel.

This shader can also be 
found on the Default 
Shaders toolbar.

Current Layer and Below shader Default shader that displays only the paint 
in your selected sub-stack (such as a mask 
or adjustment stack) up to the selected 
layer. If you don’t have a sub-stack selected, 
it shows the parent stack up to the selected 
layer.

This shader can also be 
found on the Default 
Shaders toolbar.

Current Layer shader Default shader that displays only the paint-
able paint and masks in your selected layer.

This shader can also be 
found on the Default 
Shaders toolbar.

Current Paint Target shader Default shader that displays only the paint 
in your selected layer, including any mask or 
mask stack, adjustment, filter or groups 
associated with the layer.

This shader can also be 
found on the Default 
Shaders toolbar.

button Adds a new shader to the shader list in the 
palette from a dropdown menu list of 

• Phong

• Cook Torrance

• Beckman

• Blinn

• Flat

• Standard Lighting, and

• Choose Diffuse and Specular.

Create Shader 
Dialog Box 
when selecting 
Choose Dif-
fuse and Spec-
ular.

The Choose Diffuse and 
Specular option allows 
you to create a custom 
shader. Refer to the Cre-
ate Shader Dialog Box for 
more information.
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Shaders Palette Fields 
button Makes a copy of the selected shader.

button Removes the shader from the shader list in 
the palette.

Default shaders cannot be 
removed from the Shad-
ers palette.

button Selects the default Current Channel shader 
from the shader list and displays only the 
paint in the current channel.

button Selects the default Current Layer and Below 
shader from the shader list and displays only 
the paint in the current layer stack.

button Selects the default Current Layer shader 
from the shader list and displays only the 
paint in the current layer.

button Selects the default Current Paint Target 
shader from the shader list and displays only 
the paint of the currently selected target.

Lambertian/Phong

Diffuse Color dropdown The channel containing the RGB diffuse color 
effect of the shaded surface.

Specular Color dropdown The channel containing the RGB specular 
color effect of the shaded surface.

Specular Shininess dropdown The channel containing the high shine areas 
for highlights in the specular shaded surface.

Environment Color dropdown The channel containing the reflective sur-
face, using an image in a channel as the 
reflection, on the shaded surface.

Bump dropdown The channel containing the bump map to 
show as a preview for displacement.

Normal dropdown The channel used for input as a representa-
tion of the surface normals, added to the 
shaded surface.

You must choose either a 
Bump or Normal shader 
component in the same 
shader. If you attempt to 
use both, Normal over-
rides the Bump shader 
component.

Control Type What it does Dialog Notes
Mari 2.0v1The Foundry



SHADERS PALETTE 105
Shaders Palette Fields 
Ambient Occlusion dropdown The channel to use to calculate the ambient 
occlusion.

In order for this to be calculated correctly, 
you need to run the ambient occlusion 
(Objects menu, select Ambient Occlusion) on 
each object in your project. Otherwise, 
everything is shaded equally.

Emissive Color dropdown The channel containing the RGB color of the 
emissive (glow) qualities on the shaded sur-
face.

Vector dropdown The channel containing the vector field and 
resulting vector data from paint on the 
shaded surface.

This data is used by the 
vector inspector.

Displacement dropdown The channel containing the displacement 
map and dynamic tessellation to show a 
more advanced preview of displacement.

This component is dis-
abled for Ptex channels.

button Adds a new channel to be used for the 
shader component.

Add Channel 
Dialog Box

Diffuse entry box, 
shader

How much of the diffuse input appears on 
the shaded surface.

From 0 to 2; defaults to 1.

Specular entry box, 
slider

How much of the specular light appears on 
the shaded surface.

From 0 to 2; defaults to 1.

Specular Shininess entry box, 
slider

How much shininess the specularity appears 
to have on the shaded surface.

From 0 to 100; defaults to 
30.

Environment entry box, 
slider

How much of the environment appears on 
the shaded surface.

From 0 to 2; defaults to 1.

Bump Weight entry box, 
slider

How much weight the bump map has. Lower 
values are smaller bumps, higher values are 
larger and more obvious displacements.

From 0 to 10; defaults to 
0.100.

Ambient entry box, 
slider

How much ambient light appears on the 
shaded surface.

From 0 to 2; defaults to 
0.200.

Ambient Occlusion entry box, 
slider

How much ambient occlusion occurs on the 
shaded surface.

From 0 to 2; defaults to 1.

Emissive entry box, 
slider

How much glow the emissive channel 
appears to have. 

From 0 to 2; defaults to 1.

Displacement | Displace-
ment Bias

entry box, 
slider

How much the white or black values are 
pushed or pulled from the surface.

From 0 to 1; defaults to 
0.500.

Displacement | Displace-
ment Range

entry box What the range of displacement is. This set-
ting is multiplied by the Displacement Scale 
to give the displacement.

Control Type What it does Dialog Notes
Mari 2.0v1The Foundry
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Shaders Palette Fields 
Displacement | Displace-
ment Scale

entry box, 
slider

How much displacement is applied to the 
shaded surface. Lower values equal smaller 
displacement; higher values equal larger and 
more obvious displacement.

From 0 to 1; defaults to 
0.500.

Displacement | Max Tes-
sellation

entry box, 
slider

How many texels the surface is tessellated 
to.

From 1 to 64; defaults to 
10.

Lambertian/CookTorrance

Diffuse Color dropdown The channel containing the RGB diffuse color 
effect of the shaded surface.

Specular Color dropdown The channel containing the RGB specular 
color effect of the shaded surface.

Specular Roughness dropdown The channel containing the rough shaded 
surface for specularity.

Specular IOR dropdown The channel containing the specularity for 
the index of refraction. This can be adjusted 
to the IOR value of the desired material.

Environment Color dropdown The channel containing the reflective sur-
face, using an image in a channel as the 
reflection, on the shaded surface.

Bump dropdown The channel containing the bump map to 
show as a preview for displacement.

Normal dropdown The channel used for input as a representa-
tion of the surface normals, added to the 
shaded surface.

You must choose either a 
Bump or Normal shader 
component in the same 
shader. If you attempt to 
use both, Normal over-
rides the Bump shader 
component.

Ambient Occlusion entry box, 
slider

The channel to use to calculate the ambient 
occlusion.

In order for this to be calculated correctly, 
you need to run the ambient occlusion 
(Objects menu, select Ambient Occlusion) on 
each object in your project. Otherwise, 
everything is shaded equally.

Emissive Color entry box, 
slider

The channel containing the RGB color of the 
emissive (glow) qualities on the shaded sur-
face.

Vector dropdown The channel containing the vector field and 
resulting vector data from paint on the 
shaded surface.

This data is used by the 
vector inspector.

Control Type What it does Dialog Notes
Mari 2.0v1The Foundry
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Shaders Palette Fields 
Displacement dropdown The channel containing the displacement 
map and dynamic tessellation to show a 
more advanced preview of displacement.

This component is dis-
abled for Ptex channels.

button Adds a new channel for the shader compo-
nent.

Add Channel 
Dialog Box

Diffuse entry box, 
slider

How much of the diffuse input appears on 
the shaded surface.

From 0 to 2; defaults to 1.

Specular entry box, 
slider

How much of the specular light appears on 
the shaded surface.

From 0 to 2; defaults to 1.

Specular IOR entry box, 
slider

Adjust the IOR to the value of a specific 
material, or adjust the slider until you find 
the index of refraction that suits your needs.

From 0 to 5; defaults to 1.

Specular Roughness entry box, 
slider

How “rough” the surface is by default. 
Rougher surfaces have the highlight spread 
more across the surface. Lower values mean 
the surface is smoother (specular lights are 
more concentrated), higher values mean it is 
rougher (specular lights are spread out 
more).

From 0 to 1; defaults to 
0.700.

Environment entry box, 
slider

How much of the environment appears on 
the shaded surface.

From 0 to 2; defaults to 1.

Bump Weight entry box, 
slider

How much weight the bump map has. Lower 
values are smaller bumps, higher values are 
larger and more obvious displacements.

From 0 to 10; defaults to 
0.100.

Ambient entry box, 
slider

How much ambient light appears on the 
shaded surface.

From 0 to 2; defaults to 
0.200.

Ambient Occlusion entry box, 
slider

How much ambient occlusion occurs on the 
shaded surface.

From 0 to 2; defaults to 1.

Emissive entry box, 
slider

How much glow the emissive channel 
appears to have. 

From 0 to 2; defaults to 1.

Displacement | Displace-
ment Bias

entry box, 
slider

How much the white or black values are 
pushed or pulled from the surface.

From 0 to 1; defaults to 
0.500.

Displacement | Displace-
ment Range

entry box What the range of displacement is. This set-
ting is multiplied by the Displacement Scale 
to give the displacement.

Displacement | Displace-
ment Scale

entry box, 
slider

How much displacement is applied to the 
shaded surface. Lower values equal smaller 
displacement; higher values equal larger and 
more obvious displacement.

From 0 to 1; defaults to 
0.500.

Displacement | Max Tes-
sellation

entry box, 
slider

How many texels the surface is tessellated 
to.

From 1 to 64; defaults to 
10.

Control Type What it does Dialog Notes
Mari 2.0v1The Foundry
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Shaders Palette Fields 
Lambertian/Beckman

Diffuse Color dropdown The channel containing the RGB diffuse color 
effect of the shaded surface.

Specular Color dropdown The channel containing the RGB specular 
color effect of the shaded surface.

Specular Roughness dropdown The channel containing the rough shaded 
surface for specularity.

Environment Color dropdown The channel containing the reflective sur-
face, using an image in a channel as the 
reflection, on the shaded surface.

Bump dropdown The channel containing the bump map to 
show as a preview for displacement.

Normal dropdown The channel used for input as a representa-
tion of the surface normals, added to the 
shaded surface.

You must choose either a 
Bump or Normal shader 
component in the same 
shader. If you attempt to 
use both, Normal over-
rides the Bump shader 
component.

Ambient Occlusion dropdown The channel to use to calculate the ambient 
occlusion.

In order for this to be calculated correctly, 
you need to run the ambient occlusion 
(Objects menu, select Ambient Occlusion) on 
each object in your project. Otherwise, 
everything is shaded equally.

Emissive Color dropdown The channel containing the RGB color of the 
emissive (glow) qualities on the shaded sur-
face.

Vector dropdown The channel containing the vector field and 
resulting vector data from paint on the 
shaded surface.

This data is used by the 
vector inspector.

Displacement dropdown The channel containing the displacement 
map and dynamic tessellation to show a 
more advanced preview of displacement.

This component is dis-
abled for Ptex channels.

button Adds a new channel for the shader compo-
nent.

Add Channel 
Dialog Box

Diffuse entry box, 
slider

How much of the diffuse input appears on 
the shaded surface.

From 0 to 2; defaults to 1.

Specular entry box, 
slider

How much of the specular light appears on 
the shaded surface.

From 0 to 2; defaults to 1.

Control Type What it does Dialog Notes
Mari 2.0v1The Foundry
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Shaders Palette Fields 
Specular Roughness entry box, 
slider

How “rough” the surface is by default. 
Rougher surfaces have the highlight spread 
more across the surface. Lower values mean 
the surface is smoother (specular lights are 
more concentrated), higher values mean it is 
rougher (specular lights are spread out 
more).

From 0 to 1; defaults to 
0.700.

Environment entry box, 
slider

How much of the environment appears on 
the shaded surface.

From 0 to 2; defaults to 1.

Bump Weight entry box, 
slider

How much weight the bump map has. Lower 
values are smaller bumps, higher values are 
larger and more obvious displacements.

From 0 to 10; defaults to 
0.100.

Ambient entry box, 
slider

How much ambient light appears on the 
shaded surface.

From 0 to 2; defaults to 
0.200.

Ambient Occlusion entry box, 
slider

How much ambient occlusion occurs on the 
shaded surface.

From 0 to 2; defaults to 1.

Emissive entry box, 
slider

How much glow the emissive channel 
appears to have. 

From 0 to 2; defaults to 1.

Displacement | Displace-
ment Bias

entry box, 
slider

How much the white or black values are 
pushed or pulled from the surface.

From 0 to 1; defaults to 
0.500.

Displacement | Displace-
ment Scale

entry box, 
slider

What the range of displacement is. This set-
ting is multiplied by the Displacement Scale 
to give the displacement.

Displacement | Displace-
ment Range

entry box How much displacement is applied to the 
shaded surface. Lower values equal smaller 
displacement; higher values equal larger and 
more obvious displacement.

From 0 to 1; defaults to 
0.500.

Displacement | Max Tes-
sellation

entry box, 
slider

How many texels the surface is tessellated 
to.

From 1 to 64; defaults to 
10.

Lambertian/Blinn

Diffuse Color dropdown The channel containing the RGB diffuse color 
effect of the shaded surface.

Specular Color dropdown The channel containing the RGB specular 
color effect of the shaded surface.

Specular Shininess dropdown The channel containing the high shine areas 
for highlights in the specular shaded surface.

Environment Color dropdown The channel containing the reflective sur-
face, using an image in a channel as the 
reflection, on the shaded surface.

Bump dropdown The channel containing the bump map to 
show as a preview for displacement.

Control Type What it does Dialog Notes
Mari 2.0v1The Foundry
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Normal dropdown The channel used for input as a representa-
tion of the surface normals, added to the 
shaded surface.

You must choose either a 
Bump or Normal shader 
component in the same 
shader. If you attempt to 
use both, Normal over-
rides the Bump shader 
component.

Ambient Occlusion dropdown The channel to use to calculate the ambient 
occlusion.

In order for this to be calculated correctly, 
you need to run the ambient occlusion 
(Objects menu, select Ambient Occlusion) on 
each object in your project. Otherwise, 
everything is shaded equally.

Emissive Color dropdown The channel containing the RGB color of the 
emissive (glow) qualities on the shaded sur-
face.

Vector dropdown The channel containing the vector field and 
resulting vector data from paint on the 
shaded surface.

This data is used by the 
vector inspector.

Displacement dropdown The channel containing the displacement 
map and dynamic tessellation to show a 
more advanced preview of displacement.

This component is dis-
abled for Ptex channels.

button Adds a new channel for the shader compo-
nent.

Add Channel 
Dialog Box

Diffuse entry box, 
slider

How much of the diffuse input appears on 
the shaded surface.

From 0 to 2; defaults to 1.

Specular entry box, 
slider

How much of the specular light appears on 
the shaded surface.

From 0 to 2; defaults to 1.

Specular Shininess entry box, 
slider

How much shininess the specularity appears 
to have on the shaded surface.

From 0 to 100; defaults to 
30.

Environment entry box, 
slider

How much of the environment appears on 
the shaded surface.

From 0 to 2; defaults to 1.

Bump Weight entry box, 
slider

How much weight the bump map has. Lower 
values are smaller bumps, higher values are 
larger and more obvious displacements.

From 0 to 10; defaults to 
0.100.

Ambient entry box, 
slider

How much ambient light appears on the 
shaded surface.

From 0 to 2; defaults to 
0.200.

Ambient Occlusion entry box, 
slider

How much ambient occlusion occurs on the 
shaded surface.

From 0 to 2; defaults to 1.

Emissive entry box, 
slider

How much glow the emissive channel 
appears to have. 

From 0 to 2; defaults to 1.

Control Type What it does Dialog Notes
Mari 2.0v1The Foundry
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Displacement | Displace-
ment Bias

entry box, 
slider

How much the white or black values are 
pushed or pulled from the surface.

From 0 to 1; defaults to 
0.500.

Displacement | Displace-
ment Range

entry box What the range of displacement is. This set-
ting is multiplied by the Displacement Scale 
to give the displacement.

Displacement | Displace-
ment Scale

entry box, 
slider

How much displacement is applied to the 
shaded surface. Lower values equal smaller 
displacement; higher values equal larger and 
more obvious displacement.

From 0 to 1; defaults to 
0.500.

Displacement | Max Tes-
sellation

entry box, 
slider

How many texels the surface is tessellated 
to.

From 1 to 64; defaults to 
10.

Flat

Color dropdown The channel containing the RGB values of 
the shaded surface under flat lighting.

Vector dropdown The channel containing the vector field and 
resulting vector data from paint on the 
shaded surface.

This data is used by the 
vector inspector.

Displacement dropdown The channel containing the displacement 
map and dynamic tessellation to show a 
more advanced preview of displacement.

This component is dis-
abled for Ptex channels.

button Adds a new channel for the shader compo-
nent.

Add Channel 
Dialog Box

Displacement | Displace-
ment Bias

entry box, 
slider

How much the white or black values are 
pushed or pulled from the surface.

From 0 to 1; defaults to 
0.500.

Displacement | Displace-
ment Range

entry box What the range of displacement is. This set-
ting is multiplied by the Displacement Scale 
to give the displacement.

Displacement | Displace-
ment Scale

entry box, 
slider

How much displacement is applied to the 
shaded surface. Lower values equal smaller 
displacement; higher values equal larger and 
more obvious displacement.

From 0 to 1; defaults to 
0.500.

Displacement | Max Tes-
sellation

entry box, 
slider

How many texels the surface is tessellated 
to.

From 1 to 64; defaults to 
10.

Standard Lighting

Diffuse Color dropdown The channel containing the RGB diffuse color 
effect of the shaded surface.

Vector dropdown The channel containing the vector field and 
resulting vector data from paint on the 
shaded surface.

This data is used by the 
vector inspector.

Control Type What it does Dialog Notes
Mari 2.0v1The Foundry
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Shaders Palette Fields 
Displacement dropdown The channel containing the displacement 
map and dynamic tessellation to show a 
more advanced preview of displacement.

This component is dis-
abled for Ptex channels.

button Adds a new channel for the shader compo-
nent.

Add Channel 
Dialog Box

Diffuse entry box, 
slider

How much of the diffuse input appears on 
the shaded surface.

From 0 to 2; defaults to 1.

Specular entry box, 
slider

How much of the specular light appears on 
the shaded surface.

From 0 to 2; defaults to 1.

Specular Roughness  entry box, 
slider

How “rough” the surface is by default. 
Rougher surfaces have the highlight spread 
more across the surface. Lower values mean 
the surface is smoother (specular lights are 
more concentrated), higher values mean it is 
rougher (specular lights are spread out 
more).

From 0 to 1; defaults to 
0.700.

Displacement | Displace-
ment Bias

entry box, 
slider

How much the white or black values are 
pushed or pulled from the surface.

From 0 to 1; defaults to 
0.500.

Displacement | Displace-
ment Range

entry box What the range of displacement is. This set-
ting is multiplied by the Displacement Scale 
to give the displacement.

Displacement | Displace-
ment Scale

entry box, 
slider

How much displacement is applied to the 
shaded surface. Lower values equal smaller 
displacement; higher values equal larger and 
more obvious displacement.

From 0 to 1; defaults to 
0.500.

Displacement | Max Tes-
sellation

entry box, 
slider

How many texels the surface is tessellated 
to.

From 1 to 64; defaults to 
10.

Choose Diffuse and Specular | Minnaert/Phong

Diffuse Color dropdown The channel containing the RGB diffuse color 
effect of the shaded surface.

Specular Color dropdown The channel containing the RGB specular 
color effect of the shaded surface.

Specular Shininess dropdown The channel containing the high shine areas 
for highlights in the specular shaded surface.

Environment Color dropdown The channel containing the reflective sur-
face, using an image in a channel as the 
reflection, on the shaded surface.

Bump dropdown The channel containing the bump map to 
show as a preview for displacement.

Control Type What it does Dialog Notes
Mari 2.0v1The Foundry
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Shaders Palette Fields 
Normal dropdown The channel used for input as a representa-
tion of the surface normals, added to the 
shaded surface.

You must choose either a 
Bump or Normal shader 
component in the same 
shader. If you attempt to 
use both, Normal over-
rides the Bump shader 
component.

Ambient Occlusion dropdown The channel to use to calculate the ambient 
occlusion.

In order for this to be calculated correctly, 
you need to run the ambient occlusion 
(Objects menu, select Ambient Occlusion) on 
each object in your project. Otherwise, 
everything is shaded equally.

Emissive Color dropdown The channel containing the RGB color of the 
emissive (glow) qualities on the shaded sur-
face.

Vector dropdown The channel containing the vector field and 
resulting vector data from paint on the 
shaded surface.

This data is used by the 
vector inspector.

Displacement dropdown The channel containing the displacement 
map and dynamic tessellation to show a 
more advanced preview of displacement.

This component is dis-
abled for Ptex channels.

button Adds a new channel for the shader compo-
nent.

Add Channel 
Dialog Box

Diffuse entry box, 
slider

How much of the diffuse input appears on 
the shaded surface.

From 0 to 2; defaults to 1.

Specular dropdown How much of the specular light appears on 
the shaded surface.

From 0 to 2; defaults to 1.

Specular Shininess dropdown How much shininess the specularity appears 
to have on the shaded surface.

From 0 to 100; defaults to 
30.

Environment dropdown How much of the environment appears on 
the shaded surface.

From 0 to 2; defaults to 1.

Bump Weight entry box, 
slider

How much weight the bump map has. Lower 
values are smaller bumps, higher values are 
larger and more obvious displacements.

From 0 to 10; defaults to 
0.100.

Ambient entry box, 
slider

How much ambient light appears on the 
shaded surface.

From 0 to 2; defaults to 
0.200.

Ambient Occlusion entry box, 
slider

How much ambient occlusion occurs on the 
shaded surface.

From 0 to 2; defaults to 1.

Emissive entry box, 
slider

How much glow the emissive channel 
appears to have. 

From 0 to 2; defaults to 1.

Control Type What it does Dialog Notes
Mari 2.0v1The Foundry
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Shaders Palette Fields 
Diffuse Falloff entry box, 
slider

How much falloff is given to the diffuse 
input.

From 0 to 5; defaults to 1.

Displacement | Displace-
ment Bias

entry box, 
slider

How much the white or black values are 
pushed or pulled from the surface.

From 0 to 1; defaults to 
0.500.

Displacement | Displace-
ment Scale

entry box, 
slider

What the range of displacement is. This set-
ting is multiplied by the Displacement Scale 
to give the displacement.

Displacement | Displace-
ment Range

entry box, 
slider

How much displacement is applied to the 
shaded surface. Lower values equal smaller 
displacement; higher values equal larger and 
more obvious displacement.

From 0 to 1; defaults to 
0.500.

Displacement | Max Tes-
sellation

entry box, 
slider

How many texels the surface is tessellated 
to.

From 1 to 64; defaults to 
10.

Choose Diffuse and Specular | Minnaert/Cook Torrance

Diffuse Color dropdown The channel containing the RGB diffuse color 
effect of the shaded surface.

Specular Color dropdown The channel containing the RGB specular 
color effect of the shaded surface.

Specular Roughness dropdown The channel containing the rough shaded 
surface for specularity.

Specular IOR dropdown The channel containing the specularity for 
the index of refraction. This can be adjusted 
to the IOR value of the desired material.

Environment Color dropdown The channel containing the reflective sur-
face, using an image in a channel as the 
reflection, on the shaded surface.

Bump dropdown The channel containing the bump map to 
show as a preview for displacement.

Normal dropdown The channel used for input as a representa-
tion of the surface normals, added to the 
shaded surface.

You must choose either a 
Bump or Normal shader 
component in the same 
shader. If you attempt to 
use both, Normal over-
rides the Bump shader 
component.

Ambient Occlusion dropdown The channel to use to calculate the ambient 
occlusion.

In order for this to be calculated correctly, 
you need to run the ambient occlusion 
(Objects menu, select Ambient Occlusion) on 
each object in your project. Otherwise, 
everything is shaded equally.

Control Type What it does Dialog Notes
Mari 2.0v1The Foundry
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Emissive Color dropdown The channel containing the RGB color of the 
emissive (glow) qualities on the shaded sur-
face.

Vector dropdown The channel containing the vector field and 
resulting vector data from paint on the 
shaded surface.

This data is used by the 
vector inspector.

Displacement dropdown The channel containing the displacement 
map and dynamic tessellation to show a 
more advanced preview of displacement.

This component is dis-
abled for Ptex channels.

button Adds a new channel for the shader compo-
nent.

Add Channel 
Dialog Box

Diffuse dropdown How much of the diffuse input appears on 
the shaded surface.

From 0 to 2; defaults to 1.

Specular dropdown How much of the specular light appears on 
the shaded surface.

From 0 to 2; defaults to 1.

Specular IOR dropdown Adjust the IOR to the value of a specific 
material, or adjust the slider until you find 
the index of refraction that suits your needs.

From 0 to 5; defaults to 1.

Specular Roughness dropdown How “rough” the surface is by default. 
Rougher surfaces have the highlight spread 
more across the surface. Lower values mean 
the surface is smoother (specular lights are 
more concentrated), higher values mean it is 
rougher (specular lights are spread out 
more).

From 0 to 1; defaults to 
0.700.

Environment dropdown How much of the environment appears on 
the shaded surface.

From 0 to 2; defaults to 1.

Bump Weight entry box, 
slider

How much weight the bump map has. Lower 
values are smaller bumps, higher values are 
larger and more obvious displacements.

From 0 to 10; defaults to 
0.100.

Ambient entry box, 
slider

How much ambient light appears on the 
shaded surface.

From 0 to 2; defaults to 
0.200.

Ambient Occlusion entry box, 
slider

How much ambient occlusion occurs on the 
shaded surface.

From 0 to 2; defaults to 1.

Emissive entry box, 
slider

How much glow the emissive channel 
appears to have. 

From 0 to 2; defaults to 1.

Diffuse Falloff entry box, 
slider

How much falloff is given to the diffuse 
input.

From 0 to 5; defaults to 1.

Displacement | Displace-
ment Bias

entry box, 
slider

How much the white or black values are 
pushed or pulled from the surface.

From 0 to 1; defaults to 
0.500.

Control Type What it does Dialog Notes
Mari 2.0v1The Foundry
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Shaders Palette Fields 
Displacement | Displace-
ment Scale

entry box, 
slider

What the range of displacement is. This set-
ting is multiplied by the Displacement Scale 
to give the displacement.

Displacement | Displace-
ment Range

entry box, 
slider

How much displacement is applied to the 
shaded surface. Lower values equal smaller 
displacement; higher values equal larger and 
more obvious displacement.

From 0 to 1; defaults to 
0.500.

Displacement | Max Tes-
sellation

entry box, 
slider

How many texels the surface is tessellated 
to.

From 1 to 64; defaults to 
10.

Choose Diffuse and Specular | Minnaert/Beckman

Diffuse Color dropdown The channel containing the RGB diffuse color 
effect of the shaded surface.

Specular Color dropdown The channel containing the RGB specular 
color effect of the shaded surface.

Specular Roughness dropdown The channel containing the rough shaded 
surface for specularity.

Environment Color dropdown The channel containing the reflective sur-
face, using an image in a channel as the 
reflection, on the shaded surface.

Bump dropdown The channel containing the bump map to 
show as a preview for displacement.

Normal dropdown The channel used for input as a representa-
tion of the surface normals, added to the 
shaded surface.

You must choose either a 
Bump or Normal shader 
component in the same 
shader. If you attempt to 
use both, Normal over-
rides the Bump shader 
component.

Ambient Occlusion dropdown The channel to use to calculate the ambient 
occlusion.

In order for this to be calculated correctly, 
you need to run the ambient occlusion 
(Objects menu, select Ambient Occlusion) on 
each object in your project. Otherwise, 
everything is shaded equally.

Emissive Color dropdown The channel containing the RGB color of the 
emissive (glow) qualities on the shaded sur-
face.

Vector dropdown The channel containing the vector field and 
resulting vector data from paint on the 
shaded surface.

This data is used by the 
vector inspector.

Control Type What it does Dialog Notes
Mari 2.0v1The Foundry
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Shaders Palette Fields 
Displacement dropdown The channel containing the displacement 
map and dynamic tessellation to show a 
more advanced preview of displacement.

This component is dis-
abled for Ptex channels.

button Adds a new channel for the shader compo-
nent.

Add Channel 
Dialog Box

Diffuse entry box, 
slider

How much of the diffuse input appears on 
the shaded surface.

From 0 to 2; defaults to 1.

Specular entry box, 
slider

How much of the specular light appears on 
the shaded surface.

From 0 to 2; defaults to 1.

Specular Roughness entry box, 
slider

How “rough” the surface is by default. 
Rougher surfaces have the highlight spread 
more across the surface. Lower values mean 
the surface is smoother (specular lights are 
more concentrated), higher values mean it is 
rougher (specular lights are spread out 
more).

From 0 to 1; defaults to 
0.700.

Environment entry box, 
slider

How much of the environment appears on 
the shaded surface.

From 0 to 2; defaults to 1.

Bump Weight entry box, 
slider

How much weight the bump map has. Lower 
values are smaller bumps, higher values are 
larger and more obvious displacements.

From 0 to 10; defaults to 
0.100.

Ambient entry box, 
slider

How much ambient light appears on the 
shaded surface.

From 0 to 2; defaults to 
0.200.

Ambient Occlusion entry box, 
slider

How much ambient occlusion occurs on the 
shaded surface.

From 0 to 2; defaults to 1.

Emissive entry box, 
slider

How much glow the emissive channel 
appears to have. 

From 0 to 2; defaults to 1.

Diffuse Falloff entry box, 
slider

How much falloff is given to the diffuse 
input.

From 0 to 5; defaults to 1.

Displacement | Displace-
ment Bias

entry box, 
slider

How much the white or black values are 
pushed or pulled from the surface.

From 0 to 1; defaults to 
0.500.

Displacement | Displace-
ment Scale

entry box, 
slider

What the range of displacement is. This set-
ting is multiplied by the Displacement Scale 
to give the displacement.

Displacement | Displace-
ment Range

entry box How much displacement is applied to the 
shaded surface. Lower values equal smaller 
displacement; higher values equal larger and 
more obvious displacement.

From 0 to 1; defaults to 
0.500.

Displacement | Max Tes-
sellation

entry box, 
slider

How many texels the surface is tessellated 
to.

From 1 to 64; defaults to 
10.

Control Type What it does Dialog Notes
Mari 2.0v1The Foundry
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Shaders Palette Fields 
Choose Diffuse/Specular | Minnaert/ Blinn

Diffuse Color dropdown The channel containing the RGB diffuse color 
effect of the shaded surface.

Specular Color dropdown The channel containing the RGB specular 
color effect of the shaded surface.

Specular Shininess dropdown The channel containing the high shine areas 
for highlights in the specular shaded surface.

Environment Color dropdown The channel containing the reflective sur-
face, using an image in a channel as the 
reflection, on the shaded surface.

Bump dropdown The channel containing the bump map to 
show as a preview for displacement.

Normal dropdown The channel used for input as a representa-
tion of the surface normals, added to the 
shaded surface.

You must choose either a 
Bump or Normal shader 
component in the same 
shader. If you attempt to 
use both, Normal over-
rides the Bump shader 
component.

Ambient Occlusion dropdown The channel to use to calculate the ambient 
occlusion.

In order for this to be calculated correctly, 
you need to run the ambient occlusion 
(Objects menu, select Ambient Occlusion) on 
each object in your project. Otherwise, 
everything is shaded equally.

Emissive Color dropdown The channel containing the RGB color of the 
emissive (glow) qualities on the shaded sur-
face.

Vector dropdown The channel containing the vector field and 
resulting vector data from paint on the 
shaded surface.

This data is used by the 
vector inspector.

Displacement dropdown The channel containing the displacement 
map and dynamic tessellation to show a 
more advanced preview of displacement.

This component is dis-
abled for Ptex channels.

button Adds a new channel for the shader compo-
nent.

Add Channel 
Dialog Box

Diffuse entry box, 
slider

How much of the diffuse input appears on 
the shaded surface.

From 0 to 2; defaults to 1.

Specular entry box, 
slider

How much of the specular light appears on 
the shaded surface.

From 0 to 2; defaults to 1.

Control Type What it does Dialog Notes
Mari 2.0v1The Foundry
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Shaders Palette Fields 
Specular Shininess entry box, 
slider

How much shininess the specularity appears 
to have on the shaded surface.

From 0 to 100; defaults to 
30.

Environment entry box, 
slider

How much of the environment appears on 
the shaded surface.

From 0 to 2; defaults to 1.

Bump Weight entry box, 
slider

How much weight the bump map has. Lower 
values are smaller bumps, higher values are 
larger and more obvious displacements.

From 0 to 10; defaults to 
0.100.

Ambient entry box, 
slider

How much ambient light appears on the 
shaded surface.

From 0 to 2; defaults to 
0.200.

Ambient Occlusion entry box, 
slider

How much ambient occlusion occurs on the 
shaded surface.

From 0 to 2; defaults to 1.

Emissive entry box, 
slider

How much glow the emissive channel 
appears to have. 

From 0 to 2; defaults to 1.

Diffuse Falloff entry box, 
slider

How much falloff is given to the diffuse 
input.

From 0 to 5; defaults to 1.

Displacement | Displace-
ment Bias

entry box, 
slider

How much the white or black values are 
pushed or pulled from the surface.

From 0 to 1; defaults to 
0.500.

Displacement | Displace-
ment Range

entry box What the range of displacement is. This set-
ting is multiplied by the Displacement Scale 
to give the displacement.

Displacement | Displace-
ment Scale

entry box, 
slider

How much displacement is applied to the 
shaded surface. Lower values equal smaller 
displacement; higher values equal larger and 
more obvious displacement.

From 0 to 1; defaults to 
0.500.

Displacement | Max Tes-
sellation

entry box, 
slider

How many texels the surface is tessellated 
to.

From 1 to 64; defaults to 
10.

Control Type What it does Dialog Notes
Mari 2.0v1The Foundry



26  LIGHTS PALETTE

What It Does

The Lights palette displays the lights in your project, and allows you to:

• Customize the lights.

• Turn each light on or off.

• Move the lights around.

• Reposition a light to the current camera position.

• Render shadows for individual lights.

Lights palette 
fields

Control Type What it does Notes

Sorted by dropdown Lets you specify whether to list lights by their name or in a cus-
tom order. To use a custom order, drag the lights up and down 
the list.

button Lets you reposition the selected light to the current camera 
position.

Light > Color | Specular swatch Sets the specular color of the light (the “shiny” color of the 
light).

Defaults to white.

Light > Color | Diffuse swatch Sets the diffuse color of the light (the “surface” color of the 
light).

Defaults to white.

Light > General | Fixed To dropdown Sets what the light is fixed to:

• Scene (default) — the light is fixed to the model, for example 
if a light is set at the model's back, it always points at the 
model's back, no matter how you move the view.

• Camera — the light is fixed to a camera view, for example you 
can have a light always shining from above the camera, allow-
ing you to move the model around and cast light on different 
areas.

Light > General | On checkbox Whether the light is on or off.
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Lights palette fields 
Light > Position | Position control 
sphere

Lets you move the light around your project. Click and drag to 
move the light. 

Light > Rendering | Render 
Shadows

checkbox Renders and displays the shadows cast on the model by the 
selected light in its current position.

Control Type What it does Notes
Mari 2.0v1The Foundry



27  PROJECTORS PALETTE

What It Does

The Projectors palette displays the projectors in your project, and allows you to:

• Create, load, save, and delete projectors.

• Use a projector to take a snapshot of the current view.

• Use a projector to project an edited snapshot back onto the model's surface.

Projectors 
palette fields

Control Type What it does
Opens this dialog 
box Notes

button Creates a new projector.

button Saves the selected pro-
jector to disk.

Save Projector

button Loads a saved projector 
from disk.

Load Projector

button Deletes the selected 
projector.

Projector > General | Name entry box Enter the name of the 
projector.

This identifies the 
projector at the top of 
the palette.

Projector > Action | Import button Click to load the image 
from the file set in the 
Input File Path and proj-
ect it as paint onto the 
model (without baking).

Pick Path (if Input 
File Path has not 
yet been specified)

Projector > Action | Project button Click to load the image 
from the file set in the 
Input File Path and 
project and bake it onto 
the model.

Pick Path (if Input 
File Path has not 
yet been specified)
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Projectors palette fields 
Projector > Path | Input File Path entry box Enter the filename and 

path where the 

projector loads updated 

images from.

Projector > Action | Unproject button Click to save the current 
view buffer out to the 
file set in the Output 
File Path.

Pick Path (if Out-
put File Path has 
not yet been speci-
fied)

Projector > Path | Output File Path entry box Enter the filename and 

path where the 

projector saves images 

to disk.

Projector > Unprojection | Clamp checkbox If this is checked, Mari 
restricts the range of 
the paint buffer to val-
ues between 0 and 1.

Projector > Unprojection | Shader Used dropdown Select the shader you 
want the projector to 
take a screen snapshot 
of. By default, this is set 
to Current Paint Target.

Current Shader, Cur-
rent Channel, Current 
Layer, Current Paint 
Target, and Current 
Layer and Below.

Projector > Unprojection | Lighting Mode dropdown The lighting mode to use 
when taking a screen 
snapshot with this pro-
jector.

Flat, Basic, Full.

Projector > Unprojection | Color Depth dropdown The color depth of the 
screen snapshots taken 
by this projector.

8bit (Byte), 16bit 
(Half), 32bit (Float).

Projector > Unprojection | Size dropdown The size (in pixels) of 
the screen snapshots 
taken by this projector.

Projector > Painting | Painting Mode dropdown Sets the paint blending 

mode.

The paint blending 
modes available are 
similar to many other 
paint packages. If you 
aren't familiar with the 
various modes, see 
Paint blending modes 
in the Mari User Guide 
for descriptions and 
examples.

Control Type What it does
Opens this dialog 
box Notes
Mari 2.0v1The Foundry
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Projectors palette fields 
Projector > Projection | Projection dropdown Sets whether Mari 

projects only onto the 

Front of the model (as 

you're seeing it) or 

whether paint goes 

straight Through the 

model (appearing on the 

back as well as the 

front).

Projector > Transformation | Scale entry boxes Sets the scale of the 

projector.

Projector > Transformation | Translation entry boxes Sets the translated 

position of the 

projector.

Projector > Transformation | Rotation entry box Sets the rotation, in 
degrees, of the projec-
tor.

Projector > Update | Update Global Set-
tings From Projector

button If you have adjusted any 
projection properties, 
click this button to see 
the effect of your 
changes in the canvas. 
When you do, the equiv-
alent global projection 
properties in the Projec-
tion palette are also 
updated.

Updates all global 
projection properties.

Projector > Update | Update Only Masks 
From Projector

button If you have adjusted any 
projection mask proper-
ties, click this button to 
see the effect of your 
changes in the canvas. 
When you do, the equiv-
alent global projection 
mask properties in the 
Projection palette are 
also updated.

Updates global pro-
jection mask proper-
ties only.

Projector > <projector name> > General | 
Name

entry box Name of the camera 
used for the projector.

Projector > <projector name> > General | 
Animated

information Whether the camera 
used for the projector is 
animated.

True, False.

Control Type What it does
Opens this dialog 
box Notes
Mari 2.0v1The Foundry
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Projectors palette fields 
Projector > <projector name> > Perspec-
tive | FoV

entry box, 
slider

Enter the value for the 
field of vision. This con-
trols how much Mari 
distorts the view when 
applying perspective. At 
0, the perspective cam-
era gives exactly the 
same view as the ortho 
camera. As the value 
increases, the distor-
tion increases.

Projector > <projector name> > Perspec-
tive | Near plane

entry box, 
slider

Enter the value for the 
near clipping plane. Mari 
doesn’t display parts of 
the scene that are closer 
than the Near plane.

Projector > <projector name> > Perspec-
tive | Far plane

entry box, 
slider

Enter the value for the 
far clipping plane. Mari 
doesn’t display parts of 
the scene that are fur-
ther than the Far plane.

Edge Mask > General | Enabled checkbox Whether the edge mask 
is turned on or not.

You need to click 
either of the update 
buttons under Update 
to see the effect of 
your changes in the 
canvas. When you do, 
the equivalent global 
properties in the Pro-
jection palette are 
also updated.

Edge Mask > General | Falloff Start entry box, 
slider

Controls where the edge 
mask starts on the 
model. The higher the 
value, the more forward 
facing the masking 
starts. If this is higher 
than the Falloff End, 
areas facing the view 
are paintable, and areas 
oblique to the view are 
masked. If this is lower, 
facing areas are masked 
and oblique areas are 
paintable.

You need to click 
either of the update 
buttons under Update 
to see the effect of 
your changes in the 
canvas. When you do, 
the equivalent global 
properties in the Pro-
jection palette are 
also updated.

Control Type What it does
Opens this dialog 
box Notes
Mari 2.0v1The Foundry
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Projectors palette fields 
Edge Mask > General | Falloff End entry box, 
slider

Controls where the edge 
mask ends on the model. 
The higher the value, the 
closer, more forward 
facing the mask finishes.

You need to click 
either of the update 
buttons under Update 
to see the effect of 
your changes in the 
canvas. When you do, 
the equivalent global 
properties in the Pro-
jection palette are 
also updated.

Edge Mask > General | Falloff Curve curve editor Adjusts the falloff, using 
a curve editor to modify 
the falloff start and end 
point. To fine tun con-
trol over the falloff, add 
more points to the 
curve.

You need to click 
either of the update 
buttons under Update 
to see the effect of 
your changes in the 
canvas. When you do, 
the equivalent global 
properties in the Pro-
jection palette are 
also updated.

Channel Mask > General | Invert checkbox If this is selected, the 
mask data is black on 
white rather than white 
on black.

You need to click 
either of the update 
buttons under Update 
to see the effect of 
your changes in the 
canvas. When you do, 
the equivalent global 
properties in the Pro-
jection palette are 
also updated.

Channel Mask > General | Mask Curve curve editor Adjusts the amount of 
masking on the channel, 
where white pixels are 
totally masked, black 
pixels are totally 
unmasked, and 50% 
grey is 50% masked.

You need to click 
either of the update 
buttons under Update 
to see the effect of 
your changes in the 
canvas. When you do, 
the equivalent global 
properties in the Pro-
jection palette are 
also updated.

Control Type What it does
Opens this dialog 
box Notes
Mari 2.0v1The Foundry
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Projectors palette fields 
Channel Mask > General | Mask Contrast entry box, 
slider

The contrast applied to 
the original channel to 
derive the mask. At 1.0, 
the mask comes directly 
from the original chan-
nel. Lower values make 
the mask fuzzier than 
the input channel, higher 
values make it sharper 
than the input channel.

You need to click 
either of the update 
buttons under Update 
to see the effect of 
your changes in the 
canvas. When you do, 
the equivalent global 
properties in the Pro-
jection palette are 
also updated.

Channel Mask > General | Mask Amount entry box, 
slider

The strength of the 
mask effect.1.0 means 
that the mask absolutely 
controls where you can 
paint; the effects of the 
mask decrease as the 
value gets lower.

You need to click 
either of the update 
buttons under Update 
to see the effect of 
your changes in the 
canvas. When you do, 
the equivalent global 
properties in the Pro-
jection palette are 
also updated.

Channel Mask > General | Mask Channel dropdown Sets the channel hold-
ing the mask from a list 
of available channels in 
your project.

You need to click 
either of the update 
buttons under Update 
to see the effect of 
your changes in the 
canvas. When you do, 
the equivalent global 
properties in the Pro-
jection palette are 
also updated.

Channel Mask > General | Enabled checkbox Whether the channel 
mask is turned on or 
not.

You need to click 
either of the update 
buttons under Update 
to see the effect of 
your changes in the 
canvas. When you do, 
the equivalent global 
properties in the Pro-
jection palette are 
also updated.

Ambient Occlusion Mask > General | Invert checkbox If this is selected, the 
mask data is black on 
white rather than white 
on black.

Control Type What it does
Opens this dialog 
box Notes
Mari 2.0v1The Foundry
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Projectors palette fields 
Ambient Occlusion Mask > General | Mask 
Curve

curve editor Controls how the ambi-
ent occlusion pixel val-
ues relate to the degree 
of masking. The hori-
zontal axis is the dark-
ness of the occluded 
pixels (black to the left, 
white to the right), the 
vertical axis is the 
degree of visibility. By 
default, this is a direct 
line, where white pixels 
are totally masked, black 
pixels are totally 
unmasked, and 50% 
grey is 50% masked.

Ambient Occlusion Mask > General | Mask 
Contrast

entry box, 
slider

The contrast applied to 
the ambient occlusion to 
derive the mask. At 1.0, 
the mask comes directly 
from the calculated 
ambient occlusion. 
Lower values make the 
mask fuzzier than the 
ambient occlusion, 
higher values make it 
sharper.

You need to click 
either of the update 
buttons under Update 
to see the effect of 
your changes in the 
canvas. When you do, 
the equivalent global 
properties in the Pro-
jection palette are 
also updated.

Ambient Occlusion Mask > General | Mask 
Amount

entry box, 
slider

The amount of ambient 
occlusion masking to 
apply.

You need to click 
either of the update 
buttons under Update 
to see the effect of 
your changes in the 
canvas. When you do, 
the equivalent global 
properties in the Pro-
jection palette are 
also updated.

Ambient Occlusion Mask > General | Enabled checkbox Whether the ambient 
occlusion mask is turned 
on or not.

You need to click 
either of the update 
buttons under Update 
to see the effect of 
your changes in the 
canvas. When you do, 
the equivalent global 
properties in the Pro-
jection palette are 
also updated.

Control Type What it does
Opens this dialog 
box Notes
Mari 2.0v1The Foundry
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Projectors palette fields 
Depth Mask > General | Enabled checkbox Whether the depth mask 
is turned on or not.

You need to click 
either of the update 
buttons under Update 
to see the effect of 
your changes in the 
canvas. When you do, 
the equivalent global 
properties in the Pro-
jection palette are 
also updated.

Depth Mask > General | Falloff entry box, 
slider

How fast the depth 
masking applies. Lower 
values make the mask 
apply slowly, higher val-
ues make it apply more 
quickly.

You need to click 
either of the update 
buttons under Update 
to see the effect of 
your changes in the 
canvas. When you do, 
the equivalent global 
properties in the Pro-
jection palette are 
also updated.

Depth Mask > General | End entry box, 
slider

The depth in the scene 
for the depth masking to 
finish.

You need to click 
either of the update 
buttons under Update 
to see the effect of 
your changes in the 
canvas. When you do, 
the equivalent global 
properties in the Pro-
jection palette are 
also updated.

Depth Mask > General | Start entry box, 
slider

The depth in the scene 
for the depth masking to 
start.

You need to click 
either of the update 
buttons under Update 
to see the effect of 
your changes in the 
canvas. When you do, 
the equivalent global 
properties in the Pro-
jection palette are 
also updated.

Control Type What it does
Opens this dialog 
box Notes
Mari 2.0v1The Foundry
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Projectors palette fields 
Backface Mask > General | Enabled checkbox Whether the backface 
mask is turned on or 
not. 

You need to click 
either of the update 
buttons under Update 
to see the effect of 
your changes in the 
canvas. When you do, 
the equivalent global 
properties in the Pro-
jection palette are 
also updated.

Fractal Noise Mask > General | Invert checkbox If this is selected, the 
mask data is black on 
white rather than white 
on black.

Fractal Noise Mask > General | Mask Curve curve editor Adjusts the fractal noise 
masking where white 
pixels are totally 
masked, black pixels are 
totally unmasked, and 
50% grey is 50% 
masked.

You need to click 
either of the update 
buttons under Update 
to see the effect of 
your changes in the 
canvas. When you do, 
the equivalent global 
properties in the Pro-
jection palette are 
also updated.

Fractal Noise Mask > General | Enabled checkbox Whether the fractal 
noise mask is turned on 
or not.

When enabled, a  

icon displays in the 
status bar.

Fractal Noise Mask > General | Mask 
Amount

entry box, 
slider

The amount that the 
mask affects the paint 
buffer. 1.0 means that 
the mask absolutely 
controls where you can 
paint; the effects of the 
mask decrease as the 
value gets lower.

You need to click 
either of the update 
buttons under Update 
to see the effect of 
your changes in the 
canvas. When you do, 
the equivalent global 
properties in the Pro-
jection palette are 
also updated.

Control Type What it does
Opens this dialog 
box Notes
Mari 2.0v1The Foundry



PROJECTORS PALETTE 131
Projectors palette fields 
Fractal Noise Mask > General | Size entry box, 
slider

Determines the size of 
the fractal noise fea-
tures.

You need to click 
either of the update 
buttons under Update 
to see the effect of 
your changes in the 
canvas. When you do, 
the equivalent global 
properties in the Pro-
jection palette are 
also updated.

Fractal Noise Mask > General | Roughness entry box, 
slider

Determines the rough-
ness of the fractal noise 
features.

You need to click 
either of the update 
buttons under Update 
to see the effect of 
your changes in the 
canvas. When you do, 
the equivalent global 
properties in the Pro-
jection palette are 
also updated.

Fractal Noise Mask > General | Contrast entry box, 
slider

Controls the level of 
contrast applied to the 
fractal noise features to 
derive the mask.

You need to click 
either of the update 
buttons under Update 
to see the effect of 
your changes in the 
canvas. When you do, 
the equivalent global 
properties in the Pro-
jection palette are 
also updated.

Fractal Noise Mask > General | Seed entry box, 
slider

Changes the pattern of 
the fractal noise by 
moving the pattern start 
point through 3D space.

You need to click 
either of the update 
buttons under Update 
to see the effect of 
your changes in the 
canvas. When you do, 
the equivalent global 
properties in the Pro-
jection palette are 
also updated.

Control Type What it does
Opens this dialog 
box Notes
Mari 2.0v1The Foundry



28  SELECTION GROUPS PALETTE

What It Does

The Selection Groups palette lets you switch between saved selection groups. You can also create new 
selection groups, lock and unlock groups, and show or hide groups.

Selection Groups 
palette fields

Control Type What it does Opens this dialog box Notes

Sorted by Dropdown Sets how to sort the entries in the list.

At present, you can only sort by name.

button Adds a new selection group, based on the 
current selection.

button Removes the highlighted selection group.

button Reloads the highlighted selection group.

button Locks the selection group.

button Unlocks the selection group.

button Hides the selection group.

button Shows the selection group.



29  COLOR MANAGER PALETTE

What It Does

The Color Manager lets you manage how colors are displayed on your monitor. It includes many options 
for color correction, including a host of preset filters. Managing colors using the preset filters in this 
palette does not affect the paint on your model. For information on the filters used to apply 
transformations to the paint on your model, refer to the Filter Functions chapter.

Color Manager 
Palette Fields

Control Type What it does
Opens this 
dialog box Notes

Options | Enable Color Management switch, on/
off indicator

Turns color correction 
on or off.

When on,  displays in the

status bar, and a histogram 
displays a count of frequen-
cies of colors in RGBA chan-
nels in the current view.

Options | Active on/off indi-
cator

Displays green when 
color correction is on.

Not active for scalar channel.

Options | Histogram switch, on/
off indicator

Turns histogram view on 
or off. If it's on, Mari 
displays a color histo-
gram in the background 
of the canvas.

Options | Split Point entry box, 
slider

Lets you split the dis-
play between showing 
corrected and uncor-
rected color.

Enter a value or slide to 
specify what percent-
age of the model (split 
vertically) displays with 
color correction.

Color Correction is on.

Range: 0.00 to 1.00

Current Color Profile | <profile> dropdown Lets you select from 
saved color profiles.

Default tries to make 
onscreen colors emulate film.
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Color Manager Palette Fields 
Current Color Profile | New button Prompts you to name a 
new profile, select avail-
able filters to include in 
a particular order, and 
save.

Edit

Current Color Profile | Edit button Lets you rename and 
change the current pro-
file.

Edit

Current Color Profile | Delete button Deletes the current pro-
file (after confirming).

Really Delete?

Current Color Profile | LUT switch, on/
off indicator, 
add attribute

Switches the filter on or 
off, or lets you add 
attributes to it.

Current Color Profile > LUT > 
General | File

entry box Enter the filename and 
path of the LUT.

Current Color Profile > LUT > 
General | Extrapolate

checkbox Sets whether the GPU 
extrapolates the grid 
values or clamps to the 
maximum value of the 
LUT.

Current Color Profile | Composite Filter switch, on/
off indicator, 
add attribute

Switches the filter on or 
off, or lets you add 
attributes to it.

Add User 
Attribute

Current Color Profile | Levels switch, on/
off indicator, 
add attribute

Changes the color levels 
in the paint, by setting 
the white point, mid-
tone, and black point.

Current Color Profile > Levels > 
Channel | Color Component

dropdown Whether the filter 
affects all components, 
or a specific one (Red, 
Green, or Blue).

Current Color Profile > Levels > 
Input Levels | White Point

entry box, 
slider

Specifies the upper limit 
of displayed color inten-
sity. Areas with a value 
higher than this are 
mapped to 1 (pure 
white).

Control Type What it does
Opens this 
dialog box Notes
Mari 2.0v1The Foundry
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Color Manager Palette Fields 
Current Color Profile > Levels > 
Input Levels | Midtone

entry box, 
slider

Sets the middle point 
between white and 
black. Mari remaps the 
values so that this is the 
middle of the range 
between the white point 
and black point. Moving 
this pushes the values 
towards that end of the 
spectrum.

Current Color Profile > Levels > 
Input Levels | Black Point

entry box, 
slider

Specifies the lower limit 
of displayed color inten-
sity. Areas with a value 
lower than this are 
mapped to 0 (pure 
black). 

Current Color Profile > Levels > 
Output Levels | White Output Levels

entry box, 
slider

Sets how much white is 
output in the filtered 
image. Higher values 
show the entire white 
output, lower values 
show decreasing 
amounts.

Current Color Profile > Levels > 
Output Levels | Black Output Levels

entry box, 
slider

Sets how much black is 
output in the filtered 
image. Higher values 
show the entire black 
output, lower values 
show decreasing 
amounts.

Current Color Profile | sRGB To Linear switch, on/
off indicator, 
add attribute

Applies an sRGB to lin-
ear colorspace conver-
sion.

Current Color Profile > sRGB To Linear > 
General | Invert

checkbox Applies a linear to sRGB 
colorspace conversion.

Current Color Profile | Color Curves switch, on/
off indicator, 
add attribute

Changes the color curve 
for each color channel 
(RGB) in the painting.

Add User 
Attribute

Presets can be loaded from 
.mgf (Mari Gradient Files). 

Current Color Profile > Color Curves > 
Channels | Red

curve editor Controls how the filter 
translates current Red 
values to new values.

Current Color Profile > Color Curves > 
Channels | Green

curve editor Controls how the filter 
translates current Green 
values to new values.

Control Type What it does
Opens this 
dialog box Notes
Mari 2.0v1The Foundry
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Color Manager Palette Fields 
Current Color Profile > Color Curves > 
Channels | Blue

curve editor Controls how the filter 
translates current Blue 
values to new values.

Current Color Profile | Color Switches switch, on/
off indicator, 
add attribute

Turns individual color 
channels on or off. 
(When Mari applies the 
filter, it removes any 
unchecked color chan-
nels from the painting.) 

Add User 
Attribute

Current Color Profile > Color Switches > 
Channels | Blue

checkbox Click to turn the Blue 
channel display on or 
off.

Current Color Profile > Color Switches > 
Channels | Green

checkbox Click to turn the Green 
channel display on or 
off.

Current Color Profile > Color Switches > 
Channels | Red

checkbox Click to turn the Red 
channel display on or 
off.

Current Color Profile | Brightness switch, on/
off indicator, 
add attribute

Changes the brightness 
of the paint on the 
model, either overall or 
for specific channels.

Add User 
Attribute

Current Color Profile > Brightness > 
General | Brightness

entry box, 
slider, reset

Sets the brightness 
value for all channels 
(overwrites changes to 
individual channels).

Range: 0.00 to 2.00

Reset: 1.00

Current Color Profile > Brightness > 
Channels | Blue

entry box, 
slider, reset

Sets the brightness 
value for the blue chan-
nel. 

Range: 0.00 to 2.00

Reset: 1.00

Current Color Profile > Brightness > 
Channels | Green

entry box, 
slider, reset

Sets the brightness 
value for the green 
channel. 

Range: 0.00 to 2.00

Reset: 1.00

Current Color Profile > Brightness > 
Channels | Red

entry box, 
slider, reset

Sets the brightness 
value for the red chan-
nel. 

Range: 0.00 to 2.00

Reset: 1.00

Current Color Profile | Blur switch, on/
off indicator, 
add attribute

Applies a standard blur 
to the selection.

Add User 
Attribute

Control Type What it does
Opens this 
dialog box Notes
Mari 2.0v1The Foundry
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Color Manager Palette Fields 
Current Color Profile > Blur > General | 
Blur Radius

entry box, 
slider, reset

Sets the blur radius — 
the number of pixels 
Mari uses when calcu-
lating the blur value for 
each pixel. The higher 
the radius, the more 
blurred the results. 

Range: 0 to 10

Reset: 4

If you use a larger blur radius, 
you may get slight lines on 
the boundaries between 
patches. This is an artifact of 
the way that Mari handles the 
edges of patches. 

Current Color Profile | Tone Mapping switch, on/
off indicator, 
add attribute

Varies the “exposure” of 
the painting.

Add User 
Attribute

Current Color Profile > Tone Mapping > 
General | White Point

entry box, 
slider, reset

Sets the upper limit of 
displayed color inten-
sity — any colors of 
greater intensity map to 
white.

Range: 0.00 to 1.00

Reset: 1.00

Current Color Profile > Tone Mapping > 
General | Exposure

entry box, 
slider, reset

Sets the exposure — 
lower exposures give 
darker images; higher 
exposures give lighter 
ones.

Range: 0.00 to 10.00

Reset: 1.00

Current Color Profile | Gamma switch, on/
off indicator, 
add attribute

Changes the gamma lev-
els in the selection.

Add User 
Attribute

A higher setting for Gamma 
results in a more washed-out 
looking image.

Current Color Profile > Gamma > General | 
Do Inverse

checkbox Reverses the gamma 
conversion. 

Current Color Profile > Gamma > General | 
Use default gamma

checkbox Disables the other con-
trols and uses your 
default setting for 
gamma (as set in the 
Painting tab of the Mari 
Preferences Dialog Box). 

Current Color Profile > Gamma > General | 
Gamma

entry box, 
slider, reset

Sets the gamma level. Range: 0.00 to 3.00

Reset: 2.20

Current Color Profile | “Lin 2 Log” switch, on/
off indicator, 
add attribute

Switches the filter on or 
off, or lets you add 
attributes to it.

Add User 
Attribute

Current Color Profile | Hue switch, on/
off indicator, 
add attribute

Changes the hue, satu-
ration, and value of the 
colors on the model. 

Add User 
Attribute

Control Type What it does
Opens this 
dialog box Notes
Mari 2.0v1The Foundry
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Color Manager Palette Fields 
Current Color Profile > Hue > Hue | 
Rotate

entry box, 
slider, reset

Moves the colors around 
the color wheel. The 
rotation value is the 
degree around the color 
wheel that each color 
shifts, between 0 and 
360 (which both corre-
spond to the original 
colors).

Range: 0.00 to 360.00

Reset: 0.00

Current Color Profile > Hue > Saturation | 
Scale

entry box, 
slider, reset

Sets a multiplier for the 
saturation.

Range: 0.00 to 2.00

Reset: 1.00 (the original sat-
uration)

Current Color Profile > Hue > Saturation | 
Offset

entry box, 
slider, reset

Adds an offset value to 
the initial saturation, 
before applying the 
Scale.

Range: 0.00 to 1.00

Reset: 0.00

Current Color Profile > Hue > Saturation | 
Saturation

curve editor Controls how the filter 
translates current satu-
ration to new satura-
tion.

Current Color Profile > Hue > Value | 
Scale

entry box, 
slider, reset

Sets a multiplier for the 
value.

Range: 0.00 to 2.00

Reset: 1.00 (the original 
value)

Current Color Profile > Hue > Value | 
Offset

entry box, 
slider, icon

Adds an offset value to 
the initial value, before 
applying the Scale.

Range: 0.00 to 1.00

Reset: 0.00

Current Color Profile > Hue > Value | 
Value

curve editor Controls how the filter 
translates current val-
ues to new values. 

Current Color Profile | Invert switch, on/
off indicator, 
add attribute

Inverts the colors in the 
selection. Replaces col-
ors with their “opposite” 
in the color chart. For 
example, replaces a 
color with a float value 
of 0.3 with a color with 
float value 0.7. 

Add User 
Attribute

Current Color Profile > Invert > General 
| Invert Alpha

checkbox Inverts the alpha chan-
nel.

Control Type What it does
Opens this 
dialog box Notes
Mari 2.0v1The Foundry
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Color Manager Palette Fields 
Current Color Profile | Premultiply 
Alpha

switch, on/
off indicator, 
add attribute

Either pre- or post-mul-
tiplies the alpha in the 
selected image. If you 
are painting using an 
image without pre-mul-
tiplied alpha onto one 
with it, use this filter to 
perform the pre-multi-
plication, so the images 
match and you avoid 
lines around the outside 
of the patch.

Add User 
Attribute

Current Color Profile > Premultiply Alpha 
> General | Postmultiply

checkbox Works the same as pre-
multiply, but in reverse 
(removes pre-multiplica-
tion to match images 
that do not have pre-
multiplied alpha).

Current Color Profile | “Log 2 Lin” switch, on/
off indicator, 
add attribute

Switches the filter on or 
off, or lets you add 
attributes to it.

Add User 
Attribute

Current Color Profile | Luminosity switch, on/
off indicator, 
add attribute

Outputs just the lumi-
nosity value of each 
pixel in the selection. 
That is, it outputs a 
grayscale image based 
on the brightness of 
each of the pixels in the 
original image. 

Add User 
Attribute

Current Color Profile | Contrast switch, on/
off indicator, 
add attribute

Switches the filter on or 
off, or lets you add 
attributes to it.

Add User 
Attribute

Current Color Profile | Clamp switch, on/
off indicator, 
add attribute

Clamps color values to 
lie within the specified 
upper and lower values.

Set the Upper Value and 
Lower Value by adjusting the 
sliders or entering values in 
the entry boxes.

Select the individual Color 
Component to clamp in the 
dropdown menu.

Current Color Profile > Clamp > 
General | Upper Value

entry box, 
slider

Set the upper value at 
which color values are 
clamped. All values 
higher than this number 
are set to this value.

Control Type What it does
Opens this 
dialog box Notes
Mari 2.0v1The Foundry
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Color Manager Palette Fields 
Current Color Profile > Clamp > 
General | Lower Value

entry box, 
slider

Set the lower value at 
which color values are 
clamped. All values 
lower than this number 
are set to this value.

Current Color Profile > Clamp > 
Channel | Color Component

dropdown Select the individual 
color component to 
clamp.

Current Color Profile > Contrast > 
General | Amount

entry box, 
slider, reset

Changes the contrast of 
the paint.

Range: 0.00 to 2.00

Reset: 1.00

Current Color Profile | Copy Channel switch, on/
off indicator, 
add attribute

Copies the value from 
one RGB color channel 
to the other two. The 
result is a grayscale 
image with the intensity 
values from the selected 
channel.

Add User 
Attribute

Current Color Profile > Copy Channel > 
General | Copy Channel

dropdown Select the source chan-
nel from the list (Red, 
Green, or Blue). When 
you apply the filter, Mari 
copies the selected 
channel over the other 
two channels.

Current Color Profile | Soften switch, on/
off indicator, 
add attribute

Applies a subtle soften-
ing blur.

Add User 
Attribute

This is a quick, predefined 
blur filter. If you need more 
control over the degree or 
type of blurring, use either 
the standard Blur or Gaussian 
Blur filters. 

Current Color Profile | Edge Detect switch, on/
off indicator, 
add attribute

Finds “edges” (transi-
tions between colors) in 
the image and height-
ens them.

Add User 
Attribute

Current Color Profile | Emboss switch, on/
off indicator, 
add attribute

Applies an “emboss” 
effect, so that textures 
look “raised” on the sur-
face.

Add User 
Attribute

Current Color Profile | Sharpen switch, on/
off indicator, 
add attribute

Removes 'fuzziness' and 
clarifies detail in the 
image.

Add User 
Attribute

Control Type What it does
Opens this 
dialog box Notes
Mari 2.0v1The Foundry
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Color Manager Palette Fields 
Current Color Profile > Sharpen > General 
| Amount

entry box, 
slider, reset

Sets the amount of 
sharpening. Higher val-
ues mean more sharpen-
ing, while a value of 
0.00 is the picture with-
out the filter applied.

Range: 0.00 to 1.00

Current Color Profile | Dilate switch, on/
off indicator, 
add attribute

Switches the filter on or 
off, or lets you add 
attributes to it.

Add User 
Attribute

Current Color Profile | Gaussian switch, on/
off indicator, 
add attribute

Applies a Gaussian blur. 
Compared to the stan-
dard Blur filter, this 
gives you much finer 
control over the degree 
of blurring, and the 
option of using much 
higher blur values.

Add User 
Attribute

Current Color Profile > Gaussian > 
General | Radius

entry box, 
slider

Sets the blur radius. The 
higher the radius, the 
more blurred the results. 

Range: 0.00 to 50.00

If you use a larger blur radius, 
you may get slight lines on 
the boundaries between 
patches. This is an artifact of 
the way that Mari handles the 
edges of patches. 

Current Color Profile | High Pass switch, on/
off indicator, 
add attribute

Removes low frequency 
information from the 
image while maintaining 
higher frequency detail.

Current Color Profile > High Pass > 
General | Amount

entry box, 
slider

Sets how much low fre-
quency information is 
removed by the filter.

Current Color Profile > High Pass > 
General | Radius

entry box, 
slider

Controls the number of 
pixels around the image 
highlights that are 
affected by the filter.

Current Color Profile | Color Correction switch, on/
off indicator, 
add attribute

Switches the filter on or 
off, or lets you add 
attributes to it.

Current Color Profile > Color Correction > 
User Attributes | Configuration File

entry box Specifies the configura-
tion file to use.

Current Color Profile > Color Correction > 
User Attributes | Input ColorSpace

dropdown The colorspace of the 
current painting.

Control Type What it does
Opens this 
dialog box Notes
Mari 2.0v1The Foundry
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Color Manager Palette Fields 
Current Color Profile > Color Correction > 
User Attributes | Output ColorSpace

dropdown The colorspace correc-
tion to apply to the cur-
rent painting.

Current Color Profile | Add Noise switch, on/
off indicator, 
add attribute

Applies noise to the cur-
rent painting.

Current Color Profile > Add Noise > 
User Attributes | Amount

entry box, 
slider

Adjusts how much noise 
is applied.

Current Color Profile > Add Noise > 
User Attributes | Color Component

dropdown Sets the channel you 
want to affect.

Current Color Profile > Add Noise > 
User Attributes | Grayscale

checkbox Applies grayscale noise 
with only the intensity 
values from the selected 
channel.

Current Color Profile > Add Noise > 
User Attributes | Seed

entry box, 
slider

Adds variation to the 
noise.

Current Color Profile > Add Noise > 
User Attributes | Size

entry box, 
slider

Adjusts the size of the 
noise applied.

Control Type What it does
Opens this 
dialog box Notes
Mari 2.0v1The Foundry
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What It Does

The Image Manager lets you store and work with images in your project, including using them for brushes 
and painting through them onto your model.

Image Manager 
Palette Fields

Control Type What it does
Opens this 
dialog box Notes

Image Info | MriImage add attribute

Image Info > MriImage > Info | Depth information The color depth of the 
currently selected image 
in bytes.

Image Info > MriImage > Info | Channels information The color components 
of the currently selected 
image.

Image Info > MriImage > Info | File Space dropdown File space of the cur-
rently selected image.

NORMAL or VECTOR

Image Info > MriImage > Info | ColorSpace dropdown Colorspace of the cur-
rently selected image.

COLOR or SCALAR

Image Info > MriImage > Info | Tiled Image information Whether the image is 
tiled — true or false.

Image Info > MriImage > Info | Height information The height of the cur-
rently selected image in 
pixels.

Image Info > MriImage > Info | Width information The width of the cur-
rently selected image in 
pixels.

Image Info > MriImage > Info | Path information The file path to the 
original image.

button Adds an image to the 
Image Manager.

Open an Image
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Image Manager Palette Fields 
button Removes the selected 
image from the Image 
Manager.

button Opens the selected 
image in another win-
dow, where you can 
crop it.

<image>

button Saves the selected 
image to a file.

Save an image

(<image> window) | 
button Crops the current image.

Mari copies the cropped 
area as a separate 
image in the Image 
Manager. The cropped 
image is part of the 
project, but won't be 
saved as a separate 
image file unless you 
use the Save As option 
(see above).

Choose from the following 
crop modes:

Arbitrary — Click and drag 
on an arbitrary area of the 
image.

Fixed — Enter a fixed size 
for the crop box (in pixels) 
and drag it to the area you 
want to crop.

Aspect — Enter a fixed 
aspect ratio for the crop 
box (in pixels) and drag it 
over the area you want to 
crop.

Once you have selected 
the crop area, click the 
mouse button to crop.

Control Type What it does
Opens this 
dialog box Notes
Mari 2.0v1The Foundry
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What It Does

The History View palette displays a list of actions performed in the current session. Click an action to step 
back to that version of the project.



32  BRUSH EDITOR PALETTE

What It Does

The Brush Editor palette shows the settings for the current brush tip. It includes the following tabs:

• Properties — properties of the selected brush.

• Shelves — customized shelves of brushes.

• Presets — pre-set shelves of brushes.

• (Shelves and Presets tabs are the same as the Shelf Palette).

Brush Editor 
Palette Fields

Control Type What it does
Opens this 
dialog box Notes

Properties > General | Noise entry box, 
slider, reset

The amount of noise to 
add to the brush tip for 
each splat. This is a little 
bit of noise added to the 
splat itself, to soften the 
appearance and reduce 
banding. Lower values give 
a harder brush, higher val-
ues a softer brush.

Properties > General | Spacing entry box, 
slider, reset

The space between splats, 
as a proportion of the 
width of a splat. 1.00 = 
side-by-side (so if the tip 
is a circle, it would look 
like a string of beads.) .02 
= .02 x the width of a 
splat.

Range: 0.02 to 5.00

Reset: 0.02

Properties > Paint | Jitter Opacity Max entry box, 
slider, reset

How much to randomly 
vary the opacity (if Jitter 
Opacity is enabled).

1.00 = side by side 

Range: 0.00 to 1.00

Reset: 0.00

Properties > Paint | Jitter Opacity checkbox If enabled, picks random 
number to add to opacity.
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Brush Editor Palette Fields 
Properties > Paint | Opacity entry box, 
slider, reset

How dark a stroke can be 
(maximum alpha).

Range: 0.01 to 1.00

Reset: 1.00

Properties > Paint | Flow entry box, 
slider, reset

Mimics how quickly paint 
is applied, by setting the 
maximum opacity in a 
splat. 

Range: 0.01 to 1.00

Reset: 1.00

Properties > Position | Jitter Position Max entry box, 
slider, reset

How many pixels at most 
to randomly vary displace-
ment from the line of the 
brush stroke (if Jitter 
Position is enabled).

Range: 0 to 1000

Reset: 1000

Properties > Position | Jitter Position checkbox Whether to randomly vary 
displacement from the line 
of the brush stroke (to the 
degree specified in Jitter 
Position Max).

Properties > Pressure | Colors checkbox Whether more pressure 
causes the color to vary 
(from slightly darker to the 
target color).

Properties > Pressure | Radius checkbox Whether more pressure 
increases the radius.

Properties > Pressure | Flow checkbox Whether more pressure 
increases the flow.

Properties > Pressure | Alpha checkbox Whether more pressure 

increases the opacity.

Properties > Radius | Squish entry box, 
slider, reset

How much to flatten the 
radius. If the brush tip is a 
circle, 1.0 is a circle, .5 is 
an oval half as tall as it is 
wide.

Range: 0.05 to 1.00

Reset: 1.00

Properties > Radius | Jitter Radius entry box, 

slider, reset

Whether to randomly vary 
the radius (to the degree 
specified for the Radius 
and Inner Radius).

Properties > Radius | Inner Radius entry box, 
slider, reset

How few pixels the radius 

of a splat can be (if Jitter 

Radius and/or Radius 

Pressure are enabled). 

Range: 1 to 1200

Reset: 1

Control Type What it does
Opens this 
dialog box Notes
Mari 2.0v1The Foundry
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Brush Editor Palette Fields 
Properties > Radius | Radius entry box, 
slider, reset

How many pixels at most 
the radius of splat can be 
(if Jitter Radius and/or 
Radius Pressure are 
enabled).

Range: 1 to 1200

Reset: 100

Properties > Rotation | Align to Stroke checkbox Whether the brush tip 
rotates along with the 
direction you're painting. 
(With calligraphy, for 
example, the tip does not 
align.)

Properties > Rotation | Jitter Rotation Max entry box, 
slider, reset

How many degrees at 
most to randomly vary the 
rotation (if Jitter Rotation 
is enabled).

Range: 1 to 360

Reset: 360

Properties > Rotation | Jitter Rotation checkbox Whether to randomly vary 
the rotation.

Properties > Rotation | Rotation entry box, 
slider, reset

The degree to which the 
brush rotates to match the 
direction you're painting 
(if Align to Stroke is 
enabled).

Range: 0.00 to 360.00

Reset: 0.00

Properties > General | Type dropdown Whether to use a Bitmap 
image for the brush tip, or 
Render based on the qual-
ities specified in these 
properties 

Properties > General | Preview image An image of the brush tip, 
based on the selected 
properties.

Properties > Bitmap | Use Painting button Click to use the painting in 
the paint buffer as a brush 
tip. Mari prompts you to 
save it either as an .exr or 
a .tif file (which file format 
is used depends on the 
support in your graphics 
card). Note that .exr files 
are 16-bit — most other 
bitmaps are 8-bit.

Control Type What it does
Opens this 
dialog box Notes
Mari 2.0v1The Foundry
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Brush Editor Palette Fields 
Properties > Bitmap | Path entry box, 
button

Type the path or click 

 to select an existing 

bitmap to use as the brush 
tip.

To use an image as the 
brush tip, you need to set 
Type to Bitmap.

Properties > Geometry | Vertical Shear entry box, 
slider, reset

How much to distort the 
brush tip diagonally, top 
to bottom (as if pulling 
opposite corners up and 
down).

Range: -1.00 to 1.00

Reset: 0.00

Properties > Geometry | Horizontal Shear entry box, 
slider, reset

How much to distort the 
brush tip diagonally, right 
to left (as if pulling oppo-
site corners right and left).

Range: -1.00 to 1.00

Reset: 0.00

Properties > Geometry | Vertical Scale entry box, 
slider, reset

How much to distort the 
brush tip vertically.

Range: 0.00 to 2.00

Reset: 50

Properties > Geometry | Horizontal Scale entry box, 
slider, reset

How much to distort the 
brush tip horizontally.

Range: 0.00 to 2.00

Reset: 50

Properties > Noise | Octaves entry box, 
slider, reset

Number of applications of 
noise.

Range: 1 to 8

Reset: 4

Properties > Noise | Frequency entry box, 
slider, reset

How many spikes per 
octave.

Range: 0.00 to 100.00

Reset: 1.00

Properties > Noise | Scale entry box, 
slider, reset

How big the spikes are, as 
a proportion of the radius 
(1.00 = twice as big as the 
radius).

Range: 0.00 to 1.00

Reset: 0.00

Properties > Noise | Segments entry box, 
slider, reset

Lines making up the brush 
outline, to which noise is 
applied (4=square, 
360=circle).

Range: 4 to 360

Reset: 360

Properties > Profile | Profile curve editor How opaque or transpar-
ent the brush is at differ-
ent points.

Properties > Profile | Bit Depth dropdown The color depth of the 
brush tip.

Shelves tabs Select shelves, click to dis-
play more to the left or 
right.

Control Type What it does
Opens this 
dialog box Notes
Mari 2.0v1The Foundry
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Brush Editor Palette Fields 
Presets tabs Select shelves, click to dis-
play more to the left or 
right.

Scratch pad Provides a space to test 
the brush.

Control Type What it does
Opens this 
dialog box Notes
Mari 2.0v1The Foundry
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What It Does

The Play Controls palette allows you to play animations. You can set keyframes, which allows you to paint 
different textures in different parts of the animation sequence.

What It Looks 
Like

Play Controls 
Palette Fields

Control Type What it does
Opens this 
dialog box

Notes

Timeline timeline Shows where in the animation sequence 
you are currently viewing.

Keyframes appear as solid boxes in the 
timeline.

button Adds a keyframe at the current frame. 

button Removes the selected keyframe.

Frame range entry box The start and end frames of the animation.
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Play Controls Palette Fields 
entry box, 
dropdown

Sets the start and end frames of the ani-
mation to play. Use this if you want to 
play only a section of the animation. 

Select the play mode from the dropdown. 
One of:

• Loop — play the selected frames 
through, repeating again from the start 
when it finishes.

• Bounce — play the selected frames 
through from start to finish, then back-
wards from the finish to start, and then 
repeating. 

• Stop — play the animation once and 
then stop.

button Move back a single frame.

button Move back to the beginning of the anima-
tion.

button Play the animation.

button Stop playing.

button Move forward a single frame.

Control Type What it does
Opens this 
dialog box

Notes
Mari 2.0v1

The Foundry
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What It Does

The Python Console palette is divided into three sections:

• a Script Path entry box that loads Python scripts from a defined location

• an input pane that is used to enter and execute Python statements in the lower half of the palette

• an output pane that displays statements and their outputs in the upper half of the palette.

What It Looks 
Like
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Python Console Palette Fields 
Python Console 
Palette Fields

Control Type What it does Notes

Output Pane information Displays Python statements and their outputs.

Input Pane entry box Click inside to enter Python statements.

Script Path entry box Enter the filename and path where the console 
loads scripts from.

Evaluate button Executes Python script or statement.

Clear button Clears the input and output panes.
Mari 2.0v1The Foundry
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What It Does

The Pixel Analyzer displays information about pixels selected with the Color Picker/Pixel Analyzer tool.

Pixel Analyzer 
Palette Fields

Control Type What it does
Opens this 
dialog box Notes

Colors | Current swatch Displays the color of the pixel selected with the 
Color Picker/Pixel Analyzer tool.

Colors | Minimum swatch Displays the minimum color of the pixels that have 
been selected with the Color Picker/Pixel Analyzer 
tool (when Accumulate is enabled).

Colors | Average swatch Displays the average color of the pixels that have 
been selected with the Color Picker/Pixel Analyzer 
tool (when Accumulate is enabled).

Colors | Maximum swatch Displays the maximum color of the pixels that have 
been selected with the Color Picker/Pixel Analyzer 
tool (when Accumulate is enabled).

Accumulate | Enabled checkbox When selected, keeps data on all pixels selected 
(until Reset), and calculates Minimum, Average and 
Maximum colors.

Accumulate | Reset button Clears all accumulated pixel selections, to just the 
Current selection.

Values | Range dropdown Byte, Float, or Half.

Values | R, G, B, A information Values for Red, Green, Blue, and Alpha.

Values | H, S, V, L information Values for Hue, Saturation, Value, and Luminosity.

Values | X, Y E, I information Values for position of pixel on x and y axis, and the 
pixel Exposure and Intensity.
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What It Does

The Colors palette lets you view and change colors. The controls on this palette all work together — as 
you change the color through one control, the other controls update to show your change.

Colors Palette 
Fields

Control Type What it does Notes

Foreground/Background | Foreground swatch Shows the current foreground color. This is the color that Mari 
uses when you paint using the 
Paint tool. Clicking on this 
swatch opens the Select Color 
dialog box.

Foreground/Background | Background swatch Shows the current background color. Clicking on this swatch opens 
the Select Color dialog box.

Foreground/Background | 
button Swap foreground and background.

Foreground/Background | 
button Set colors to black (background) and white 

(foreground).

entry box, 
slider

Specify Red values. Range: 0.000 to 1.000

entry box, 
slider

Specify Green values. Range: 0.000 to 1.000

entry box, 
slider

Specify Blue values. Range: 0.000 to 1.000

entry box, 
slider

Specify Alpha values. Range: 0.000 to 1.000

entry box, 
slider

Specify Hue values. Range: 0.000 to 0.999
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Colors Palette Fields 
entry box, 
slider

Specify Saturation values. Range: 0.000 to 1.000

entry box, 
slider

Specify Value values. Range: 0.000 to 1.000

HSV tab: field, 
sliders, 
option 
buttons

Use this to pick colors from a Hue/Saturation/
Value field. 

To create custom color spec-
trums. Adjust the field values 
using the controls on the 
right, then click in the field to 
set the foreground color. 

Values tab: field Use this to set Byte (8 Bit), Half (16 Bit), or 
Float (32 Bit) color values.

Image tab: field Drag an image here from the Image Manager 
Palette to pick colors from an image. 

Click the image to select a 
foreground color.

You can also load an image by 
right-clicking and selecting 
Load Image, then choosing a 
file from the Load dialog box. 

To clear an image, right-click 
it and select Clear Image.

Grey tab: slid-
ers, but-
tons

Use this to pick a grey value from the gradi-
ent, or one of the presets. 

Swatches tab: 
swatches, 
buttons

Use this to pick from the Background and 
Foreground swatches. Click the buttons to 
swap foreground and background, and switch 
to black and white.

(same as swatches and but-
tons next to tabs)

Sliders tab: sliders Use this to pick colors by specifying RGB, 
alpha, and HSV values.

(same as sliders next to tabs)

Blend tab: 
swatches, 
field

Use this to show a field with four colors 
blending into each other.

Click on the box at each cor-
ner of the field to set the 
color for that corner. You can 
set each color individually, 
then click in the field to pick 
from the blend. 

Control Type What it does Notes
Mari 2.0v1The Foundry
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What It Does

The Tool Properties palette displays information about the selected tool.

Tool Properties 
Palette Fields

Tool Control Type What it does
Opens this 
dialog box Notes

Select > MriSelect > General | 
Facing

dropdown Sets whether the selection only 
applies to the Front of the model as 
you can see it, or if the selection 
goes Through the model and 
includes the other side.

Marquee Select Tool > 
MriMarqueeSelectTool > General | 
Crawling Ants

checkbox Controls whether the selection 
edges are animated. If on, the edges 
are animated. 

Marquee Select Tool > 
MriMarqueeSelectTool > General | 
Type

dropdown The shape of the selection drawn:

• Lasso — lets you draw a “free” 
selection of any shape.

• Rectangle — lets you draw a 
rectangular selection.

• Ellipse — lets you draw an oval 
selection. 

• MagicWand — lets you select by 
color. When you click, Mari cre-
ates a selection around the point 
you clicked. The selection is 
based on color – areas with a 
similar color to the original point 
are selected. You can change the 
color threshold for the selection.
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Tool Properties Palette Fields 
Marquee Select Tool > 
MriMarqueeSelectTool > General | 
Mode

dropdown How drawing a new selection 
affects the current marquee selec-
tion:

• Replace — the new selection 
replaces the existing selection.

• Transform — this lets you move 
you selection area around (move, 
rotate, or scale the selection). 

• Add — the new selection adds 
onto the existing selection.

• Subtract — the new selection 
removes areas of the existing 
selection. 

• Intersect — inverts the existing 
selection. That is, any areas that 
were selected become unselected, 
and any areas that were 
unselected become selected. 

Marquee Select Tool > 
MriMarqueeSelectTool > General | 
Invert Marquee Selection

button Inverts the current selection. 
Unselected areas become selected, 
and vice versa.

Marquee Select Tool > 
MriMarqueeSelectTool > General | 
Clear Marquee Selection

button Clears the current selection.

Marquee Select Tool > 
MriMarqueeSelectTool > General | 
Enabled

checkbox Turns the marquee selection on and 
off.

Marquee Select Tool > 
MriMarqueeSelectTool > General | 
Color Threshold

entry box, 
slider

Sets the color threshold for the 
marquee selection. Setting a lower 
value here results in a more accu-
rate color selection. Higher values 
catch more of the surrounding 
color.

Marquee Select Tool > 
MriMarqueeSelectTool > General | 
Amount

entry box, 
slider, 
reset

Sets how much the marquee selec-
tion prevents painting outside the 
selected area.

This works as a multiplier to the 
alpha of paint applied outside the 
selection:

• At 1, only the area inside the 
selection is paintable.

• At 0.5, paint outside the selec-
tion applies with an alpha of 0.5.

Tool Control Type What it does
Opens this 
dialog box Notes
Mari 2.0v1The Foundry
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Tool Properties Palette Fields 
Marquee Select Tool > 
MriMarqueeSelectTool > Selection 
Edge | Feathering

entry box, 
counter

Controls how sharp the edge of the 
selection area is. At 0, the selection 
has a completely sharp edge. As the 
value rises, the edges become 
softer.

Marquee Select Tool > 
MriMarqueeSelectTool > 
Transform | Reset Marquee Trans-
form

button Resets any transformations (moves, 
rotations, scales) applied to the 
marquee selection area. 

Marquee Select Tool > 
MriMarqueeSelectTool > 
Transform | Center

entry box Sets the center of the marquee 
selection.

Use the break link 
button to break the 
link between the two 
fields. 

Marquee Select Tool > 
MriMarqueeSelectTool > 
Transform | Rotation

entry box Sets the rotation, in degrees, of the 
marquee selection.

Marquee Select Tool > 
MriMarqueeSelectTool > 
Transform | Scale

entry box Sets the scale of the marquee 
selection.

1 is the original 
scale. 

Marquee Select Tool > 
MriMarqueeSelectTool > 
Transform | Translation

entry box Sets the translated position 
onscreen of the marquee selection.

No properties.

No properties.

No properties.

Tool Control Type What it does
Opens this 
dialog box Notes
Mari 2.0v1The Foundry
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Tool Properties Palette Fields 
Vector Inspector | MriVector 
InspectorTool

add attri-
bute

Click to add attributes. Add User 
Attribute

Vector Inspector > MriVectorIn-
spectorTool > General | Line Spac-
ing

entry box, 
slider

Adjusts the spacing between the 
directional markers.

Can also be done by 
Shift+dragging the 
mouse when the vec-
tor inspector is 
active.

Vector Inspector > MriVec-
torInpsectorTool > General | Line 
Length

entry box, 
slider

Adjust the length of the directional 
markers.

Vector Inspector > MriVectorIn-
spectorTool > General | Line Width

entry box, 
slider

Adjust the width (thickness) of the 
directional markers.

Vector Inspector > MriVectorIn-
spectorTool > General | Start 
color

swatch Change the color at the base of the 
directional markers.

Vector Inspector > MriVectorIn-
spectorTool > General | End color

swatch Change the color at the tip of the 
directional markers.

Vector Inspector > MriVectorIn-
spectorTool > General | Vector 
Space

dropdown Set whether the vector inspector 
operates in ScreenSpace, Tangent-
Space, or WorldSpace.

Vector Inspector > MriVectorIn-
spectorTool > General | Rotation

entry box, 
slider

Adjusts the rotation of the direc-
tional markers. This can be changed 
using the slider, or by entering a 
specific value.

Vector Inspector > MriVectorIn-
spectorTool > General | Transla-
tion

entry 
boxes

The exact location in XY space of 
the vector inspector. Entering val-
ues adjusts the position of the 
inspector too.

Blur > (Same as Paint.) add attri-
bute

Click to add attributes. Add User 
Attribute

No properties. add attri-
bute

Click to add attributes Add User 
Attribute

No properties. add attri-
bute

Click to add attributes. Add User 
Attribute

No properties. add attri-
bute

Click to add attributes. Add User 
Attribute

Tool Control Type What it does
Opens this 
dialog box Notes
Mari 2.0v1The Foundry
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Tool Properties Palette Fields 
Paint | Paint add attri-
bute

Click to add attributes Add User 
Attribute

Paint > Paint > General |
Description

informa-
tion

Paint > Paint > General |Name informa-
tion

Paint > Paint | Tip add attri-
bute

Brush tip details. This is a duplicate 
of the section from the Brush Editor 
Palette. 

Add User 
Attribute

Paint > Paint | Texture Brush texture details. This is a 
duplicate of the section from the 
Brush Editor Palette. 

Paint > Paint | Geometry Brush geometry details. This is a 
duplicate of the section from the 
Brush Editor Palette. 

Vector Paint | Vector Paint add attri-
bute

Click to add attributes. Add User 
Attributes

Vector Paint > Vector Paint > 
General | Description

informa-
tion

Vector Paint > Vector Paint > 
General | Name

informa-
tion

Vector Paint > Vector Paint | Tip add attri-
bute

Brush tip details. This is a duplicate 
of the section from the Brush Editor 
Palette.

Add User 
Attribute

Vector Paint > Vector Paint | Tex-
ture

add attri-
bute

Brush texture details. This is a 
duplicate of the section from the 
Brush Editor Palette.

Add User 
Attribute

Vector Paint > Vector Paint | 
Geometry

add attri-
bute

Brush geometry details. This is a 
duplicate of the section from the 
Brush Editor Palette.

Add User 
Attribute

Eraser > (Same as Paint) add attri-
bute

Click to add attributes. Add User 
Attributes

Tool Control Type What it does
Opens this 
dialog box Notes
Mari 2.0v1The Foundry



TOOL PROPERTIES PALETTE 163
Tool Properties Palette Fields 
Paint Through > Same as Paint 
except:

• Texture does not include 
Geometry. 

• And it includes the following: 

Texture > Image | Filename 
entry box, 
button

Texture > Info | Description informa-
tion

Texture > Info | Height informa-
tion

Texture > Info | Width informa-
tion

Texture > Preview | Preview Alpha entry box, 
slider

Range: 0.10 to 1.00

Texture > Preview | Image image

Texture > Transform | Image Scale two entry 
boxes

Enter values to scale the image on 
the x and y axes.

Texture > Transform | 
Image Scale

button Locks the current Image Scale val-
ues so that any changes to scale 
are applied proportionately to both 
axes.

Texture > Transform | Pan Lock checkbox Locks the image position relative to 
the model. If you pan the model, the 
image that you're painting through 
pans too.

Texture > Transform | Scale Lock checkbox Locks the image size relative to the 
model. If you zoom the model in or 
out, the image that you're painting 
through zooms in or out too.

Texture > Transform | Reset Size dropdown ToOriginalSize, RelativeToPaintBuf-
fer.

Texture > Transform | Auto Reset dropdown Reset, DoNotReset.

Texture > Gradient > Info | Width informa-
tion

Texture > Gradient > Preview | 
Preview Alpha

swatch The alpha value to use for the gra-
dient “floating” over the main can-
vas

Texture > Gradient > Preview | 
Image

image Preview version of the gradient

Tool Control Type What it does
Opens this 
dialog box Notes
Mari 2.0v1The Foundry
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Tool Properties Palette Fields 
Gradient > Same as Paint except:

• Texture does not include 
Geometry. 

• And it includes the following: 

Texture > Gradient > Gradient | 
Description

informa-
tion

Texture > Gradient > Gradient | 
Name

informa-
tion

Texture > Gradient > Gradient | 
Name

dropdown Selects between Linear or Radial 
gradient. 

Texture > Gradient > Gradient | 
Out Point

entry box, 
slider

How far through the gradient the 
final color reaches. 

0.00 to 1.00, higher 
values imply the end 
color is reached 
later. 

Texture > Gradient > Gradient | 
In Point

entry box, 
slider

How far through the gradient the 
start color lasts for (before it starts 
graduating into the end color).

0.00 to 1.00, higher 
values imply the start 
color finishes later.

Texture > Gradient > Gradient | 
End

swatch Final color for the gradient (color 
that the gradient ends up as).

Texture > Gradient > Gradient | 
Start

swatch First color for the gradient (color 
the gradient starts out as). 

Texture > Gradient > Info | Height informa-
tion

Clone Stamp > Same as Paint 
Through except it includes the 
following:

Texture > Debug | Relative checkbox

Texture > Debug | Debug View checkbox

Texture > Debug | Preview Alpha entry box, 
slider 

Range: 0.10 to 1.00

Texture > Image | Clone From two entry 
boxes 

Texture > Preview |
Onscreen Preview

checkbox

Tool Control Type What it does
Opens this 
dialog box Notes
Mari 2.0v1The Foundry
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Tool Properties Palette Fields 
Towbrush > MriTowbrush > 
General | Falloff

entry box, 
slider

Sets how sharply the texture blends 
in from the edges of the selected 
patch. Higher values have sharper 
transition to the surrounding tex-
ture, lower values blend more 
smoothly.

Towbrush > MriTowbrush > 
General | Value

entry box, 
slider

Controls how much of the color of 
the original patch to preserve. 
Higher values keep more of the 
original color, lower values blend 
the whole patch in with the back-
ground as you move it.

Eye Dropper > General | 
Sample Size

entry box, 
slider

Radius in pixels that the eyedropper 
uses when sampling colors off the 
surface of the model.

Range: 1 to 15

Eye Dropper > Graph | 
Grid Size

entry box, 
slider

The size of the grid overlay.

Eye Dropper > Graph | 
Grid

checkbox Enable the grid overlay. To see the grid over-
lay you must select a 
Type other than 
None.

Eye Dropper > Graph | 
Color

swatch The color of the grid overlay.

Eye Dropper > Graph | 
Type

dropdown The orientation of the Eye Dropper 
guide. When Both is selected, both 
axes of the guide are displayed.

Tool Control Type What it does
Opens this 
dialog box Notes
Mari 2.0v1The Foundry



38  PAINTING PALETTE

What It Does

The Painting palette displays information and controls for managing painting features.

Painting Palette 
Fields

Control Type What it does
Opens this 
dialog box Notes

Painter > Filtering | Image dropdown The image filtering to use when copying 
textures using the clone tools (Clone 
Stamp and Paint Through). One of: 

• Nearest — preserves edge detail, but 
gives quite "blocky" textures. 

• Bilinear — gives good results, but can 
produce square artifacts at extreme 
zoom. 

• Bicubic — provides more rounded 
results, slightly blurrier but without the 
square artifacts.

Painter > Source Grade | Enabled checkbox Enables source image grading.

Used this to grade your source image 
when cloning from or painting through an 
image.

Painter > Source Grade | Rgb entry box, 
slider

Changes the overall color saturation for 
all three color components of the source 
image. Moving this also moves the sepa-
rate Red, Green, and Blue sliders.

Painter > Source Grade | Red entry box, 
slider

Changes the color saturation in the Red 
component of the source image.

Painter > Source Grade | Green entry box, 
slider

Changes the color saturation in the Green 
component of the source image.

Painter > Source Grade | Blue entry box, 
slider

Changes the color saturation in the Blue 
component of the source image.

Painter > Source Grade | Contrast entry box, 
slider

Changes the contrast of the source image.
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Painting Palette Fields 
Painter > Source Grade | Saturation entry box, 
slider

Changes the color saturation of the 
source image. Used in addition to the RGB 
sliders.

Painter > Source Grade | Value curve editor Allows you to edit the color value curve 
for the source image.

Paint Buffer > Paint Buffer | Color Depth dropdown Color depth of the paint buffer. 8, 16, or 
32-bit color.

Paint Buffer > Paint Buffer | Buffer Size dropdown Onscreen resolution of the paint buffer. 
This controls the amount of detail you can 
use when painting, not the resolution of 
the patches in your project.

Paint Buffer > Paint Buffer | Clamp checkbox If this is checked, Mari restricts the range 
of the image to values between 0 and 1.

Paint Buffer > Transform | Translation entry boxes The amount that the buffer has been 
translated (moved onscreen) from the 
default.

Paint Buffer > Transform | Scale entry boxes The amount that the buffer has been 
scaled (resized) from the default.

Paint Buffer > Transform | Rotation entry box, 
slider

The amount that the buffer has been 
rotated from the default.

Paint Buffer > Transform | Reset button Resets the paint buffer to the default val-
ues, removing any translations or distor-
tions you have applied.

Paint Buffer > Transform | Reset on bake dropdown Either: 

• Enabled — the paint buffer automati-
cally resets to default settings every 
time you bake the paint.

• Disabled — any changes you have made 
to the paint buffer stay until you manu-
ally click the Reset button.

Control Type What it does
Opens this 
dialog box Notes
Mari 2.0v1The Foundry



39  PROJECTION PALETTE

What It Does

The Projection palette holds controls for how Mari projects the paint onto the model. This includes details 
of the various masks available (edge mask, channel mask, depth mask, ambient occlusion mask, backface 
mask and fractal noise mask).

Projection 
Palette Fields

Control Type What it does
Opens this 
dialog box Notes

Projection Settings > Masking | Masking 
Disabled

checkbox Disables all masking, regardless of 
channel, and overrides the Masking 
Enabled setting. 

When enabled, a 

 icon displays in 

the status bar.

Projection Settings > Masking | 
Mask Preview Color

swatch What color to display the masking 
on-screen.

Projection Settings > Masking | Mask Pre-
view Enabled

checkbox Shows the masking. Areas that are 
covered by the current defined 
mask(s) are shown colored. This 
includes all the masking currently in 
use – for example, if you have both 
the edge mask and depth mask 
turned on, Mari shows the effects 
of both simultaneously.

When enabled, a 

 icon displays in 

the status bar.

Projection Settings > Painting | 
Painting Mode

dropdown The blending mode used when the 
paint bakes down onto the channel 
surface. The default is Normal 
(paint in the buffer overwrites the 
surface), but Mari supports a num-
ber of other blending modes.

Projection Settings > Painting | Painting 
Opacity

entry box, 
slider, reset

How opaque the paint is. This is a 
multiplier on the paint buffer con-
tents. At 1.0, the paint bakes down 
to the surface with the same opac-
ity as it is in the buffer. At 0.5, the 
paint applied to the surface is half 
as transparent as when it's in the 
buffer.
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Projection Palette Fields 
Projection Settings > Projection | 
Projection Filter

dropdown The image filtering to use when cal-
culating how to apply the paint buf-
fer onto the surface. One of: 

• Nearest — preserves edge detail, 
but gives quite "blocky" textures. 

• Bilinear — gives good results, but 
can produce square artifacts at 
extreme zoom.

Projection Settings > Projection | 
Bake Behavior

dropdown One of: 

• Manual — you have to bake man-
ually. After a bake, the paint 
stays in the paint buffer until you 
manually clear it. 

• ClearOnly — you have to bake 
manually. After a bake, the paint 
buffer clears automatically. 

• AutoBakeAndClear — Mari bakes, 
and then clears the paint buffer, 
whenever you move the model.

Projection Settings > Projection | 
Projection

dropdown One of: 

• Front — paint only applies to the 
front of the model, as it is visible 
in the current view. 

• Through — paint applies to all 
surfaces on the model under your 
brush, whether or not there is 
something in front of them.

Projection Settings > Projection | 
Project On

dropdown Either: 

• All — you can paint on all areas 
on your model(s), selected or not. 

• SelectedOnly — you can only 
paint on the currently selected 
areas.

Projection Settings > Edge Mask toggle Whether the edge mask is turned on 
or not. If this is on, but Mask Pre-
view Enabled is off, the model is 
masked but you won't see the 
masking. That is, you can see the 
mask's effects, but not the mask 
itself.

When enabled, a 

 icon displays in 

the status bar.

Control Type What it does
Opens this 
dialog box Notes
Mari 2.0v1The Foundry
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Projection Palette Fields 
Projection Settings > Edge Mask > 
General | Falloff End

entry box, 
slider, reset

Controls where the edge mask ends 
on the model. The higher the value, 
the closer, more forward facing the 
mask finishes.

Range: 0.00 to 1.00 
Reset: 0.00

Projection Settings > Edge Mask > 
General | Falloff Start

entry box, 
slider, reset

Controls where the edge mask 
starts on the model. The higher the 
value, the more forward facing the 
masking starts. If this is higher than 
the Falloff End, areas facing the 
view are paintable, and areas 
oblique to the view are masked. If 
this is lower, facing areas are 
masked and oblique areas are 
paintable.

Range: 0.00 to 1.00 
Reset: 0.00

Projection Settings > Channel Mask toggle Whether the channel mask is turned 
on or not. If this is on, but Mask 
Preview Enabled is off, the model is 
masked but you won't see the 
masking. That is, you can see the 
mask's effects, but not the mask 
itself.

When enabled, a 

 icon displays 

in the status bar.

Projection Settings > Channel Mask > Gen-
eral | Mask Channel

dropdown Sets the channel holding the mask 
for the paint buffer. This mask sets 
the paintable area within the buffer.

Projection Settings > Channel Mask > Gen-
eral | Mask Amount

entry box, 
slider, reset

The amount that the mask affects 
the paint buffer. 1.0 means that the 
mask absolutely controls where you 
can paint; the effects of the mask 
decrease as the value gets lower.

Projection Settings > Channel Mask > Gen-
eral | Mask Contrast

entry box, 
slider, reset

The contrast applied to the original 
channel to derive the mask. At 1.0, 
the mask comes directly from the 
original channel. Lower values make 
the mask fuzzier than the input 
channel, higher values make it 
sharper than the input channel.

Control Type What it does
Opens this 
dialog box Notes
Mari 2.0v1The Foundry
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Projection Palette Fields 
Projection Settings > Channel Mask > Gen-
eral | Mask Curve

curve editor, 
reset

Sets how the channel masking 
works. 

The x axis is the color of the source 
pixel (black to the left, white to the 
right). The y axis is how paintable 
the target pixel is. By default, the 
curve runs from the bottom at the 
left up to the top at the right — so 
black pixels are totally masked, 
white pixels are totally paintable, 
and there's a constant curve 
between the two. Use this if you 
want to change which pixel values 
are masked.

Projection Settings > Channel Mask > Gen-
eral | Invert

check box Whether to invert the input from 
the mask. If this is selected, the 
mask data is black on white rather 
than white on black.

Projection Settings > 
Ambient Occlusion Mask

toggle Whether the ambient occlusion 
mask is turned on or not. If this is 
on, but Mask Preview Enabled is 
off, the model is masked but you 
won't see the masking. That is, you 
can see the mask's effects, but not 
the mask itself.

Before using this, 
you should calculate 
the ambient occlu-
sion for each object 
in the project 
(Objects menu, 
select Ambient 
Occlusion).

When ambient 
occlusion masking is 

enabled, a  icon 

displays in the sta-
tus bar.

Projection Settings > 
Ambient Occlusion Mask > General | Mask 
Amount

entry box, 
slider, reset

The amount of ambient occlusion 
masking to apply.

Projection Settings > 
Ambient Occlusion Mask > General | 
Mask Contrast

entry box, 
slider, reset

The contrast applied to the ambient 
occlusion to derive the mask. At 
1.0, the mask comes directly from 
the calculated ambient occlusion. 
Lower values make the mask fuzzier 
than the ambient occlusion, higher 
values make it sharper.

Control Type What it does
Opens this 
dialog box Notes
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Projection Palette Fields 
Projection Settings > 
Ambient Occlusion Mask > General | 
Mask Curve

curve editor, 
reset

Controls how the ambient occlusion 
pixel values relate to the degree of 
masking. The horizontal axis is the 
darkness of the occluded pixels 
(black to the left, white to the 
right), the vertical axis is the 
degree of visibility. By default, this 
is a direct line, where white pixels 
are totally masked, black pixels are 
totally unmasked, and 50% grey is 
50% masked.

Projection Settings > 
Ambient Occlusion Mask > General | 
Invert

checkbox If this is selected, the mask data is 
black on white rather than white on 
black.

Projection Settings > Depth Mask toggle Whether the depth mask is turned 
on or not.

When enabled, a 

 icon displays in 

the status bar.

Projection Settings > Depth Mask > Gen-
eral | Start

entry box, 
slider, reset

The depth in the scene for the 
depth masking to start.

Projection Settings > Depth Mask > Gen-
eral | End

entry box, 
slider, reset

The depth in the scene for the 
depth masking to finish.

Projection Settings > Depth Mask > Gen-
eral | Falloff

entry box, 
slider, reset

How fast the depth masking 
applies. Lower values make the 
mask apply slowly, higher values 
make it apply more quickly.

Projection Settings > Backface Mask toggle Whether the backface mask is 
turned on or not.

When enabled, a 

 icon displays in 

the status bar.

Projection Settings > Fractal Noise Mask toggle Whether the fractal noise mask is 
turned on or not.

When enabled, a 

 icon displays in 

the status bar.

Projection Settings > Fractal Noise Mask > 
General | Seed

entry box, 
slider, reset

Changes the pattern of the noise by 
moving the pattern through 3D 
space.

Projection Settings > Fractal Noise Mask > 
General | Contrast

entry box, 
slider, reset

Controls the level of contrast 
applied to the fractal noise features 
to derive the mask.

Projection Settings > Fractal Noise Mask > 
General | Roughness

entry box, 
slider, reset

Determines the roughness of the 
fractal noise features.

Projection Settings > Fractal Noise Mask > 
General | Size

entry box, 
slider, reset

Determines the size of the fractal 
noise features.

Control Type What it does
Opens this 
dialog box Notes
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Projection Palette Fields 
Projection Settings > Fractal Noise Mask > 
General | Mask Amount

entry box, 
slider, reset

The amount that the mask affects 
the paint buffer. 1.0 means that the 
mask absolutely controls where you 
can paint; the effects of the mask 
decrease as the value gets lower.

Projection Settings > Fractal Noise Mask > 
General | Mask Curve 

curve editor, 
reset

Controls how the fractal noise 
relates to the degree of masking, 
based on the above fields. This 
allows you to fine tune the contrast 
and pattern appearance of the frac-
tal noise mask.

Projection Settings > Fractal Noise Mask > 
General | Invert

checkbox If this is selected, the mask data is 
black on white rather than white on 
black.

Control Type What it does
Opens this 
dialog box Notes
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40  SHELF PALETTE

What It Does

The Shelf stores sets of brushes and colors. These include:

• Menu shelf — the content of the F9 menu.

• Personal shelf (with customized items) — selected items you use regularly.

• Basic Brushes shelf — a set of predefined basic brushes.

• Hard Surface Brushes shelf — a set of predefined hard surface brushes.

• Organic Brushes shelf — a set of predefined organic brushes.

• Project — shelf items for just the current project.

Shelf palette 
fields

Control What it does Notes

Types of Controls Select from shelves, click icons to add new 
shelf, spawn floating shelves, delete custom 
shelves.

Mari saves shelves as .msh files, and items within shelves 
(which you can save through a right-click option) as .msi 
files. 

Right-click to toggle icon size (for example, to use smaller 
icons to create color swatches).



41  HSV PALETTE

What It Does

The HSV palette is a cut-down version of the Colors palette, only containing the HSV color picker control.

HSV Palette 
Fields

Control Type What it does

HSV field, sliders, option buttons Use this to pick colors from a Hue/Saturation/Value field.
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What It Does

The Snapshots palette displays: 

• a list of snapshots for the entire project or currently selected channel

• buttons to take, revert, or delete channel snapshots

• information about snapshots, such as name, when they were created and by what user.

Snapshots 
Palette Fields

Control Type What it does
Opens this 
dialog box Notes

Channels > All button Displays a list of all snap-
shots in the project.

Channels > Current button Displays a list of snapshots 
for the currently selected 
channel.

Created info The date and time when the 
snapshot was taken.

Preview thumbnail A thumbnail preview of the 
snapshot.

Name info The name of the snapshot.

User info The name of the user that 
created the snapshot.

button Takes a new snapshot. 
Depending on whether 
Channels > All, or Channels 
> Current is selected, this 
button behaves differently. 
If All is selected, a snapshot 
is taken for all channels in a 
project. If Current is 
selected, a snapshot is only 
taken for the current chan-
nel.

Snapshot All 
Channels. 

Snapshot Chan-
nel.
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Snapshots Palette Fields 
button Loads the selected snapshot.

button Deletes the selected snap-
shot.

Delete Snapshot

Control Type What it does
Opens this 
dialog box Notes
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What It Does

The New Project dialog box lets you select geometries and various options for a new Mari project. Use the 
Path control to select an .obj or .ptx file you want to use in the project.

Resize the dialog box to display long filenames or select multiple files to display more than one geometry, 
if they are of the same file type. Mari checks the model for any errors that might prevent it from 
processing, for example whether UVs overlap or touch border edges. A “Mesh Sanity Check” dialog 
displays any warnings or errors. (Errors cancel opening the model, but you can continue with warnings.) 

Depending on the size and complexity of textures, it can take several minutes the first time you load them 
into a Mari project. Once saved, however, the project should open quickly in future.

How to Access It

• Menubar | File > New

• Keyboard | Ctrl+N 

• Projects tab | New button

• Projects tab | Right-click > New

• Toolbar | 
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New Project Dialog Box Fields 
New Project 
Dialog Box Fields

Control Type What it does
Opens this 
dialog box Notes

Name entry box For you to identify it only (this is not 
a filename).

Geometry | Path entry box, 
dropdown, 
button

Opens .obj/.ptx files. Dropdown 
lists last 10 opened.

Pick Mesh Select by either typing the Path, 
selecting from the dropdown of the 
last 10 files selected, or clicking the 
icon to browse to a file. 

If you select to open an animated .obj 
file, the Mesh Options tab displays.

Geometry | Mesh Options > 
Mapping Scheme

dropdown If there is a UV map available, 
and you would like to use it, 
select UV if available, Ptex oth-
erwise. If you prefer to use 
Ptex, select Force Ptex. This 
option loads the selected geom-
etry and replaces the existing 
UV map with a Ptex map.

Geometry | Mesh Options > 
Selection Sets

dropdown Selection sets have two options, 
to either:

• Create From Face Groups -
this is the default behavior 
and allows the use of selec-
tion sets in Mari.

• Don’t Create - if you choose 
not to create a selection set, 
Mari does not create any from 
the file.

Geometry | Mesh Options > 
Multiple Geometries Per 
Object

dropdown If your .obj consists of multiple 
geometries, you have the option 
to Merge Geometries Into One, 
which is the default behavior, or 
Create Separate Geometries 
(Ptex Only). If you choose to 
Merge Geometries Into One, 
Mari combines the individual 
geometries into a single geome-
try, while choosing Create Sepa-
rate Geometries (Ptex Only) 
creates individual geometries.

Even if you choose to Create Separate 
Geometries (Ptex Only), Mari only dis-
plays a single geometry on the can-
vas. However, when you export a 
channel you have the option to export 
individual .ptx files for each geometry.
Mari 2.0v1The Foundry
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New Project Dialog Box Fields 
Ptex: Geometry | Mesh 
Options > Process each 
geometry file as a

dropdown For Ptex files, there are two 
choices for the geometry mesh 
options: 

• Separate Object - creates 
only one object with one 
geometry.

• Separate Geometry In One 
Object - creates only one 
object, but has multiple 
geometries within it.

The option to Separate Geometry In 
One Object is essentially the inverse 
of the Ptex channel export process, 
and allows project reconstruction.

Texture | Root Path dropdown Displays the root path for the 
project. This is where Mari looks 
for any existing textures to 
import as it creates the chan-
nels.

Choose 
Base Path

This is the value that Mari substitutes 
for $PATH in the import templates in 
the bottom list.

Texture | Scan button Scans the Root Path for any 
existing texture files.

After scanning the Root Path, you 
should always set the Size of the tex-
ture files manually. The default values 
Mari sets may not be correct as chan-
nels can contain many different patch 
sizes.

Texture | Prefix entry box Filename prefix for existing tex-
ture files, if applicable.

Texture | Create checkbox Select this to create the listed 
channel.

Texture | Import checkbox Select this to import existing 
textures into the channel after 
creating it.

Texture | Name information Name of the channel to create. 
Mari sets a default value, but 
you can change this.

For example, color, specRough, disp-
Fine, dispBroad, colorDetail, colorDe-
tailMask.

Texture | Size dropdown Patch size for the new channel. 
Mari sets a default value, but 
you can change this.

256x256, 512x512, 1024x1024, 
2048x2048, 4096x4096, 
8192x8192, 16384x16384, 
32768x32768

Texture | Type dropdown Channel type. Mari sets a 
default value, but you can 
change this.

Color or Scalar

texture | File Space dropdown The file space used when gener-
ating vectors. Mari sets a 
default but you can change this.

Normal or Vector.

Control Type What it does
Opens this 
dialog box Notes
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New Project Dialog Box Fields 
Texture | Fill swatch Color to fill the new channel. 
Mari sets a default value, but 
you can change this.

Click the swatch to change the color.

Texture | Depth dropdown The color depth size. Mari sets a 
default value, but you can 
change this.

8bit (Byte), 16bit (Half), or 32bit 
(Float).

Texture | Files entry The filename template used to 
pick existing textures to import 
into the channel. Mari sets a 
default value, but you can 
change this, or you can use the 
button to open a dialog allowing 
you to manually pick the files.

Texture | 
button Opens a dialog box allowing you 

to pick the textures for Mari to 
import into the new channel.

Import Dia-
log Box

Texture | 
image Indicates that Mari has not 

found any textures to import.
If there are textures to import, Mari 
displays the number of patches avail-
able.

Mesh Options > Start Frame 
and End Frame

entry box Set the frame range from the 
source file to import.

Mesh Options > Single Frame button Sets the other fields to only 
import the first frame from the 
animation in the object file.

Mesh Options > All Frames button Sets the other fields to import 
the entire animation from the 
object file.

Control Type What it does
Opens this 
dialog box Notes
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44  SELECT COLOR DIALOG BOX

What It Does

The Select Color dialog box lets you view and change colors. The controls on this palette all work together 
— as you change the color through one control, the other controls update to show your change.

How to Access It

• Tools toolbar | Foreground color swatch

• Tools toolbar | Background color swatch

• Colors palette | Foreground color swatch

• Colors palette | Background color swatch

• Add Channel dialog | Color color swatch

• HSV palette | Color swatch

Select Color 
dialog box fields

Control Type What it does Notes

swatch Displays currently selected color.

entry box, 
slider

Specify Red values. Range: 0.000 to 1.000

entry box, 
slider

Specify Green values. Range: 0.000 to 1.000

entry box, 
slider

Specify Blue values. Range: 0.000 to 1.000

entry box, 
slider

Specify Alpha values. Range: 0.000 to 1.000



SELECT COLOR DIALOG BOX 183
Select Color dialog box fields 
entry box, 
slider

Specify Hue values. Range: 0.000 to 0.999

entry box, 
slider

Specify Saturation values. Range: 0.000 to 1.000

entry box, 
slider

Specify Value values. Range: 0.000 to 1.000

History Swatches swatch These swatches store the 5 most recently 
selected colors. When a new color is selected, 
it is added to the top of the list. Clicking on a 
swatch selects it as the current color.

You can drag and drop from 
the current swatch to the his-
tory swatches to manually 
arrange the colors.

HSV tab: field, 
sliders, 
option 
buttons

Use this to pick colors from a Hue/Saturation/
Value field. 

To create custom color spec-
trums. Adjust the field values 
using the controls on the 
right, then click in the field to 
set the foreground color. 

Values tab: field Use the fields to manually enter RGBA and 
HSV values for either Byte (8 Bit), Half (16 
bit), or Float (32 Bit) categories.

This sets the default values 
for RGBA and HSV colors 
when creating either 8 bit, 16 
bit, or 32 bit channels.

Grey tab: slid-
ers, but-
tons

Use this to pick a grey value from the gradi-
ent, or one of the presets. 

button Pick a color from within Mari, as well as from 
your desktop or other windows

Canvas dropdown The type of pixels you want the color picker 
to choose from. Either Pick screen Pixels or 
Pick raw pixels.

Control Type What it does Notes
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45  ADD CHANNEL DIALOG BOX

What It Does

This allows you to add a single channel to your project. The dropdown at the top of the dialog box lets you 
select from recently created channels. If you select a channel from the dropdown, Mari updates the rest of 
the fields with the details you used last time. You can change any of the values if required.

How to Access It

• Menubar | Channel > Add Channel

• Right-click | in Channels Palette > Add Channel

• Button | Channels Palette > 

• Button | Shaders Palette > 

Add Channel 
Dialog Box Fields

Control Type What it does
Opens this 
dialog box Notes

<Previous channel 
names>

dropdown This holds the names of recently created channels. 
Select a channel from the list, and the rest of the dialog 
box updates with the details from the last time the 
channel was created.

Name information, 
dropdown

Name of the channel to create.

Size dropdown Patch size for the new channel. Either 256x256, 
512x512, 1024x1024, 2048x2048, 4096x4096, 
8192x8192, 16384x16384, or 32768x32768.

Depth dropdown Color depth for the new channel.Either 8bit (Byte), 16bit 
(Half), or 32-bit (Float).

ColorSpace dropdown The type of channel. Either Color or Scalar. Scalar channels do 
not use color cor-
rection.



ADD CHANNEL DIALOG BOX 185
Add Channel Dialog Box Fields 
File Space dropdown The type of file space used for vector painting. Either 
Normal or Vector.

Color swatch Color to fill the new channel. Click the swatch to change 
the color.

Select Color 
Dialog Box

Control Type What it does
Opens this 
dialog box Notes
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46  ADD MULTIPLE CHANNELS DIALOG BOX

What It Does

Adds multiple channels at once. Mari takes the channels available from predefined sets of standard 
channels for types of assets — for example, the channels required to paint a vehicle. You can select which 
channels from the set to create.

Also, if there are existing textures for the channels, Mari can automatically load these in as it creates the 
channels. Mari automatically detects existing textures that conform to the selected naming convention. 
You can write config files that add new sets of channels to the Category field. See the Extending Mari 
chapter in the Mari User Guide for details.

How to Access It

• Menubar | Channel > Channel Presets

• Right-click | channel in Channels Palette > ChannelPresets

• Button | Channels Palette > 

Add Multiple 
Channels Dialog 
Box Fields

Control Type What it does
Opens this 
dialog box Notes

Root Path dropdown Displays the root path for the project. This is 
where Mari looks for any existing textures to 
import as it creates the channels.

Choose Base 
Path

This is the value that Mari substitutes 
for $PATH in the import templates in 
the bottom list.

Scan button Scans the Root Path for any existing texture 
files.

Import dropdown Whether to import all patches in the project 
or only the selected ones. This applies to 
every channel being imported during the cre-
ation.
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Add Multiple Channels Dialog Box Fields 
Resize dropdown How Mari handles patch/image size mis-
matches (for example, attempting to import a 
1024x1024 image to a 2048x2048 patch). 
You can select either to resize the images to 
match the patches, or to resize the patches 
to match the images.

Prefix entry box Filename prefix for existing texture files, if 
applicable.

Create checkbox Select this to create the listed channel.

Import checkbox Select this to import existing textures into 
the channel after creating it.

Name information Name of the channel to create. For example, color, specRough, disp-
Fine, dispBroad, colorDetail, colorDe-
tailMask.

Size dropdown Patch size for the new channel. Mari sets a 
default value, but you can change this.

Type dropdown Channel type. Either Color or Scalar. Mari sets 
a default value, but you can change this.

Fill swatch Color to fill the new channel. Mari sets a 
default value, but you can change this.

Click on the swatch to set the color.

Files entry The filename template used to pick existing 
textures to import into the channel. Mari sets 
a default value, but you can change this, or 
you can use the button to open a dialog 
allowing you to manually pick the files.

button Opens a dialog box allowing you to pick the 
textures for Mari to import into the new 
channel.

Import 
Channel

image Indicates that Mari has not found any tex-
tures to import.

If there are textures to import, Mari 
displays the number of patches avail-
able.

Control Type What it does
Opens this 
dialog box Notes
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47  CHANNEL PRESETS DIALOG BOX

What It Does

Allows you to set up preferences for quickly creating channels through the Channels palette or menu. 
These presets include options such as the color depth size, patch size, file space, and color space. This 
gives you the opportunity to quickly set up a channel template for channel types you know are going to be 
created numerous times.

How to Access It

• Menubar | Channels > Channel Presets

• Right-click | in Channels Palette > Channel Presets

Channel Preset 
Dialog Box Fields

Control Type What it does
Opens this 
dialog box Notes

Root Path entry box, 
dropdown, 
button

Specify the file path for the creation of new channel 
templates.

The browse and 
scan buttons also 
allow you to search 
for the file location.

Import dropdown Select which patches to import if a channel is being 
imported for the creation of the template. Options are: 
All Patches.

Resize dropdown Select which files should be resized when patches are 
being imported for channel template creation. Options 
are: Patches to fit images or Images to fit patches.

Prefix entry box Specify a prefix for organizing created channels.

Create checkbox Select which channel templates you want to create from 
the list in the dialog.

Import checkbox Select which channel templates you want to create from 
imported channels. Import settings were chosen from 
the earlier option in the dialog.
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Channel Preset Dialog Box Fields 
Name information Name of the channel type; for instance, color, displace-
ment, or specular.

Size dropdown Select a patch size for the channels from the options: 
256x256, 512x512, 1024x1024, 2048x2048, 
4096x4096, 8192x8192, 16384x16384, 
32768x32768.

Channels can be 
resized later from 
the Channels menu 
or palette if neces-
sary.

Type dropdown Select a color space for the created channel template. 
Options are: Color or Scalar.

File Space dropdown Select a file space for the created channel template. 
Options are: Normal and Vector.

Fill swatch Select a color to use for the background of channel tem-
plate.

Select Color 
Dialog Box

Depth dropdown Select a color depth size for the created channel tem-
plate. Options are: 8bit (Byte), 16bit (Half), 32bit 
(Float).

The color depth 
size for channels 
can be resized later 
from the Channels 
menu or palette if 
necessary.

Files entry box Specify a file location to be imported.

button Select a file to import for the channel template. This 
corresponds to the File entry box above.

icon

Control Type What it does
Opens this 
dialog box Notes
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48  CONVERT TYPE DIALOG BOX

What It Does

Converts the color depth of the selected channel into a different bit depth. The color depth determines the 
number of pixels per RGB channel. Existing channels set to another color depth can be converted by simply 
selecting them and opening the Convert Type dialog box.

How to Access It

• Menubar | Channels > Convert Channel

• Right-click | in Channels Palette > Convert Channel

• Button | in Channels Palette > 

Convert Type 
Dialog Box Fields

Control Type What it does
Opens this 
dialog box Notes

Type dropdown The color depth options for converting the selected 
channel. Depth sizes are: 8bit (Byte), 16bit (Half), and 
32bit (Float).

Note that you 
should only see two 
options in the 
dropdown menu, as 
it does not show 
the current depth 
size of your chan-
nel.



49  COPY MULTIPLE TEXTURES DIALOG BOX

What It Does

Lets you copy the textures from one layer to another. If you have multiple objects in your project, you can 
copy the textures between objects.

How to Access It

Menubar | Patches > Copy Textures

Copy Multiple 
Textures Dialog 
Box Fields

Control Type What it does
Opens this 
dialog box Notes

Source Object dropdown Select the object holding the source layer.

Source Layer dropdown The layer to copy the patches from.

Select By dropdown Select how to identify the patches on the source layer.

Source Range entry box The patch numbers of the patches to copy textures from. 
Enter the patch numbers. You can separate patch numbers 
with commas, or enter ranges. 

For example: 1001,1003,1005-1008

Target Object dropdown The object to copy the patches onto.

Target Layer dropdown The layer to copy the patches onto. If required, this can be 
the same as the source layer.

Offset entry box A numeric offset for the patch numbers. 

For example, if this is set to 100, the source patch 1001 is 
copied to 1101. Use this to copy textures between sides of 
symmetrical models.

The default for the 
Offset is zero.



50  EXPORT DIALOG BOX

What It Does

Invoked by the export channel functions, export flattened channel functions, export layer functions, or 
export flattened layers functions, the Export dialog box lets you specify options for exporting channels or 
layers from the current Mari project, in either flattened or non-flattened states.

If you export with Small Textures set to Enabled then any patches that are entirely filled with one color 
(such as gray, before anything else has been painted on the patch,) are exported as small 8x8 images to 
save space. Mari supports loading these 8x8 images when importing. These images are scaled up to fill the 
entire patch.

How to Access It

• Menubar | Channels > Export > any of the dropdown options

• Menubar | Channels > Export Flattened > any of the dropdown options

• Menubar | Layers > Export > any of the dropdown options

• Menubar | Layers > Export Flattened > any of the dropdown options

• Right-click | in Channels Palette > Export > any of the dropdown options

• Right-click | in Channels Palette > Export Flattened > any of the dropdown options

• Right-click | in Layers Palette > Export > any of the dropdown options

• Right-click | in Layers Palette > Export Flattened > any of the dropdown options

Export dialog 
box fields

Control Type What it does
Opens this 
dialog box Notes

Named Files

U information Lists the U texture coordinate for the left edge of 
the patch.

V information Lists the V texture coordinate for the bottom edge 
of the patch.
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Export dialog box fields 
UDIM information Lists the UDIM number for the patch.

File entry box Specify the file location to export to.

button Browse to the file location you want to export the 
texture to.

Small Textures dropdown With this option enabled, Mari exports any patches 
filled with a constant color as 8x8 pixel textures, 
no matter what resolution the patches are in Mari.

• Enabling Small Textures saves disk space if 
you're exporting a channel that hasn't been fully 
painted.

• Disabling Small Textures lets Mari always export 
patches at their full size (even if they haven't 
been painted).

Enabling Small Textures 
saves disk space if you're 
exporting a channel that 
hasn't been fully painted. 
Disable Small Textures if 
you want Mari to always 
export patches at their 
full size (even if they 
haven't been painted).

Alpha Channels dropdown Choose whether to Keep or Remove alpha channels 
when exporting textures. This can help decrease 
the resulting file size when exporting images that 
don’t need alpha channels.

Sequence

Layer information The name of the object, channel, and layer being 
exported.

Path entry box, 
dropdown

The directory to export the files to. Type the direc-
tory, select a recent directory from the dropdown, 
or use the navigation controls below.

button Resets the path to the default location.

button Goes back to the previous directory.

button Goes forward to the next directory that you have 
browsed.

Only available if you 
have already browsed 
back via the back button.

button Goes up one level in the directory hierarchy.

button Creates a new folder in the current directory.

button Displays the contents of the directory as icons and 
names only.

button Displays the contents of the directory as a details 
view, with a sort option at the top of the listing.

Control Type What it does
Opens this 
dialog box Notes
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Export dialog box fields 
Filter entry box, 
dropdown

Lets you filter the image sequences displayed in 
the dialog box. As you enter the filter text, Mari 
updates the display to only show the image 
sequences that match your text.

Full Image Indicates whether the selected image sequence has 
a full set of images for the current model. That is, 
for each patch on the model, there is a correspond-
ing image in the image sequence. Green if a full set 
of images is present, otherwise the number found 
vs number required (for example, 4/5) displays.

Images information Lists the image sequences found in the selected 
Path.

Start information First UDIM number in the selected image sequence.

End information Last UDIM number in the selected image sequence.

Patch Count information Number of image patches in the image sequence.

Frames Information How many frames in the image sequence.

Modified information Last modified date for the images in the sequence.

Template entry box, 
dropdown

Sets the Template for Mari to use when gathering 
the names of images in the selected sequence. 
Variables available are: 

$ENTITY — the name of the object

$CHANNEL — the name of the channel

$LAYER — the name of the layer

$UDIM — the UDIM patch value

$FRAME — the animation frame number

$NUMBER — number of the file within the batch 
(for example, “$NUMBER of $COUNT” gives strings 
like “22 of 28”)

$COUNT — total number of files in the channel

$[METADATA VALUE] — any user-defined variables 
(for example, if a patch has a user attribute called 
“PROJECT”, with a value of “Project1”, Mari 
replaces the variable “$PROJECT” with “Project1”).

Don't use numbers in 
your texture name — if 
you do, the Import and 
Export dialog boxes 
won't recognize the 
sequence.

File Example information Displays an example of the selected template path 
and filename.

Formats Information Displays a list of supported export file formats.

Use Template For dropdown Specifies whether the template should be used for 
Only this layer or Everything that is being 
exported.

Control Type What it does
Opens this 
dialog box Notes
Mari 2.0v1The Foundry
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Export dialog box fields 
Small Textures dropdown With this option Enabled, Mari exports any patches 
not yet painted on as 8x8 pixel textures (in the 
background color), no matter what resolution the 
patches are in Mari.

Enabling Small Textures 
saves disk space if you're 
exporting a channel that 
hasn't been fully painted. 
Disable Small Textures if 
you want Mari to always 
export patches at their 
full size (even if they 
haven't been painted).

Alpha Channels dropdown Choose whether to Keep or Remove alpha channels 
when exporting textures. This can help decrease 
the resulting file size when exporting images that 
don’t need alpha channels.

Export All Patches button Exports images from all patches in the project.

Cancel button Cancels the export and closes the dialog box.

Control Type What it does
Opens this 
dialog box Notes
Mari 2.0v1The Foundry
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What It Does

Invoked by the import channel functions and import layer functions, the Import dialog box lets you specify 
options for importing channels or layers. This can be done by importing textures into existing layer stacks, 
layers, or as new channels, however, importing textures as a new channel only opens the Import dialog 
box after first selecting options for the new channel from the Add Channel Dialog Box.

How to Access It

• Menubar | Channels > Import > any of the dropdown options

• Menubar | Layers > Import > any of the dropdown options

• Right-click | Channels Palette > Import > any of the dropdown options

• Right-click | Layers Palette > Import > any of the dropdown options

Import Channel 
Dialog Box Fields

Control Type What it does
Opens this 
dialog box

Notes

Named Files

U information Lists the U texture coordinate for the left edge of 
the patch.

V information Lists the V texture coordinate for the bottom 
edge of the patch.

UDIM information Lists the UDIM number for the patch.

File entry box Specify the file location to import from.

button Browse to the file location you want to export the 
texture to.
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Import Channel Dialog Box Fields 
Sequence

Channel/Layer information The name of the channel or layer that is being 
imported.

This name is only dis-
played if a name has 
been assigned to the 
selected layer.

Path entry box, 
dropdown

The directory holding the files to import. Type the 
directory, select a recent directory from the drop-
down, or use the navigation controls below.

Make sure you check the 
path and name care-
fully, especially if you 
have been swapping 
between assets — Mari 
defaults to the last place 
you imported from. 
Don't risk overwriting 
your textures!

button Resets the path to the default location.

button Goes back to the previous directory.

button Goes forward to the next directory that you have 
browsed.

Only available if you 
have already browsed 
back using the back but-
ton.

button Goes up one level in the directory hierarchy.

button Creates a new folder in the current directory.

button Displays the contents of the directory as icons 
and names only.

button Displays the contents of the directory as a details 
view, with a sort option at the top of the listing.

Filter entry box, 
dropdown

Lets you filter the image sequences displayed in 
the dialog box. As you enter the filter text, Mari 
updates the display to only show the image 
sequences that match your text.

Control Type What it does
Opens this 
dialog box

Notes
Mari 2.0v1

The Foundry
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Import Channel Dialog Box Fields 
Full Image Indicates whether the selected image sequence 
has a full set of images for the current model. 
That is, for each patch on the model, there is a 
corresponding image in the image sequence. 
Green if the selected image sequence has a full 
set of images for the current model, yellow if the 
selected image sequence has a partial set of 
images for the current model, or red if the 
selected image sequence has no images for the 
current model.

Images information Lists the image sequences found in the selected 
Path.

Start information First UDIM number in the selected image 
sequence.

End information Last UDIM number in the selected image 
sequence.

Patch Count information Number of image patches in the image sequence.

Frames information How many frames in the image sequence.

Modified information Last modified date for the images in the 
sequence.

Template entry box, 
dropdown

Specify or select a preset format for automati-
cally naming and numbering files on import. Vari-
ables available are: 

$ENTITY — the name of the object

$LAYER — the name of the layer

$CHANNEL — the name of the channel

$UDIM — the UDIM patch value

$FRAME — the animation frame number

$NUMBER — number of the file within the batch 
(for example, “$NUMBER of $COUNT” gives 
strings like “22 of 28”)

$COUNT — total number of files in the channel

$[METADATA VALUE] — any user-defined vari-
ables (for example, if a patch has a user attribute 
called “PROJECT”, with a value of “Project1”, Mari 
replaces the variable “$PROJECT” with “Project1”).

Don't use numbers in 
your texture name — if 
you do, the Import and 
Export dialog boxes 
won't recognize the 
sequence.

File Example information Displays an example of the selected template 
path and filename.

Formats Information Displays a list of supported import file formats.

Import All Patches button Imports textures onto all patches in the project.

Control Type What it does
Opens this 
dialog box

Notes
Mari 2.0v1

The Foundry
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Import Channel Dialog Box Fields 
Import Selected 
Patches

button Appears instead of Import All Patches when at 
least one patch is selected.

Cancel button Closes the dialog box without importing.

Control Type What it does
Opens this 
dialog box

Notes
Mari 2.0v1

The Foundry
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What It Does

The Mari To Maya Export dialog box lets you specify the file type and destination for exporting a channel 
from the current Mari project to a Maya .ma file. Exported textures are saved to a user-selected directory 
and the created .ma file is set up to reference those texture files. The .ma file is created with the correct 
UDIM offsets for the textures so that Maya can import and apply them to the model correctly.

How to Access It

• Menubar | Python > Examples > Export for Maya.

Mari to Maya 
Export Dialog 
Box Fields

Control Type What it does
Opens this 
dialog box Notes

Output Folder entry box Displays the selected filepath for the exported 
files. You can also manually type in the file loca-
tion.

Browse button Allows you to select the file location for the 
exported files from the Select Directory for Export 
dialog.

Select 
Directory 
for Export 
dialog box.

Channels list Displays the channel(s) for the currently selected 
object.

Multiple channels can be 
selected at once.

+ button Adds the selected channel(s) and destination direc-
tory to the For Export pane.

- button Removes the selected channel(s) and destination 
directory from the For Export pane.

For Export information Displays the channel(s) to be exported.
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Mari to Maya Export Dialog Box Fields 
8-bit Files dropdown Selects the bit depth of the exported images. Available formats: bmp, jpg, 
jpeg, png, ppm, psd, tga, tif, 
tiff, xbm, and xpm.

16/32-bit Files dropdown Selects the bit depth of the exported images. Available formats: exr, psd, tif, 
and tiff.

Force Over-
write

checkbox Forces Mari to overwrite previously exported files 
to the same location, effectively replacing them.

OK button Accepts the current channel export selections and 
exports them to the designated file location.

Mari > 
Maya Prog-
ress dialog 
box.

Cancel button Cancels the current channel export selections and 
closes the Mari To Maya Export dialog box.

Control Type What it does
Opens this 
dialog box Notes
Mari 2.0v1The Foundry
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What It Does

Specify what lighting shader you want to set up for your project. This does not affect your Flat, Basic, or 
Full lighting options, but instead impacts how the texture on your model looks under the lighting and 
shader components you’ve chosen.

How to Access It

• Menubar | Shading > Add SurfaceShader

• Button | in Shaders Palette >  > Choose Diffuse/Specular

New Shader 
Dialog Box Fields

Control Type What it does
Opens this 
dialog box Notes

Diffuse

Diffuse | Lighting/Dif-
fuse/Lambertian

dropdown Sets the Diffuse component of the shader to Lamber-
tian.

Diffuse | Lighting/Dif-
fuse/Minnaert

dropdown Sets the Diffuse component of the shader to Minnaert.

Specular

Specular | Lighting/
Specular/Phong

dropdown Sets the Specular component of the shader to Phong. By default, the 
Phong shader in the 
Add New Shader 
dropdown menu is 
Lambertian/Phong.
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New Shader Dialog Box Fields 
Specular | Lighting/
Specular/Cook Tor-
rance

dropdown Sets the Specular component of the shader to Cook 
Torrance.

By default, the 
Cook Torrance 
shader in the Add 
New Shader drop-
down menu is Lam-
bertian/Cook 
Torrance.

Specular | Lighting/
Specular/Beckman

dropdown Sets the Specular component of the shader to Beck-
man.

By default, the 
Beckman shader in 
the Add New 
Shader dropdown 
menu is Lamber-
tian/Beckman.

Specular | Lighting/
Specular/Blinn

dropdown Sets the Specular component of the shader to Blinn. By default, the 
Blinn shader in the 
Add New Shader 
dropdown menu is 
Lambertian/Blinn.

Control Type What it does
Opens this 
dialog box Notes
Mari 2.0v1The Foundry
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What It Does

The Create Shader dialog box allows you to create shaders that are not listed in the Shading menu or 
Shaders palette. These shaders are primarily those that do not use Lambertian diffuse shading. However, 
options for Lambertian diffuse shading are still included in the Create Shader dialog, so you can customize 
your shaders however you want.

How to Access It

• Menubar | Shading > Add New Shader > Choose Diffuse and Specular

• Right-click | Shaders Palette > Choose Diffuse and Specular

• Shaders Palette |  > Choose Diffuse and Specular

Create Shader 
dialog box fields

Control Type What it does
Opens this 
dialog box Notes

Diffuse dropdown Select either Lambertian or Minnaert for Lighting/
Diffuse options. Choosing either option does not 
limit the options you can choose in the Specular 
dropdown menu.

Selecting Lambertian and a 
Specular options gives you the 
same result as the named 
options for Add New Shader on 
the menubar.

Specular dropdown Select Phong, Cook-Torrance, Beckman, or Blinn for 
the Lighting/Specular options.
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What It Does

Creates a new channel based on the selected mask channel and source texture, with the alpha values on 
the new channel set by the original mask.

How to Access It

• Menubar | Channel > Mask to Alpha

• Right-click | Channel in Channels Palette > Mask to Alpha

Mask Channel to 
Alpha Dialog Box 
Fields

Control Type What it does
Opens this 
dialog box

Notes

New Channel Name entry / dropdown Enter the name for the new channel to 
create.

RGB Channel dropdown Selects the existing channel that pro-
vides the diffuse color data for the new 
channel.

Mask Channel dropdown Selects the existing channel to use as 
the mask when creating the new chan-
nel. A second dropdown allows you to 
select the specific color channel to use 
as the mask (red, green, or blue).
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What It Does

Selects a range of patches according to their index or UDIM value number. Objects or scenes with many 
patches may benefit from being able to quickly select patches by their range value as opposed to selecting 
them manually from the Patches palette.

How to Access It

• Menubar | Patches > Select Range

Select Patches 
By Range dialog 
box fields

Control Type What it does
Opens this 
dialog box Notes

Select By dropdown Gives you the choice of selecting a range of patches 
by either the UDIM value or the index value.

This is set to UDIM by default.

Value entry box Allows you to specify the UDIM or index values that 
you wish to select. You can choose a range of con-
secutive values by listing them with a hyphen (for 
example, 1-5) and include non-consecutive values by 
separating them with a comma (for example, 1-5, 8).
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What It Does

The Load Camera dialog box comes up whenever you attempt to load or import a camera from outside the 
current Mari project. The camera file types are .fbx only.

How to Access It

• Menubar | Camera > Load Camera

Load Camera 
dialog box fields

Control Type What it does
Opens this 
dialog box Notes

Look in entry box, 
dropdown

The directory of the camera file that is to be loaded 
into the current project.

button Goes back to the previous directory.

button Goes forward to the next directory that you have 
browsed.

Only available if you 
have already browsed 
back via the back button.

button Goes up one level in the directory hierarchy.

button Creates a new folder in the current directory.

button Displays the contents of the directory as icons and 
names only.

button Displays the contents of the directory as a details 
view, with a sort option at the top of the listing.
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Load Camera dialog box fields 
File Name entry box Displays the name of the selected file to be 
imported into the project.

This field is automati-
cally filled in when a file 
is selected from the 
above directory location.

File Type entry box, 
dropdown

Displays the file formats available to import the 
selected file.

By default this should 
display .fbx or .FBX.

Control Type What it does
Opens this 
dialog box Notes
Mari 2.0v1The Foundry
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What It Does

Lets you add, edit and remove toolbars for quick access to Mari functions.
Click Add to add a new toolbar, Remove to remove the selected toolbar. Drag icons for actions listed to 
and from existing toolbars.

How to Access It

Menubar | Edit >Toolbars

Manage Toolbars 
Dialog Box Fields

Control Type What it does
Opens this 
dialog box

Notes

Search Actions entry box, drop-
down

Search for actions in the list 
below to quickly find a particu-
lar action shortcut or informa-
tion.

button Clear the search bar for the 
Search Actions field.

button Go back to the previous search 
result.

button If on a previous result, go for-
ward to the next search result.

button Reset all shortcuts to their 
default entries.

button Import custom shortcuts from 
outside Mari.

button Export custom shortcuts to an 
external source.
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Manage Toolbars Dialog Box Fields 
Lookup Shortcut entry box Enter the shortcut to look up 
what action the shortcut is set 
to.

(actions) | Name information The name of the action.

(actions) | Description information A brief description of the 
action.

(actions) | Shortcut information, entry Displays assigned keyboard 
shortcuts.

(toolbars) | Visible checkbox Whether the action is currently 
displayed.

Grouped by Default (the standard 
toolbars that come with Mari) and 
Custom (user-added toolbars).

(toolbars) | Add button Add a new toolbar. Make New 
Toolbar

Opens a dialog box to name the 
new toolbar.

(toolbars) | Remove button Remove selected custom tool-
bar.

Control Type What it does
Opens this 
dialog box

Notes
Mari 2.0v1

The Foundry



59  MANAGE KEYBOARD SHORTCUTS DIALOG BOX

What It Does

Lets you add, edit and remove keyboard shortcuts for quick access to Mari functions.

Click in the Shortcut column and type the keyboard shortcut for a function. A 'collision' icon displays if 
that shortcut has already been assigned to another function.

How to Access It

Menubar | Edit > Shortcuts

Edit Shortcuts 
dialog box fields

Column Type What it does Notes

Search Actions entry box, dropdown Search for actions in the list below to 
quickly find a particular action shortcut 
or information.

button Clear the search bar for the Search 
Actions field.

button Go back to the previous search result.

button If on a previous result, go forward to the 
next search result.

button Reset all shortcuts to their default 
entries.

button Import custom shortcuts from outside 
Mari.

button Export custom shortcuts to an external 
source.

Lookup Shortcut entry box Enter the shortcut to look up what action 
the shortcut is set to.

(actions) | Name information The name of the action.
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Edit Shortcuts dialog box fields 
(actions) | Description information A brief description of the action.

(actions) | Shortcut information Displays assigned keyboard shortcuts. 
Click and type over new shortcuts.

Column Type What it does Notes
Mari 2.0v1

The Foundry
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What It Does

Lets you select what appears on the “Head Up Display” (HUD) that shows information about Mari and the 
current project in the top left-hand corner of the canvas. For each piece of information, the HUD 
Manager shows its:

• Name — displayed hierarchically.

• Type — QString, int, bool, qint64, float, PaintSelectedMarkFlag, MriColor, PaintOnFlag, DisplayQuality, 
MriGradient, LightingMode, Qdate, MriFileList, Background, MriPaintMode.

• HUD — a checkbox for whether to include in the HUD.

• Control — this is debug information, and can be ignored.

How to Access It

Menubar | Edit > HUD Manager

HUD Manager 
Dialog Box Fields

Control Type What it does Notes

Shader Network GLSL Code Generator 
Manager > General | GLSL Generator

QString Shows the GLSL for the shader network.

Project > Project | Current Object QString Shows the name of the object currently selected.

Canvas > Rendering | Deferred Texture 
Array

bool Debug info.

Canvas > Rendering | Deferred Shading bool Debug info.

Canvas > Rendering | Selected Patches int Shows the number of patches currently selected.

Canvas > Rendering | Triangles int Shows the number of triangles on the model.

Canvas > Rendering | FPS float Shows the current Frames Per Second of the display. This 
shows how fast the display is rendering, and how smoothly 
movement displays.

Canvas > Rendering | FPAnim int Shows the number of frames per animation. 
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HUD Manager Dialog Box Fields 
Tool Manager > General | Tool Help QString Shows basic tool help for the current tool.

Tool Manager > General | Current Tool QString Shows the name of the current tool.

GPU 0 > Capabilities | Threaded OpenGL 
Operations Allowed

bool Debug info.

GPU 0 > Capabilities | Tessellation 
Allowed

bool Debug info.

GPU 0 > Capabilities | 
Geometry Shaders Supported

bool Debug info.

GPU 0 > Capabilities | Offscreen AA bool Debug info.

GPU 0 > Capabilities | Float Data bool Debug info.

GPU 0 > Capabilities | Offscreen bool Debug info.

GPU 0 > Capabilities | Shaders bool Debug info.

GPU 0 > Capabilities | Max Texture Size int Debug info.

GPU 0 > Capabilities | Texture Units int Debug info.

GPU 0 > Driver | Renderer QString Debug info.

GPU 0 > Driver | Glew QString Debug info.

GPU 0 > Driver | Version QString Debug info.

GPU 0 > Driver | Vendor QString Debug info.

GPU 0 > Resources | Memory Info QString Shows the memory usage and free memory information for 
the project.

GPU 0 > Resources | Used Texture Units int The number of texture units used in the project.

GPU 0 > Resources | Free Offscreen int Debug info.

GPU 0 > Resources | Offscreen Buffers int Debug info.

GPU 0 > Resources | Gpu Ram qint64 Debug info.

GPU 0 > Resources | Max Image Memory qint64 Debug info.

GPU 0 > Resources | Buffer Memory qint64 Debug info.

GPU 0 > Resources | Tile Memory qint64 Debug info.

GPU 0 > Resources | Image Tiles int Debug info.

Channels | Current Channel QString Shows the name of the current channel on the current object.

Clock | Animation Frame int The number of the frame currently being displayed.

Clock | Animation Loop int The number of frames currently being looped.

Clock | Animation FPS int Frames Per Second of the animation.

Clock | Animation Time QString Time length of the animation in the scene.

Control Type What it does Notes
Mari 2.0v1

The Foundry
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HUD Manager Dialog Box Fields 
Layers | Current Layer QString Shows the name of the current layer in the current channel 
and object.

Shaders | Current Shader QString Shows the name of the shader currently selected.

<Project> > General | Description QString Shows description of current project.

<Project> > Creation | Created By QString Displays the login name of the user who originally created 
the project.

<Project> > Creation | Creation Date QDate Displays the initial creation date of the project.

<Project> > Debug | Unique Id QString Debug info.

<Project> > Editing | Last Edited QDate Displays date that the project was last edited.

<Project> > Editing | Last Editor QString Displays user who last edited the project.

<Project> > Geometry | Mesh Creator QString Displays the user who created the geometry file upon which 
the project is based.

<Project> > Geometry | Mesh Created QString Displays the date and time that the geometry file was cre-
ated.

<Project> > Geometry | Mesh Path QString Displays the path for the mesh file.

Control Type What it does Notes
Mari 2.0v1

The Foundry
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What It Does

Lets you set preferences for how Mari works.

How to Access It

Menubar | Edit > Preferences

Mari Preferences 
Dialog Box Fields

Setting Type What it does Notes

Color

Color Management Defaults | Enabled checkbox Sets whether color management is enabled by 
default.

Color Management Defaults | Color 
Profile

dropdown Sets the default color profile for displaying colors 
on your monitor.

Display Defaults | Configuration File entry box, 
button

Specifies the default colorspace configuration file 
that is loaded by the colorspace toolbar. 

Display Defaults | Input ColorSpace dropdown Sets the default colorspace of the scene.

Display Defaults | Display dropdown Sets the default colorspace for the display device 
used to view the scene.

Display Defaults | View dropdown Sets the default display transform applied to the 
scene.

Display Defaults | Component dropdown Sets the default color component displayed for 
the scene.

Display Defaults | Gain entry box, 
slider

Sets the default amount of exposure adjustment 
that is applied before the display transform.

Display Defaults | Gamma entry box, 
slider

Sets the default amount of gamma correction that 
is applied after the display transform.
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Mari Preferences Dialog Box Fields 
Display General | LUT Size dropdown Sets the size of the display LUT loaded by the col-
orspace toolbar.

You may sometimes 
notice artifacts on 
the canvas when your 
LUT size is too small. 
Increase the size of 
the LUT here.

Display General | Center F-Stop entry box, 
slider

Sets the center F-Stop value for when the Gain 
reset button is clicked.

LUT Defaults | File entry box, 
button

Sets the location of the default LUT file that is 
loaded by the colorspace toolbar.

LUT Defaults | Extrapolate checkbox Sets whether extrapolation is enabled by default. 
If enabled, the GPU extrapolates the grid values 
or clamps to the maximum value of the LUT.

Data

Autosave | Autosave Frequency (Mins) entry box, 
incrementers

Sets how frequently (in minutes) Mari automati-
cally saves your work.

Cache | Thread Count entry box, 
slider

Sets the number of free threads that are available 
for background tasks.

These are in addition 
to the dedicated data 
management threads 
(of which there are 
three per cache direc-
tory).

Cache | Max Memory entry box, 
incrementers

Sets the maximum amount of memory Mari uses 
for the DDI cache blocks. You can't set this to a 
value higher than 80% of the memory you have 
available (rounded to the nearest half-GB). For 
example, if you have 6GB of memory available, 
you can't set Max Memory to a value higher than 
4.5GB. This is to avoid using all the physical mem-
ory available.

DDI is the data cach-
ing system used in 
Mari.

The Reset (R) icon 
resets the maximum 
memory value to 2 
GB.

Cache | Check Drive Space entry box, 
slider

Sets the interval, in seconds, that the cache 
drives are checked for sufficient disk space. 

Channel Cache | Resolution Mode dropdown Determines if Mari caches at the given channel’s 
resolution or a lower proxy level. Setting this to 
Fixed uses the Default resolution and Type listed 
below.

This can speed up the 
caching process if 
you don’t require the 
full resolution of the 
channel to be cached.

Channel Cache | Default Resolution dropdown If the Resolution Mode is set to Fixed, Mari 
caches at the selected resolution.

This can save time 
when caching large 
patches if you don’t 
require the full reso-
lution while working.

Setting Type What it does Notes
Mari 2.0v1

The Foundry
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Mari Preferences Dialog Box Fields 
Channel Cache | Default Type dropdown If the Resolution Mode is set to Fixed, Mari 
caches at the selected bit depth.

This can save time 
when caching large 
patches if you don’t 
require the full reso-
lution while working.

Channels | Importer dropdown Sets the mode for the import function. One of:

• Fast Importer — takes over your Mari session 
while it imports the textures, but works 
quicker.

• Background Importer — works in the back-
ground, letting you paint and work on your 
project, but takes longer.

Channels | Exporter dropdown Sets the mode for the export function. One of:

• Fast Exporter — takes over your Mari session 
while it exports the textures, but works 
quicker.

• Background Exporter — works in the back-
ground, letting you paint and work on your 
project, but takes longer.

Channels | Export Mask Stacks dropdown Determines how mask stacks are exported. Either:

• Export Baked Mask Stack and an Invisible 
Group - exports a group along with the mask 
stack in order to group the exported masks.

• Export Baked Mask Stack Only - exports on the 
mask stack with nothing else as part of the 
export.

Channels | Autosnapshot dropdown Sets whether automatic snapshots are enabled or 
disabled. The options available are:

• Disabled — Disables the Autosnapshot feature.

• Enabled with Limit — Enables the Autosnap-
shot feature but limits the number of autos-
napshots that can be stored in the Snapshots 
palette.

• Enabled - Unlimited — Enables the Autosnap-
shot feature without a limit on the number of 
autosnapshots that can be stored in the Snap-
shots palette.

Channels | Autosnapshot Limit entry box, 
slider

When Enabled with Limit is selected, Mari limits 
the number of automatic snapshots that are 
stored in the Snapshots palette to the number 
specified by the Autosnapshot Limit. The maxi-
mum value is 20.

Setting Type What it does Notes
Mari 2.0v1

The Foundry
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Mari Preferences Dialog Box Fields 
General | Fix Edge UVs dropdown Sets whether Mari should “fix” any UVs that sit 
on the edge of the patch. With this on, you can 
paint models that have UVs at the edge of the 
patch.

General | Channel Input dropdown When creating a new project, sets whether the 
New Channel dialog box adds either:

• Single Channel — a single channel.

• Channel Presets — a set of channels that you 
select from a list of presets.

GPU

Baking and Projection | Max Tile Size 
for Tiled Renders

dropdown Sets the maximum tile size for tiled render opera-
tions (for example, unprojections). Setting this to 
a lower value improves accuracy but may result in 
slower render operations.

Baking and Projection | Max Render Size 
for Baking

dropdown If baking calculation has to be divided into sec-
tions in order to continue efficiently, this speci-
fies the maximum square size of these sections.

Increasing the num-
ber of squares per 
section can increase 
baking time, but may 
impact stability.

Canvas | Deferred Shading checkbox Specifies whether to use deferred shading. This is 
on by default and should increase painting and 
navigation speed.

Canvas | Deferred Texture Array checkbox Turns Deferred Texture Array on/off. When this is 
active, Mari makes more efficient use of OpenGL.

Depth Projection | Allow Depth Projec-
tions

checkbox Allows the use of shadow rendering in Mari. If the 
box is ticked, shadow-related features are avail-
able in the Lights and Objects palettes. By 
default, this preference is disabled.

Depending on your 
hardware and project 
requirements, shadow 
processing may cause 
a noticeable drop in 
UI responsiveness. 
Disabling this option 
disables shadow pro-
cessing entirely and 
improves rendering 
throughput.

Depth Projection | Use Variance Maths checkbox Sets whether variance map maths are used for 
shadows. If this box is ticked, the boundary of the 
shadows are softer and less prone to aliasing. For 
a sharper edge to shadows, unselect this box.

If Allow Depth Projec-
tions is unselected, 
shadows do not dis-
play. The Use Vari-
ance Maths checkbox 
should be unselected 
as it depends on 
shadows being used.

Setting Type What it does Notes
Mari 2.0v1
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Mari Preferences Dialog Box Fields 
Depth Projection | Depth Projection 
Resolution

dropdown Sets the texture resolution of each of the array of 
depth textures used for shadow rendering. The 
Depth Projection Texture Array Size is linked to 
this resolution and impacts other resolution sizes 
set in Mari.

Depth Projection | Depth Projection 
Texture Array Size

dropdown Sets the number of depth projection textures to 
use for shadow rendering. Increasing the array 
size increases the graphics card memory made 
available for shadow rendering. The total graphics 
memory used for these textures is 8 multiplied by 
the depth projection resolution, multiplied by the 
depth projection texture array size. The array size 
controls how many angles each light of the 4 
lights uses. The maximum array size is 24, which 
allows for 6 angles per light.

Options are available 
for 25-32, but at this 
time Mari does not 
use these additional 
angles. Selecting 
options over 24 
causes wasted cache 
space.

General | Max Image Memory entry box, 
incrementers

Sets the maximum amount of additional GPU 
memory Mari uses for tasks other than painting, 
for example, filter operations.

General | Deferred Quad Split Count entry box, 
slider

Sets the quad split count. Increasing this value 
splits the canvas into smaller parts.

Used in conjunction 
with Draw Batch Size, 
adjusting this value 
can improve stability 
and prevent Win-
dows driver resets.

General | Threaded OpenGL Operations 
Allowed

checkbox If this is enabled then operations requiring 
threaded OpenGL can be executed.

General | Tessellation Allowed  checkbox Enables the use of tessellation shaders for hard-
ware able to support them.

Virtual Texture | Virtual Texture Type dropdown Sets the pixel type of the virtual texture that Mari 
uses. Setting this to Half or Float gives more pre-
cision when painting or previewing displacement 
but requires significantly more GPU memory.

Virtual Texture | Virtual Texture Size dropdown Sets the size of the virtual textures Mari uses. 
Larger sizes may give better results but require 
significantly more GPU memory.

Virtual Texture  | Virtual Texture Size 
for Paint Bake

dropdown Controls the size of the virtual texture being used 
for the display. Increasing this setting may 
resolve issues, such as flickering, but takes up 
more memory.

This is a graphics 
card-dependant set-
ting.

Setting Type What it does Notes
Mari 2.0v1

The Foundry



MARI PREFERENCES DIALOG BOX 221
Mari Preferences Dialog Box Fields 
Virtual Texture | Gather Scale entry box, 
slider

Sets the buffer size Mari uses when gathering 
information on which image tiles are required for 
rendering a scene. The default value of 1.000 
halves the canvas resolution and works well in 
most situations, saving processing time. However, 
if glitches are appearing in the canvas, you may 
need to increase this value to fix the problem (at 
the cost of reduced painting and navigation 
speed).

Virtual Texture | Thin Triangle Pre-
view Quality

entry box, 
slider

Controls the texture preview quality of thin trian-
gles. The default value is 0. In cases where the 
geometry has long thin triangles, increasing this 
value results in the use of higher resolution tex-
tures.

Misc

Appearance | Use Custom Font checkbox Enabling this allows you to change the font used 
in Mari from the default setting.

Appearance | Custom Font Size entry box, 
slider

Adjusts point size of the custom font. Use Custom Font 
must be enabled in 
order for this to have 
an affect.

Image Import/Export | Show Summary 
Dialog on Import

checkbox Sets whether Mari displays an import summary 
dialog after importing an image.

The import summary 
dialog displays infor-
mation such as how 
many images were 
imported, how long 
the operation took, 
and if patches were 
resized — then how 
many.

Import/Export Dialogs | Remember 
Import and Export Paths

checkbox If enabled, Mari automatically remembers paths 
previously set for importing and exporting, and 
offers them again next time you attempt to 
import or export.

Import/Export Dialogs | Enable Multi-
Channel Import and Export

checkbox If enabled, import and export dialogs offer the 
ability to import or export multiple files at once.

Input | Use HiRes Positions checkbox If this option is enabled, Mari uses high resolution 
position values from tablets and other devices.

Most often this is only noticeable using Paint and 
Vector Paint on large patch sizes.

In some cases, hav-
ing this option 
enabled can hinder 
painting entirely. Dis-
abling it resolves the 
issue.

Setting Type What it does Notes
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Mari Preferences Dialog Box Fields 
Named Files | Patch Cutoff entry box, 
slider

Sets the maximum number of patches objects are 
allowed to have for the Named Files tab to 
appear on the Import and Export Channel dia-
logs. You can override this setting using the 
MARI_NAMEDFILEIMPORT_SEQUENCELIMIT envi-
ronment variable. 

You can use the Named Files tab to import or 
export individual files rather than a sequence of 
patches with the udim number (1001, 1002, etc.) 
in the file names.

Scene | Default Lights Fixed To dropdown Sets whether the lights are fixed to a camera or 
scene by default.

Shelf | Show Overlay checkbox Specifies whether to show object information 
over the items within shelves (for example, color 
values for color swatches).

Shelf | Show Labels checkbox Specifies whether to show item labels in shelves 
(for example, names for color swatches).

Shelf | Shelves Include Presets checkbox Specifies whether to show Mari's preset brushes 
in the Shelf tab. If off, only your personal and 
custom shelves are displayed.

Shelf | Remake Icons button Regenerates Mari's icons for shelf items. If these 
have become corrupt (for example, if your brush 
icons are all blank), clicking this forces Mari to re-
create all the icons.

Slider Precision | Slider Precision slider Adjusts how many decimal places are represented 
by Mari’s sliders. Increasing this gives you finer 
control over slider values.

Toggle Tools | Toggle On Key Held checkbox Sets how the shortcut keys for the Zoom Paint 
Buffer (Z), Color Picker (C), and Select (S) tools 
work.

• If On, these shortcut keys only apply while 
you're holding them down. Mari switches back 
to your previous tool when you let go of the 
shortcut key.

• If this is Off, tapping the shortcut key quickly 
switches permanently to the tool, and holding it 
down for more than a second or two switches 
to the tool while you're holding the shortcut 
key (and switches back as soon as you let it go).

Usage Statistics | Send Statistics checkbox Allows Mari to send usage data to The Foundry. All information is sent 
anonymously.

Setting Type What it does Notes
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Mari Preferences Dialog Box Fields 
Navigation

General | Momentum Enabled checkbox If this is enabled, the model has momentum, so 
when you let go of the mouse button, it slowly 
coasts to a stop. If this is disabled, the model 
only moves when you are holding the mouse but-
ton down.

General | Minimum Flick Speed entry box, 
slider

Sets the minimum speed at which you can move 
your model around. The higher this is set, the 
more sensitive the movement controls are.

General | Friction entry box, 
slider

Affects the momentum of your model as you move 
it around the canvas.

Decreasing this value 
allows movement to 
retain its momentum 
for longer. Increasing 
the value arrests 
momentum faster.

General | Control Type dropdown Sets up the Mari controls on the canvas to match 
the controls of another application, specified in 
the dropdown list. Applications include: Nuke, 
Maya, LightWave, and Houdini.

Orbit | Lock To World Up checkbox If this is on, it locks the y axis to world up view.

Orbit | Center Mode dropdown Specify the center point to orbit around from the 
choice of:

• Look At - what is currently being viewed in the 
display.

• Objects - the objects in a scene.

• Origin - the scene origin point.

• Selection - the current selection.

Roll | Circular Motion Enabled checkbox If enabled, rolling is achieved by making a circular 
motion in the center of the canvas. If this option 
is disabled, rolling is only done with a horizontal 
motion across the canvas.

Nuke

General | Use flat lighting checkbox, 
reset

Modifies the Nuke workflow to use flat lighting. The reset icon resets 
the flat lighting 
option back to 
default.

Server | Nuke host entry box, 
reset

Allows you to specify the host name for the loca-
tion of Nuke.

Server | Port entry box, 
slider, reset

Allows you to specify the port number, or modify 
it with the slider.

Setting Type What it does Notes
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Mari Preferences Dialog Box Fields 
Server | Nuke launch path entry box Allows you to browse and load a launch path for 
accessing Nuke files.

The path can be writ-
ten manually or 
inserted using the 
browse and load icon.

Painting

Cursor | Shape dropdown Allows you to set whether the brush cursor in 
Mari is displayed as an outline of the selected 
brush tip or as a standard round paint cursor.

Cursor | Opacity entry box, 
slider

Allows you to set the opacity of the brush cursor. 
This only affects how opaque the cursor design is, 
not the opacity of the paint.

Projection | Default Color Depth dropdown Sets the default color depth Mari uses: 8, 16, or 
32-bit.

Paths

Channel Presets | Search Paths list, button Adds or removes directories that Mari checks for 
channel preset configuration files.

See the Mari User 
Guide for details on 
writing your own 
channel preset files.

Shaders | Search Paths list, button Adds or removes directories that Mari checks for 
compositing shaders.

Ptex

Face Textures | Minimum Size dropdown Sets the minimum face texture size. The options 
provide increments in powers of two, and allow 
you to clamp face texture sizes during project 
creation and face resizing.

The default state is 1 
for quadrangular tex-
tures, and 2 for trian-
gular textures.

Scripts

Console | Font Size entry box, 
slider

The point size of the default Mari font in the 
Python console.

Mari Command Port | Port entry box, 
slider

Sets the port number that Mari receives com-
mands from Nuke through. The default value is 
6100.

Mari Command Port | Enabled checkbox If checked, Mari can receive commands through 
the specified port.

The default state is 
disabled.

Mari Command Port | Local Host Only checkbox If unchecked, Mari can listen for connections to 
its command port from any machine. 

If this is checked, then Mari only listens for con-
nections from the local machine.

• Only allowing connections from the local host is 
more secure but prevents you from using fea-
tures, such as the Nuke<>Mari Bridge.

The default state is 
enabled.

Setting Type What it does Notes
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What It Does

Allows you to set how Mari displays the project — the background behind the model, the overlay used on 
locked patches, whether to show wireframes on the model, and so on.

How to Access It

Right-click | main canvas > Display Properties

Display 
Properties 
Dialog Box Fields

Control Type What it does Notes

Canvas > HUD | HUD checkbox Shows the Heads Up Display information in the 
background of the canvas (tool tips, etc).

Canvas > Background | Image entry box, 
button

Select the file to display as the project back-
ground in the canvas. If not set, the colors in the 
Bottom and Top fields are used for the back-
ground.

Canvas > Background | Bottom swatch Sets the color to display at the bottom of the 
screen. To use a single color in the background, 
set both the Bottom and Top to the same value.

Canvas > Background | Top swatch Sets the color to display at the top of the screen.

Canvas > Grid | Color swatch Sets the color for the onscreen reference grid.

Canvas > Grid | Size entry box How large (in squares) the onscreen reference 
grid is.

Canvas > Grid | Visible checkbox Shows the reference grid in the background of 
the onscreen display.

This does not affect 
the UV view.

Canvas > Wireframe | Color swatch The color of the wires displayed in the wireframe 
overlay.
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Display Properties Dialog Box Fields 
Canvas > Wireframe | Visible checkbox If this is selected, the model in the 3D views are 
displayed with the wireframe visible on top of the 
paint.

Canvas > Camera Mask | Opacity entry box, 
slider

The opacity of the black bars that indicate the 
aspect ratio of the perspective camera in the 
Canvas. 

By default, this is set 
to 0, which means the 
bars are disabled.

Canvas > Linked Patches | Color swatch The color of the patches that are linked together.

Canvas > Rendering | Checker Color A swatch Sets color A of the transparency checkerboard. 
This can be chosen using the color picker.

Canvas > Rendering | Checker Color B swatch Sets color B of the transparency checkerboard. 
This can be chosen using the color picker.

Canvas > Rendering | Checker Size entry box, 
slider

The size of the individual checkerboard squares. 
This can be adjusted using either the slider or the 
entry box.

By default this is set 
to 10.

Canvas > Rendering | Render Cameras checkbox Show the cameras on the canvas.

Canvas > Rendering | Render Lights checkbox Show the lights on the canvas.

Canvas > Rendering | Render UV Image checkbox Show the patches in the UV view as they appear 
after export, including the overspill areas.

Canvas > UV Label | Text Color swatch The color for the onscreen text on the UV view, 
used to show the UV patch information.

Only visible if you 
have opened the dia-
log box from within 
the UV view.

Canvas > UV Label | Visible checkbox Whether to show the onscreen UV patch infor-
mation text over each patch in the UV view.

Only visible if you 
have opened the dia-
log box from within 
the UV view.

Canvas > Selection | Fill Render dropdown When to show the selection fill color. This 
appears in the middle of selected areas. Options 
are:

• Select — show the selection fill while the area 
is being selected. Once you've finished making 
the selection, the fill disappears.

• Always — show the selection fill the whole 
time the area is selected.

• Never — do not show the selection fill.

Canvas > Selection | Fill Color swatch The color to use to fill selected areas. Click on 
the swatch to set the color.

Control Type What it does Notes
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Display Properties Dialog Box Fields 
Canvas > Selection | Outline Render dropdown When to show the selection outline. This appears 
around the outside of selected areas. The 
options are the same as for Fill Render, above.

Canvas > Selection | Outline Color swatch The color to use to outline the selected areas. 
Click on the swatch to set the color.

Control Type What it does Notes
Mari 2.0v1
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What It Does

Allows you to specify the settings for any screenshots that you take of the Mari canvas. If these settings 
have never been adjusted before, the dialog appears the first time you attempt to take a screenshot from 
the View menu. However, you can change these settings at any time.

How to Access It

Menubar | View > Screenshot Settings

Screenshot 
Settings dialog 
box fields

Control Type What it does
Opens this 
dialog box Notes

Output entry box, 
dropdown

The directory where the screenshots are to be saved. 
Type the directory or click the file browser button to 
navigate to it directly.

button Browse to the directory where you want the screen-
shots to be saved.

Incremental dropdown If Enabled, multiple screenshots are saved with incre-
mental numbers appended to the filename. If Disabled, 
every screenshot overwrites the previous one.

Background dropdown Sets whether the background of the screenshot is Grey 
or Transparent.
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What It Does

Takes the scene as you can see it through the selected shader, and creates a series of images showing the 
model rotating through an axis. The axis of rotation is a vertical line through the current camera view, 
centered in the middle of the visible portion of the model. You can include custom text or thumbnails of 
reference images in the turntable.

How to Access It

Right-click | Projector in Projectors Palette >  Render Turntable

Render 
Turntable Dialog 
Box Fields

Control Type What it does Notes

Settings | Size dropdown Selects the size of the generated images.

Settings | Antialias dropdown How much anti-aliasing to use in the generated 
images.

Settings | Background dropdown Selects the background for the images (Gray, 
Transparent, or From Canvas).

From Canvas uses the current back-
ground in Mari.

Settings | Frames entry box, 
slider

Sets the number of frames to generate — how 
many images should be in the sequence.

Range: 1 to 1000

Default: 360

Settings | Play Animation checkbox If you are using animated models or textures, 
lets you render the turntable with the anima-
tion.

When you check this, the Frames 
control above becomes disabled. 
This is because the frame range is 
taken from the Play Controls Palette.
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Render Turntable Dialog Box Fields 
Settings | Offset entry box If you are combining multiple turntables, lets 
you chain together sequences by offsetting the 
image numbers.

For example, with an offset of 0, the 
first image is MariTurntable_1.jpg. 
With an offset of 360, the first 
image is MariTurntable_361.jpg. You 
can use this to generate one 
sequence of frames for the x axis, 
then another for the y axis.

Settings | Filters dropdown If this is checked, the turntable images are 
produced with the LUT and any other applica-
ble view filters applied. If this is not checked, 
no filters are applied to the images produced.

Settings | Lighting dropdown Specify whether you want to render a turntable 
with Flat, Basic, or Full lighting.

Info | Comment entry box, 
dropdown

Sets a comment to include this at the bottom 
of the turntable.

Info | Text Size entry box, 
slider

Sets the text size for the comment. Range: 0.10 to 10.00

Default: 1.00

Info | Reference entry box, 
dropdown, 
button

Selects a reference image to include at the top 
right of your model.

Second dropdown specifies whether 
the colorspace is sRGB or Linear.

Info | Reference entry box, 
dropdown, 
button

Specifies where Mari should create the images. Second dropdown specifies whether 
the colorspace is sRGB or Linear.

Output | Path entry box, 
dropdown, 
button

Specifies where Mari should create the images. Default: /local1

Output | Template entry box, 
dropdown

Sets a template for the filenames. This must include the $FRAME vari-
able, so Mari assigns the frame num-
bers correctly to the files. Mari can 
export turntables as either .tif, .png, 
.jpg, or .tga files — change the file 
extension in the template to set the 
file type. Default: 
MariTurntable_$FRAME.jpg

Output | Command entry box, 
dropdown

Specifies any commands to run on files after 
creating them.

Preview button Generates the first frame of the turntable, 
enabling you to check the placement of refer-
ence images and text.

Control Type What it does Notes
Mari 2.0v1
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What It Does

Creates a series of images showing the scene rotating through an axis. The axis of rotation is a vertical 
line through the current camera view, centered in the middle of the visible portion of the scene. You can 
export multiple channels at once. Mari creates all the images using the default shader and flat lighting.

How to Access It

• Right-click | Projector in Projectors Palette >  Diagnostic Turntable

• Menubar | Camera > Quick Turntable

Diagnostic 
Turntable Dialog 
Box Fields

Control Type What it does Notes

Channel list Selects which channels to export turntables 
for.

Settings | Size dropdown Selects the size of the generated images.

Settings | Antialias dropdown How much anti-aliasing to use in the gener-
ated images.

Settings | Background dropdown Selects the background for the images 
(Gray, Transparent, or From Canvas).

From Canvas uses the current back-
ground in Mari.

Settings | Frames entry box, 
slider

Sets the number of frames to generate — 
how many images should be in the 
sequence.

Range: 1 to 1000

Default: 360

Settings | Play Animation checkbox If you are using animated models or tex-
tures, lets you render the turntable with the 
animation.

When you check this, the Frames con-
trol above becomes disabled. This is 
because the frame range is taken from 
the Play Controls Palette.
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Diagnostic Turntable Dialog Box Fields 
Settings | Filters dropdown If this is checked, the turntable images are 
produced with the LUT and any other appli-
cable view filters applied. If this is not 
checked, no filters are applied to the images 
produced.

Info | Comment entry box, 

dropdown

Sets a comment to include this at the bot-
tom of the turntable.

Info | Text Size entry box, 

slider

Sets the text size for the comment. Range: 0.10 to 10.00

Default: 1.00

Info | Reference entry box, 

dropdown, 

button

Selects a reference image to include at the 
top left of your model.

Second dropdown specifies whether 
the colorspace is sRGB or Linear.

Info | Reference entry box, 

dropdown, 

button

Selects a reference image to include at the 
top right of your model.

Second dropdown specifies whether 
the colorspace is sRGB or Linear.

Output | Path entry box, 

dropdown, 

button

Specifies where Mari should create the 
images.

Default: /local1

Output | Template entry box, 

dropdown

Sets a template for the filenames. This must include the $FRAME variable, 
so Mari assigns the frame numbers 
correctly to the files. 

If you're generating turntables for mul-
tiple channels, this should include the 
$CHANNEL variable, as otherwise the 
later channels overwrite the earlier 
ones. 

Mari can export turntables as either 
.tif, .png, .jpg, or .tga files — change 
the file extension in the template to 
set the file type.

Output | Command entry box, 

dropdown

Specifies any commands to run on files 
after creating them.

Preview button Generates the first frame of the turntable, 
enabling you to check the placement of ref-
erence images and text.

Control Type What it does Notes
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What It Does

Sets the details that the quick projection tools use — the filename, file size, and lighting model for the 
quick project files.

How to Access It

• Toolbars | Quick Projection

• Menubar | Camera > Quick Projection Settings

Quick Projection 
Dialog Box Fields

Control Type What it does Notes

Resolution dropdown Sets the resolution for the projected file.

Color Depth dropdown Sets the color depth for the projected file.

Clamp checkbox If enabled, Mari clamps the RGB values for the 
projected file.

Path entry box, button Specifies the location and filename for the pro-
jected file.

Lighting dropdown Sets whether the projected file contains lighting 
information:

• None - no lighting information.

• Separate File - lighting information is stored 
in a separate file. For example: diffuse.light-
ing.tif or diffuse.lighting.psd.

• Layer - lighting information is stored in a 
separate layer (PSD files only).
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